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Eclipse Business Connect XML Overview

Using Eclipse Business Connect XML (referred to in this documentation as Business Connect XML) you
can take advantage of real-time collaboration between systems, no matter how similar or dissimilar they
may be. Use the integrated mapping utility to establish electronic trading relationships with your
customers and vendors, aswell as other distributors using XML. Y ou can receive transactions, such as
orders, from your customersin any XML format and translate outgoing XML transactions, such as order
confirmations, into a format your customers' systems can understand. Using the HTTPs transport
protocol, you can ensure your transactions and data are traded securely.

Use Business Connect XML to:

o Eliminate EDI VAN and porta charges by linking directly with customers, vendors, and other
distributors.

¢ Improve your customer service by making it easier for your customers to get what they want, when
they want it.

¢ Reduce costs associated with manual transactions and their potential errors.

o Increase inventory visibility of slow-moving items and dead stock.

o Sdll excessinventory to other distributors, optimizing the use of your warehouse space.
o Fill orders from other wholesalers inventory.

o Save time by taking advantage of existing resources.

¢ Save on mapping costs by setting up your own trading partner rel ationships.

¢ Receive orders and inquiries from your customers through supply-chain marketplaces such as
Ariba, DataStream, MRO, MROSoup, Commerce One®, and Pantellos®.

Y ou might have el ectronic trading relationships established with customers and vendors that also use
Eclipse through the Eclipse B2B Commerce companion product. If you conduct electronic business with
other Eclipse users, you can still use B2B Commerce to complete those transactions. Use Business
Connect XML to complete XML transactions with customers and vendors who are not using Eclipse.

Important: The Business Connect XML functionality that runs outside the XML Mapping
Utility has not been incorporated into Solar Eclipse as of thisrelease. Use the
character-based system when sending and receiving XML transactions.

Use this document to guide you through creating trading partner profiles, mapping XML transactions, and
sending and receiving XML transactions through the Eclipse system.

Note: The content of the Business Connect XML online Help assumes you have a
working knowledge of XML, Windows applications, and the Eclipse system.

© 2011 Epicor Software Corporation. All rights reserved. 1
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What's New in Business Connect XML 2.0

The following functionality is new in the Business Connect XML 2.0 release.

NEW| Send direct shipmentsusing XML from within sales order entry. For more information, see Sending
XML Direct Ordersto Your Vendors.

NEW| Access any user-defined files that you create beyond the standard filesin Eclipse. For example, you
may want to store or send additional information about a transaction that you have defined in a user-
defined file. Modifying the existing XML schemas to include your user-defined files makes those files
available in the XML mapping utility. For more information, see Creating XML Database Schemas.

2 © 2011 Epicor Software Corporation. All rights reserved.
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Getting Started with Business Connect XML

Consider the following when setting up an XML document trading rel ationship with your trading
partners:

o What are my trading partner's e-commerce capabilities?
¢ What documents and transactions do | want to exchange with my trading partners?

o Do my trading partners conduct business through an online portal, such as the Ariba Supplier
Network?

e What manual processes will this new relationship automate?
¢ Who will manage the trading partner relationships going forward?

Y our answers to these questions dictate how and when you implement each trading relationship.

What Do | Need From My Trading Partners?

Before exchanging XML documents with your trading partners, obtain the following items for each
transaction you plan to trade:

o Document type definition (DTD) files - For each transaction type, the DTD isrequired to
compl ete the transaction map using the Business Connect XML mapping utility.

e Document specifications - Defines required elements, what datais contained in each element, and
element descriptions.

e Sample XML documents- Use sample XML documents to determine which fields from the DTD
the trading partner uses and to test transactions after creating the transaction map.

Meet with your trading partners to discuss the best way to map their transaction data in and out of Eclipse
and work with them to determine the following:

e Transactionsto trade.

o Definitions of all datafieldsin the XML documents.

e Theintended purpose or use of each field in the XML document.
e Post URL for each document.

o Workflow procedures that both parties use when processing transactions.

How Do | Get Started?

After you determine which transactions you are going to trade using XML and have obtained the
necessary documents from your trading partner, complete the following tasks to get started using the
Business Connect XML application.

1. Learn how XML documents flow from your trading partner through the Eclipse system.
e How XML documents flow through the system.
o Example XML dataflow .
e Example XML data flow with marketplace diagram.

© 2011 Epicor Software Corporation. All rights reserved. 3
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Set system, customer, and vendor parametersin Eclipse.
Learn about XML database schemas and how they form transactions.

Use the Business Connect XML mapping utility to create transaction maps for each transaction
you complete with your trading partners.

¢ Learn about the Business Connect XML mapping utility and its symbols.

Add trading partners to the mapping utility.

e Learn about transaction maps.

Create an XML transaction map for each transaction.

Define XML mapping selection criteria.
e Modify incoming and outgoing data, if necessary.
5. Send and receive transactions from your customers and vendors.

4 © 2011 Epicor Software Corporation. All rights reserved.
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How XML Documents Flow Through the System

The following diagram illustrates how XML documents flow from your trading partner through your
application server and on to Eclipse.

If you are sending an outbound only transaction, such as an invoice to your customer, the XML document
originatesin Eclipse with no inbound component. In the diagram below, start with the Eclipse symbol at
the bottom and follow the flow up the right side to the trading partner.

© 2011 Epicor Software Corporation. All rights reserved.
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Example XML Data Flow

The following diagram illustrates how XML documents for an order submit transaction flow from a
customer flow through the system to the application server and on to Eclipse.

In the example below, you have a transaction map defined for an order submit transaction that contains a
received document map for an order submit transaction type, and sent document map for an order
acknowledgement transaction type.

© 2011 Epicor Software Corporation. All rights reserved. 7
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Example XML Data Flow with Marketplace

The following diagram illustrates how XML documents for an order submit transaction flow from a
supply chain marketplace site, or portal, through the system to the application server and on to Eclipse.

In the example below, you have a transaction map defined for the following:

o A websession transaction for the marketplace site that contains a received document map for an
websession request and a sent document map for a websession response.

e Anorder submit transaction that contains a received document map for an order submit
transaction type, and sent document map for an order acknowledgement transaction type.

© 2011 Epicor Software Corporation. All rights reserved. 9
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Business Connect XML Setup Overview

Set the following parameters before sending or receiving XML documents:
e XML-related control maintenance records
e XML Product Not Found product
¢ Remote document details
Set the following parameters before sending or receiving XML documents to or from customers:
e Activity triggers for XML documents
e System notifications
o Document post locations
e Pricing variance parameters
e E-commerce IDs
Set the following parameters before sending or receiving XML documents to or from vendors:
¢ Vendor access information
o Activity triggers for XML documents

e Document post locations

© 2011 Epicor Software Corporation. All rights reserved. 11
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Setup Requirements for Business Connect XML

Following are control maintenance records and authorization keys used for Business Connect XML.

Control Maintenance Records
Set the following control maintenance records:
e BCXML Application Server Settings

The combination of the server name and port define the address that the Eclipse system must use to
communicate with the BCXML server.

e IDMS-XML Admin Message User/Group
IDMS-XML Default Part # Used For Creating A Nonstock Item
IDMS-XML Default Sales Order Writer Default Sales Order Writer

IDMS-XML Inbound Sales Orders Always Use Partner Pricing Inbound Sales Orders Always Use
Partner Pricing

Order Statuses Displayed In IDMS-XML
Default IDMS-XML Sales Source
o J2EE Application Server Settings

Authorization Keys
Assign the following authorization keys:
o WOE.MAINT

12 © 2011 Epicor Software Corporation. All rights reserved.
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Defining the **Product Not Found*** Product for XML
Transactions

When the system processes an XML order, it uses the following hierarchy to match products.
o Eclipse product ID
o Product description
e UPC
o Customer part number
e User-defined fields
o Catalog number
o Keywords
e Description

Each of the items must have data from the XML document mapped for the system to search onit. If the
data is not mapped, the system searches on the next available piece of data. For example, if you map both
the product 1D and product description, the system first tries to match against the product ID. If it finds a
match, it stops and does not search using the rest of the hierarchy. If the system does not find a match on
the product 1D or you have not mapped the product ID data, it tries the product description, and so on
down the hierarchy.

When the system processes an XML order for a product it cannot identify or find, the system substitutes a
default product for the lineitem so it can continue processing the order. At alater time, you can review
the order and replace the default product entries with actual products. For the system to use this feature,
you need to create a product for this purposein Product Maintenance and then assign the product part
number to the IDMS-XML Default Part # Used For Creating A Nonstock Item control maintenance
record.

To createthe***Product Not Found*** product:
1. Fromthe Files menu, select Product to display the Product Maintenance screen.
2. IntheProduct ID field, type new and press Enter.

3. Inthe Description field, type ***B2B PRODUCT NOT FOUND***. Thisis the description
that displays on an order when the system cannot identify or find a requested product.

Inthe Prc Linefield, enter Nonstock.
Inthe Buy Linefield, enter Nonstock.
In the Statusfield, select the Nonstock status.
In the Quant field for unit of measure, enter 1.

Inthe GL Acct/Product Type field, select a miscellaneous code.

© ® N o 0 &

Note the part number assigned to the product displayed in the upper right part of the screen.
10. Press Esc to save the record and exit the screen.
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To assign the product to the IDMS-XML Default Part # Used For Creating A Nonstock |tem
control maintenance record:

1. Fromthe System > System Files menu, select Control Maintenance to display the Control
M aintenance screen.

In the Keyword field, enter IDM S XML and press Enter.

Select IDSM-XML Default Part # Used For Creating A Nonstock |tem from the control
maintenance record list and press Enter.

4. Enter the part number from the product you just created and press Esc.

See Also:
Business Connect XML Setup Overview

14 © 2011 Epicor Software Corporation. All rights reserved.
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Setting Customer Activity Triggers for XML Documents

You can set up XML activities that events in the system automatically trigger. For example, you can set
up the system to send an Advanced Shipment Notification (ASN) to atrading partner using XML when
the shipping ticket for the order prints. For more information about activity triggers, see Assigning

Activity Triggers.

Y ou must set the activity triggers and post locations for XML documents to send documents to your
customers.

Use the following activity triggers and trigger actions:
¢ B2B Advanced Ship Notification used with Shipment Notification and Ship Ticket Print triggers.

e B2B Sales Doc used with Batch Invsin Lieu of Print, Email Stmts - Invsin lieu of Print, Invoice

Order, and Invoice Print triggers.

o E-mail and Fax Natifications used with the BC-XML Submit Order trigger.

To send triggered B2B ASNSs:

1

© N o g A
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From the M aintenance menu, select Customer and display the customer to which you want to

assign triggers.

From the Additional menu, select Activity Trigger to display the Activity Trigger Maintenance

window.

Inthe Trigger Description and Activity Description fields, do one of the following:

To...

Do this...

send an ASN at shipment notification

enter Shipment Notification and select B2B Adv
Ship Noticein the Activity Description field.

send an ASN when the shipping ticket prints for
an order

enter Ship Ticket Print and select B2B Adv Ship
Noticein the Activity Description field.

send an ASN from the Shipping Manifest Queue
after the manifest is created and locked

enter M anifest Lock and select B2B Adv Ship
Noticein the Activity Description field.

send an ASN when the pick ticket prints for an
order

enter Pick Ticket Print and select B2B Adv Ship
Noticein the Activity Description field.

send an ASN when invoicing an order

enter Invoice Order and select B2B Adv Ship
Notice in the Activity Description field.

send an ASN when printing an invoice for an
order

enter Invoice Print and select B2B Adv Ship
Notice in the Activity Description field.

send an ASN when an RF order closes

enter RF Order Close and B2B Adv Ship Notice
in the Activity Description field.

In the Foreground and Background fields, accept the default setting.
Select the trigger you just added and select Activity Propertiesfrom the File menu.
Enter the URL to which to post the ASN for this customer and press Enter .

Return to the Customer record.

Save your changes and exit the window.

15
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To send triggered B2B sales documents:

1

© N o g A~
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From the M aintenance menu, select Customer and display the customer to which you want to

assign triggers.

From the Additional menu, select Activity Trigger to display the Activity Trigger Maintenance

window.

Inthe Trigger Description field, do one of the following:

To...

Do this...

send a sales document when processing batch
invoices

enter Batch Invsin Lieu of Print and select B2B
Sales Doc in the Activity Description field.

send a sales document when invoicing an order

enter Invoice Order and select B2B Sales Doc in
the Activity Description field.

send a sales document when printing an invoice
for an order

enter Invoice Print and select B2B Sales Doc in
the Activity Description field.

send a sales document when processing overdue
invoices

enter Overdue I nvoices and select B2B Sales
Doc in the Activity Description field.

send a sales document when printing a pick ticket
for an order

enter Pick Ticket Print and select B2B Sales Doc
in the Activity Description field.

send a sales document when an RF order closes

enter RF Order Close and select B2B Sales Doc
in the Activity Description field.

send a sales document when receiving a purchase
order acknowledgement for a direct order

enter PO Ack Received on Direct and select B2B
Sales Doc in the Activity Description field.

send a sales document when printing a shipping
ticket for an order

enter Ship Ticket Print and select B2B Sales
Doc in the Activity Description field.

send the sales document in XML format by way
of B2B Commerce.

enter BC-XML Submit Order and Select B2B
Sales Doc in the Activity Description field.

In the Foreground and Backround fields, accept the default setting.

Select the trigger you just added and select use the Activity Properties from the File menu.

Enter the URL to which to post the ASN for this customer and press Enter .

Return to the Customer record.

Save your changes and exit the window.

To send triggered e-mailsand faxeswhen an order is submitted:

16

1

From the M aintenance menu, select Customer and display the customer to which you want to

assign triggers.

From the Additional menu, select Activity Trigger to display the Activity Trigger Maintenance

window.

© 2011 Epicor Software Corporation. All rights reserved.




Rel.8.7.2

Business Connect XML

3. IntheTrigger Description field, do one of the following:
To... Do this...
acopy of the sales order to the customer's e- enter BC-XML Submit Order and select E-
mail address submitted in the XML document | mail Sales Doc in the Activity Description

field.

send a message indicating that you received enter BC-XML Submit Order and select E-
the customer's sales or to the customer's e- mail M essage in the Activity Description
mail address submitted in the XML document | field.
send a message and a copy of the sales order enter BC-XML Submit Order and select E-
in HTML format to the customer's e-mail mail Sales Doc HTML in the Activity
address submitted in the XML document Description field.
send a copy of the sales order to the enter BC-XML Submit Order and select
customer's fax number submitted inthe XML | FAX Sales Doc in the Activity Description
document. field.
add the sales order to a Tradepowers enter BC-XML Submit Order and select
purchase order acknowledgement that the FTP TradePowers PO Ack in the Activity
system sends by FTP to the customer at a Description field.
future date.

4. Inthe Foreground and Background fields, accept the default setting.

5. Select thetrigger you just added and select Activity Properties from the File menu.

6. Enter the URL to which to post the ASN for this customer and press Enter.

7. Return to the Customer record.

8. Save your changes and exit the window.
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Setting System Notifications for XML Customer Transactions

While processing XML transactions, the system can notify users or message groups using the Eclipse
message System about events, such as when it receives a new order from a customer, or when a
transaction encounters problems processing through the system.

Define notification settings for each customer with which you conduct business using XML. If the system
receives an order and cannot identify the customer who sent it, the system sends notifications to the user
or users defined in the IDMS-XML Admin Message User/Group control maintenance record.

To set system natificationsfor XML customer transactions:

1. Display the character-based system.

Note: The error message user functionality has not been incorporated into Solar Eclipse
as of thisrelease.

2. Fromthe Files menu, select Customer to display the Customer Maintenance screen and open a
customer record.
Use the Remote hot key to display the Remote Order Entry Parameters screen.
Do one of the following:

e Todefineauser or set of usersto receive notification for all types of remote transactions, enter
the ID to receive messages in the following fields:

o Default User Messaged With New Order #
o Default User Messaged With Order Changes
o Default User Messaged With Errors

e Todefineadifferent user or set of usersfor XML transactions, use the Remote M essaging hot
key, select Business Connect, and enter user 1Ds to receive messaged in the following fields:

o User to be Messaged With New Order #
o User to be Messaged With Order Changes
o User to be Messaged with Errors
Press Esc to return to the Customer Maintenance screen.

Press Esc to save your changes and exit the record.
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Setting Post Locations for XML Customer Transaction
Documents

For each customer you do business with using XML, define the URL location to which to save outgoing
documents, such as order acknowledgements, invoices, and advance ship notices. This URL can be
specific for each type of transaction, or adefault for all transactions for the customer, regardless of the

type.

If the transactions with a customer are inbound only, a post location is not required for sending the
standard Status 200 HT TP response that indicates to the customer's system that you received their XML
document transmission.

To set post locationsfor XML customer transaction documents:

1. Fromthe Maintenance menu, select Customer to display the Customer Maintenance window
and open a customer record.

2. Fromthe Orders menu, select Remote Order Entry Parameter sto display the Remote Order
Entry Parameters window.

3. Fromthe Edit menu, select WOE I nformation to display the B2B/WOE Remote Order Entry
Parameters window.

4. Inthe B2B Post URLsfield in the URLs section at the bottom of the window, enter the post
|ocation for each XML document for the customer.

The system uses the location in the Default transaction type if all transactions' posts go to the
same location for the customer. If the customer requires posts for different transaction typesto go
to different locations, set the URL for the individual transaction type.

To trade secure information, such as credit card information, use the HTTPs transport protocol
instead of plain HTTP. Specify the post URL as https.// instead of http://.

5. Savethe customer record to save your changes.
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Defining Pricing Variance for XML Customer Transactions

For each customer you do business with using XML, you can select whether to use the pricing
information defined in Eclipse, or the pricing information the customer sends to you in an XML
document for atransaction. In addition, you can set an acceptable dollar amount or a percentage rangein
which the price can differ and still use the customer's pricing information. Set the following to set the
pricing variance for XML customer transactions:

o Partner pricing parameter.
¢ Allowed variancein pricing.

If the Use Partner Pricing parameter is set in the order document details for this customer, the system
uses the setting as defined in the order document details rather than the setting in Customer Maintenance
for XML transactions. However, other remote transactions still use the Customer Maintenance parameter
Setting.

To set the partner pricing parameter for a customer:

1. Fromthe Maintenance menu, select Customer to display the Customer Maintenance window
and open a customer record.

2. Fromthe Orders menu, select Remote Order Entry Parameter sto display the Remote Order
Entry Parameters window.

3. Fromthe Edit menu, select WOE I nformation to display the B2B/WOE Remote Order Entry
Parameters window.

4. From the Edit menu, select IDM S- XML Parametersto display the IDMS-XML Parameters
window.

5. Select the Use Partner Pricing check box to indicate that you want to use the pricing information
the customer sends to you with an order.

Save your changes and return to the Remote Order Entry Parameters window.

Continue with the next procedure.
To set the allowed variancein pricing:

Compl ete the previous procedure.

2. IntheAllowed Pricing Variance Percentagefield, select Dollar Amt or Per centage to indicate
the measurement type for the pricing variance.

3. Enter the dollar amount or percentage in which a customer's pricing information is allowed to
differ from the pricing defined in Eclipse.

If the difference between the customer's pricing information and that defined in Eclipseis outside
the range that you enter here, the system uses the pricing information defined in Eclipse.

Note: The variance you enter in thisfield is the variance the system uses for all remote
order entry transactions, not just XML transactions. However, if the pricing
parameter is not set, the variance does not apply to XML transactions.

4. Saveyour changes and exit the customer record.

20 © 2011 Epicor Software Corporation. All rights reserved.



Rel. 8.7.2 Business Connect XML

Defining Customer E-Commerce IDs for XML Transactions

The system uses customer e-commerce |Ds to identify shipping locations that you service. The system
uses the IDs to determine the customer's ship-to account to use when creating an order. When entering
customer e-commerce |Ds, remember that they can be in any format; however, each ID must be unique.
When you create your transaction maps for a customer, you can map the customer's incoming customer
number to the ship-to element in Eclipse. For the system to identify and match the datato a customer
record, concatenate a literal string to the beginning or the end of the incoming data to make it unique.

For example, if your trading partner sends you a customer number of 1234, that number might not be
unique to a customer record in Eclipse. To convert the number to a unique e-commerce 1D, such as
ABC1234, you can concatenate an a pha string to the beginning of the data using aliteral string and the
concatenate operation in the mapping utility. Now the system has a unique identifier to which it can
match the ship-to and bill-to information for an order for the customer.

E-commerce IDs are a so used with Aribatransactions.

To define customer e-commerce | Dsfor XML transactions:

1. Fromthe Maintenance menu, select Customer to display the Customer Maintenance window
and open a customer record.

2. From the Orders menu, select Remote Order Entry Parameters to display the Remote Order Entry
Parameters window.

3. Fromthe Edit menu, select ECommerce | Dsto display the Customer Unique E-Commerce IDs
window.

Enter each ID on anew linein the window.
Save your changes and return to the main Customer Maintenance window.

Save the customer record.
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Setting Vendor Access Information for XML Documents

Before sending XML documents to atrading partner, define the web site and access information such as
login name and password, where the vendor retrieves documents that you send.

To set vendor accessinformation for XML documents:
1. Display the character-based system.

Note: The vendor access for XML document settings have not been incorporated into
Solar Eclipse as of thisrelease.

2. Fromthe File menu, select Vendor and display the vendor to which you want to set access
information.

3. Usethe WWW hot key then the B2B Commer ce hot key to display the Eclipse B2B Commerce
Vendor Maintenance screen.

4. Inthe WWW Addressfield, enter the full Uniform Resource Locator (URL) path used to access
the vendor’ s web site where documents from your system post. Include the “http://” in the URL.
For example, http://www.thewidgetspro.com.

Use the Expand WWW Address hot key to enter or view aweb site address that is longer than
the display area on the screen.

5. Enter the login information you use to access the vendor’ s site. If you are using Business Connect
XML to talk to another Eclipse system using Eclipse B2B Commerce, thislogin information is
required to compl ete transactions.

Field Description

Customer ID Y our company-assigned login identification.

Login Thelogin ID you use to access the vendor's web site to post requests.
Password The password you use to access the vendor's web site to post requests.

6. InthePreferred Remote Site New Order Statusfield, press F10 and select the default status for
orders placed remotely to this vendor.

7. Usethe Test Connection hot key to test your connection to the vendor. The system attempts to
connect to the vendor's web address, using your login information.

If the connection test is... Then...

successful the following message displays:
"Good Customer Number and Password. Connection was
successful."

not successful a message displays with troubleshooting information. For example,

the message might indicate that the password you specified is
invalid, or the web server would not allow a certain method. The
message often displays detailed HTML information that you can use
to determine the connection problem. Consult with the web experts
at your company or Eclipse for assistance.
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8. PressEsc until you return to the Vendor Maintenance screen.

9. Press Esc to save the vendor record and exit the screen.
Note: The All,Description,/Price Line,! Group field is used with the Eclipse B2B

Commerce companion product and is not required for trading XML documents
with avendor.
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Setting Vendor Activity Triggers for XML Documents

You can set up XML activities that events in the system automatically trigger. For more information
about activity triggers, see Assigning Activity Triggers.

Note: You must set post locations and activity triggers for XML documents to send
documents to your customers.
Y ou can set up the system to send a B2B Purchasing document when any of the following activities
occur:
e You create and exit a new purchase order.
¢ You create and exit a new purchase order bid.
e You create and exit new direct order.

¢ Receive a purchase order.

To send triggered B2B purchasing documents:

1. Fromthe Maintenance menu, select Vendor and display the vendor to which you want to assign
triggers.

2. Fromthe Additional menu, select Activity Trigger to display the Activity Trigger Maintenance
window.

3. IntheTrigger Description field, select the event for which you want to send a B2B purchasing
document.

For example, to send B2B documents for purchase orders, select New Purchase Order or New
Purchase Order Bid. To send a B2B document for a direct order, select New Direct Order.

4. IntheActivity Description field, select B2B Purchasing Document.
Note: In the Foreground and Background fields, accept the default setting.
5. Select thetrigger you added and select Activity Propertiesfrom the File menu a enter the URL
where the XML document posts for the vendor.
Return to the VVendor record.
Save your changes and exit the window.
8. Set the post location for the documents you send to the vendor using XML.
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Setting Post Locations for XML Vendor Transaction
Documents

For each vendor you do business with using XML, define the URL location to which to save outgoing
documents, such as orders, quote requests, and product inquiries. This URL can be specific for each
transaction type, or adefault for al transactions for the vendor, regardless of type.

Note: Y ou must set post locations and activity triggers for XML documents to send
documents to your vendors.

To set post locationsfor XML vendor transaction documents:
1. Display the character-based system.
Note: The post locations for vendor transaction documents has not been incorporated into
Solar Eclipse as of thisrelease.
2. Fromthe Files menu, select Vendor to display the Vendor Maintenance screen and open a
vendor record.

3. Usethe WWW hot key and then the B2B Commer ce hot key to display the Eclipse B2B
Commerce Vendor Maintenance screen.

4. Usethe B2B Post URL hot key and select the type of transaction for which you are setting the
post location.

The system uses the location in the Default transaction type if all transactions' posts go to the
same location for the vendor. If the vendor requires posts for different transaction typesto go to
different locations, set the URL for the individual transaction type.

Inthe B2B Post URL field, enter the post location for XML documents for the vendor.
Press Esc until you return to the Vendor Maintenance screen.

Press Esc to save the vendor record and exit the screen.
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Remote Document Details Overview

For each customer or vendor with whom you have a remote trading rel ationship, define additional
document settings for each transaction you trade with them. Additional settings include but are not limited
to indicating who the system notifies when it receives a transaction of a given type and setting the initial
order status.

Use Remote Trading Partner Maintenance to define details for each document type that you receive or
send to each customer and vendor.

Note: In the current release, you can only define details for XML documents in Remote
Trading Partner Maintenance. Define EDI document details through EDI Group
Profile Maintenance.

For customers, some of the document details that you can set in Remote Trading Partner Maintenance,
such as who to notify about a certain document transmissions and pricing variances can also be set in the
customer record. Setting document detailsin Remote Trading Partner Maintenance overrides the settings
defined at the customer level.

Define details for the following remote document types:
e Orders
¢ Advanced ship notices

Change order requests

Quote requests

Order acknowledgements

Invoices
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Setting Remote Order Document Details

Use Remote Trading Parther Maintenance to set additional details about remote order documents that you
trade with your customer and vendors.

Note: In the current release, you can only define details for XML documentsin Remote
Trading Partner Maintenance. Define document details for EDI 850 purchase
orders through EDI Group Profile Maintenance.

To set remote order document details:

1
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Display the character-based system.

Note: The Remote Trading Partner Maintenance functionality has not been incorporated
into Solar Eclipse as of thisrelease.

From the System > Custom menu, select Remote Trading Partner Maintenance to display the
Remote Trading Partner Maintenance screen.

Inthe Trading Partner field, enter the trading partner for which you want to set remote order
document details. Press F10 for alist of trading partners that have transaction maps defined in the
Business Connect XML mapping utility.

In the Remote Type field, select the type of remote transaction for which you want to set details.

Note: In the current release, Remote Trading Partner Maintenance supports only XML

transactions.

Press Enter to display the list of transactions that have transaction maps defined for the trading

partner.

Select the order submit transaction and use the Add'l Doc Info hot key to display the additional
detail fields for the transaction type.

Enter the detail information as necessary for the transaction type:

Field

AppliesTo

Description

User To Notify

Ordersreceived from
customers

The user or message group that receives
notification when the system receives an order
from this customer.

Setting this parameter overrides notification
settings for this transaction type that are set at
the customer level.

User To Review

Ordersreceived from
customers

The user or message group that reviews orders
from this customer.

Setting this parameter overrides notification
settings for this transaction type that are set at
the customer level.

Initial Order Status

Orders received from
customers

The status default for al remote orders you
receive from the customer. We recommend
setting the initial order status to Bid.
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Field

AppliesTo

Description

Use Partner Pricing

Orders received from
customers

Indicates whether to use the pricing
information defined in Eclipse, or the pricing
information the customer sends to you in the
order request.

Setting this parameter overrides partner
pricing parameters that are set at the customer
level.

Remote Order Entry
%

Ordersreceived from
customers

The dollar amount or percentage in which a
customer's pricing information is allowed to
differ from the pricing defined in Eclipse.

If the difference between the customer's
pricing information and that defined in Eclipse
is outside the range that you enter here, the
system uses the pricing information defined in
Eclipse.

Setting this parameter overrides pricing
variance parameters that are set at the
customer level.

Round Up to Min
Sales Qty

Orders received from
customers

I ndicates whether the system rounds order
guantities to the minimum sales quantity for
each item on an order. Set thisfield to No to
allow the user to order any quantity.

Notify of Receipt

Orders sent to vendors

The user or message group that receives
notification when your vendor's system
receives an order from this customer.

Send Pricing Data In
Qty UOM

Orders sent to vendors

Converts the pricing information to the same
unit of measure as the quantity information.

9. PressEscto close the screen and save your changes.

8. PressEsc to return to the Remote Trading Partner Maintenance screen.
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Setting Remote Advanced Ship Notice Document Details

Use Remote Trading Partner Maintenance to set additional details about remote advanced ship notice
(ASN) documents that you trade with your customers and vendors.

Note: In the current release, you can only define details for XML documentsin Remote
Trading Partner Maintenance. Define document details for EDI 856 ASNs through
EDI Group Profile Maintenance.

To set remote ASN document details:

1

Display the character-based system.
Note: The Remote Trading Partner Maintenance functionality has not been incorporated
into Solar Eclipse as of thisrelease.
From the System > Custom menu, select Remote Trading Partner Maintenance to display the
Remote Trading Partner Maintenance screen.

In the Trading Partner field, enter the trading partner for which you want to set remote ASN
document details. Press F10 for alist of trading partners that have transaction maps defined in the
Business Connect XML mapping utility.

In the Remote Type field, select the type of remote transaction for which you want to set details.

Note: In the current release, Remote Trading Partner Maintenance supports only XML
transactions.

Press Enter to display the list of transactions that have transaction maps defined for the trading

partner.

Select the advance ship notice transaction and use the Add'l Doc I nfo hot key to display the
detail fields for the transaction type.

Enter the following information, as necessary for the document type:

Field AppliesTo Description
User to Review ASNSs received from The user or message group that reviews ASNs
vendors from the trading partner.
User to Notify ASNSs received from The user or message group that receives
vendors notification when the system receives an ASN
from there trading partner.

Press Esc to return to the Remote Trading Partner Maintenance screen.

Press Esc to close the screen and save your changes.
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Setting Remote Change Order Document Details

Use Remote Trading Partner Maintenance to set additional details about remote change order documents
that you trade with your customers and vendors.

Note: In the current release, you can only define details for XML documents in Remote
Trading Partner Maintenance. Define document details for EDI 860 purchase
order change requests through EDI Group Profile Maintenance.

To set remote change order document details:
1. Display the character-based system.
Note: The Remote Trading Partner Maintenance functionality has not been incorporated
into Solar Eclipse as of thisrelease.
2. Fromthe System > Custom menu, select Remote Trading Partner Maintenance to display the
Remote Trading Partner Maintenance screen.

3. Inthe Trading Partner field, enter the trading partner for which you want to set remote change
order document details. Press F10 for alist of trading partners that have transaction maps defined
in the Business Connect XML mapping utility.

4. Inthe Remote Typefield, select the type of remote transaction for which you want to set details.
Note: Inthe current release, Remote Trading Partner Maintenance supports only XML
transactions.
5. PressEnter to display the list of transactions that have transaction maps defined for the trading
partner.

6. Select the change order transaction and use the Add'l Doc I nfo hot key to display the detail fields
for the transaction type.

7. Enter the detail information, as necessary for the transaction type:

Field AppliesTo Description
User to Review Change orders received from The user or message group that
customers reviews change orders from this
customer.

Setting this parameter overrides
notification settings for this
transaction type that are set at the

customer level.
User to Notify Change orders received from The user or message group that
customers receives notification when the
system receives an order from this
customer.

Setting this parameter overrides
notification settings for this
transaction type that are set at the
customer level.
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8. PressEscto return to the Remote Trading Partner Maintenance screen.

9. PressEsc to close the screen and save your changes.
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Setting Remote Quote Request Document Details

Use Remote Trading Partner Maintenance to set additional details about remote quote request documents
that you trade with your customers and vendors.

Note: In the current release, you can only define details for XML documents in Remote
Trading Partner Maintenance. Define document details for EDI 840 quote requests
through EDI Group Profile Maintenance.

To set remote quote request document details:

1

8.
0.

32

Display the character-based system.
Note: The Remote Trading Partner Maintenance functionality has not been incorporated
into Solar Eclipse as of thisrelease.
From the System > Custom menu, select Remote Trading Partner Maintenance to display the
Remote Trading Partner Maintenance screen.

Inthe Trading Partner field, enter the trading partner for which you want to set remote quote
request document details. Press F10 for alist of trading partners that have transaction maps
defined in the Business Connect XML mapping utility.

In the Remote Type field, select the type of remote transaction for which you want to set details.

Note: In the current release, Remote Trading Partner Maintenance supports only XML
transactions.

Press Enter to display the list of transactions that have transaction maps defined for the trading

partner.

Select the quote request transaction and use the Add'l Doc Info hot key to display the detail
fields for the transaction type.

Enter the detail information, as necessary for the transaction type:

Field AppliesTo Description
User To Notify Quote reguests received The user or message group that receives
from customers notification when the system receives a quote

request form the trading partner.

Setting this parameter overrides notification
settings for this transaction type that are set at
the customer level.

User To Review Quote requests received The user or message group that reviews quote
from customers requests from the trading partner.

Setting this parameter overrides notification
settings for this transaction type that are set at
the customer level.

Press Esc to return to the Remote Trading Partner Maintenance screen.
Press Esc to close the screen and save your changes.
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Setting Remote Order Acknowledgement Document Details

Use Remote Trading Partner Maintenance to set additional details about remote order acknowledgment
documents that you trade with your customers and vendors.

Note: In the current release, you can only define details for XML documents in Remote
Trading Partner Maintenance. Define document details for EDI 855 purchase
order acknowledgements through EDI Group Profile Maintenance.

To set remote order acknowledgement document details:

1

Display the character-based system.
Note: The Remote Trading Partner Maintenance functionality has not been incorporated
into Solar Eclipse as of thisrelease.
From the System > Custom menu, select Remote Trading Partner Maintenance to display the
Remote Trading Partner Maintenance screen.

Inthe Trading Partner field, enter the trading partner for which you want to set remote order
acknowledgment document details. Press F10 for alist of trading partners that have transaction
maps defined in the Business Connect XML mapping utility.

In the Remote Type field, select the type of remote transaction for which you want to set details.

Note: In the current release, Remote Trading Partner Maintenance supports only XML
transactions.

Press Enter to display the list of transactions that have transaction maps defined for the trading

partner.

Select the order acknowledgement transaction and use the Add'l Doc I nfo hot key to display the
detail fields for the transaction type.

Enter the detail information, as necessary for the transaction type:

Field AppliesTo Description
User to Notify e Order acknowledgementssentto | The user or message group that
customers receives notification when the system
o Order acknowledgements receives an order acknowledgment
received from vendors from the trading partner.

Setting this parameter overrides
notification settings for this
transaction type that are set at the

customer level.
User to Review e Order acknowledgementssent to | The user or message group that
customers reviews order acknowledgments from
e Order acknowledgements this trading partner.
received from vendors Setting this parameter overrides

notification settings for this
transaction type that are set at the
customer level.
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Field AppliesTo Description
Initial Order Status Order acknowledgements received The status default for all remote order
from vendors acknowledgments you receive from
the trading partner.
Dflt Lead Timeif Order acknowledgements received The number of daysit takesthe
NO Shp Dt Provided | from vendors vendor to ship the material out of

their warehouse. The system addsthis
number to the date of the order
acknowledgement and uses this
calculated date as the expected
receive date for the order.

Update Req'd Date Order acknowledgements received Updates the required date of the order
with the Ship Date from vendors with the calculated ship date from the
vendor.

8. PressEsc to return to the Remote Trading Partner Maintenance screen.

9. PressEsc to close the screen and save your changes.
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Setting Remote Invoice Document Details

Use Remote Trading Partner Maintenance to set additional details about remote order invoice documents
that you trade with your customers and vendors.

Note: In the current release, you can only define details for XML documents in Remote
Trading Partner Maintenance. Define document details for EDI 810 invoices
through EDI Group Profile Maintenance.

To set remoteinvoice document details:
1. Display the character-based system.
Note: The Remote Trading Partner Maintenance functionality has not been incorporated
into Solar Eclipse as of thisrelease.
2. Fromthe System > Custom menu, select Remote Trading Partner Maintenance to display the
Remote Trading Partner Maintenance screen.

3. IntheTrading Partner field, enter the trading partner for which you want to set remote invoice
document details. Press F10 for alist of trading partners that have transaction maps defined in the
Business Connect XML mapping utility.

4. Inthe Remote Typefield, select the type of remote transaction for which you want to set details.
Note: In the current release, Remote Trading Partner Maintenance supports only XML
transactions.
5. PressEnter to display the list of transactions that have transaction maps defined for the trading
partner.

6. Select theinvoice transaction and use the Add'l Doc Info hot key to display the detail fields for
the transaction type.

7. Enter the detail information, as necessary for the transaction type:

Field AppliesTo Description
User to Notify e Invoicesreceived from The user or message group that receives
vendors notification when the system sends or

e Invoices sent to customers receives an invoice from the trading partner.
Setting this parameter overrides notification
settings for this transaction type that are set
at the customer level.

User to Review e Invoicesreceived from The user or message group that reviews
vendors invoices from the trading partner.

e |nvoices sent to customers Setting this parameter overrides notification

settings for this transaction type that are set

at the customer level.

Enable Auto Invoices received from Indicatesif the system reconciles and
Approveon vendors approves a remote invoice automatically
Invoicing when the line items match and the dollar

amount is within the over/short range.
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Field AppliesTo Description

Create Ack/ASN Invoices received from Indicatesif the system should create an
Documents From vendors acknowledgement document or an advance
Inv ship document from an invoice.

Reconcile I nvoice
Freight Changes

Invoices received from
vendors

Indicatesif the system marks the invoice as
a prefect match in the Remote Invoice
Review Queue when the invoice amount
differs from the purchase order amount by
the total freight amount.

Process | nvoices for
Directs

Invoices received from
vendors

Indicatesif the system tries to match the
invoice from your vendor to the purchase
order of adirect order. If it finds a match,
the system receives that purchase order
generation and reconciles the invoices
against that generation.

Enable Terms
Checking

Invoices received from
vendors

Indicatesif the system verifies the terms
defined in the invoice from your vendor
with the terms from the purchase order. If
the terms do not match, the match level in
the Remote Invoice Review QueueisT.

Create Payablesfor
Non-Eclipse PO#s

Invoices received from
vendors

Indicates whether the system creates a
payable for non-Eclipse purchase order
numbers. The system checks the vendor's
home branch and first authorized branch if
thereisno valid G/L branch.

Freight Already
Posted on Eclipse
PO

e |nvoices received from
vendors

¢ |nvoices sent to customers

Indicates whether the freight is already
posted on the Eclipse purchase orders. The
customer posts the freight to the purchase
order during the receiving process. Direct
orders do not have freight included on the
purchase order. Vendors may bill for freight
and have this put in the freight bucket in AP
Entry.

Check All Unpaid
Gens

Invoices received from
vendors

Indicates whether the system checks for an
exact match on one generation and then also
checks for an exact match by summing all
the received, unpaid generations on that
purchase order. If you leave thisfield blank
or enter No, the system checks for matches
only at the generation level.

Send Credit/zero
Bal. Invoices

Invoices sent to customers

Indicatesif the system should send invoices
with negative (credits) or zero balances.

Send Pricing Datain
Qty UOM

Invoices sent to customers

Converts the pricing information to the
same unit of measure as the quantity
information.

8. PressEsc to return to the Remote Trading Partner Maintenance screen.

9. PressEsc to close the screen and save your changes.
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XML Schema Maintenance Overview

Use XML Schema Maintenance to define and access data stored in any file in Eclipse when using
Business Connect XML to receive and send transactions. XML database schemas are similar to Eclipse
dictionaries, in that they display data file information so you can easily view and understand it. XML
database schemas provide additional information specific to the XML interface and trandlation of datato
and from the database. Each datafilein Eclipse can have a corresponding XML database schema.

The system uses XML database schemas to store data when receiving transactions via XML, such as
order submits or stock inquiries, and to retrieve datato send out using XML. Each XML transaction type
calls one or more XML database schemas, grouped into transaction schemas. For example, an
OrderSubmit transaction schema uses the Order and OrderDetail database schemas to store and retrieve
the data required to submit an order in the system using XML. For more information, see How XML
Database Schemas Form Transactions.

Note: Business Connect XML includes a set of predefined XML transaction types such
as order submits and remittance advice. For acomplete list of the supported
customer and vendor transactions, see Sending and Receiving Customer
Transactions Using XML and Sending and Receiving Vendor Transactions Using
XML.

Y our system administrator has the ability to add or modify data definitions to a schema or add additional
schemas required for your business relationships. Eclipse personnel set up the following default XML
database schemeas.

o Contact
o Entity
o Order
e OrderAdditional
¢ OrderChange
e OrderDetail
o OrderDetailChange
e Product
e Territory
Use the following instructions to create or modify XML database schemas:
e Creating XML Database Schemas
e Defining XML Database Schema Trand ation Properties
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Eclipse Data and XML Database Schemas

If you are defining your own XML database schemas or are adding additional information to the default
XML schemas provided to you, it is important to understand how Eclipse stores and retrieves data.
Understanding the database structure helps to ensure that you enter the correct attribute, value, and sub-
value marksin XML Schema Maintenance.

This topic discusses the following information:
e The Eclipse Database
¢ XML Database Schemas' Relationships to Eclipse

Eclipse Database
The Eclipse system stores its information in a nested relational database.

o Datais separated and stored in files. For example, the Product file contains details about the
products you sell, and the Contact file contains information about contacts at customers you do
business with.

e Each file contains records. For example, the Contact file contains arecord for each contact in your
system.

o Each record contains fields of information called attributes. Within each record the same type of
information is stored in the same attribute. For example, attribute 1 in a contact record isthe
contact's first name.

Attribute | Attribute | Attribute
0 1 2 Attribute 11
Item First Last
ID Name Name Email
Record 1 | 001 John Doe johndoe@nowhere.com
Record 2 | 002 Jane Doe janedoe@nowhere.com

A unique key identifies every record in the system. The key is anumber, which the system
assigns when you create the record. The system stores the key in attribute number O (zero).

Note: Y ou cannot change the unigue key in attribute O.

o Attributes can contain multiple pieces of data, called values. For example, for each contact, you can
have multiple phone numbers.

Attribute| Attribute | Attribute
0 1 2 Attribute 11 Attribute 14
Item First Last
ID Name Name Email Phone Number
Record | 001 John Doe johndoe@anywhere.com Value:: 303-555-1234
1 Value: 303-555-4321
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Attribute| Attribute | Attribute
0 1 2 Attribute 11 Attribute 14
Item First Last
ID Name Name Email Phone Number
Record | 002 Jane Doe janedoe@anywhere.com Value: 303-555-5678
2 Value: 303-555-8765

¢ A value can contain one or more pieces of data, called sub-values. For example, for each contact,
you can have multiple credit cards on file.

Attribute
0

Attribute
1

Attribute
2

Attribute 11

Attribute 26

Iltem
1D

First
Name

Last
Name

Email

Credit Card

Record

001

John

Doe

johndoe@anywhere.com

Value: Credit Card Type
Sub-value: Visa
Sub-value: MC

Value: Credit Card #
Sub-value:
1111111111111111
Sub-value:
2222222222222222

Record

002

Jane

Doe

janedoe@anywhere.com

Value: Credit Card Type
Sub-value: Visa
Sub-value MC

Value: Credit Card #
Sub-value:
3333333333333333
Sub-value:
A4444444404444444

XML Database Schemas' Relationship to Eclipse

When defining XML database schemas, it isimportant to enter the correct attribute, value, and sub-value
positions for each data definition within the schema. If the attribute or value marks are incorrect, it can
cause data to be stored in the wrong position within arecord in the Eclipse database. When creating your
own schemas, or entering additional data definitions for existing schemas, study the record layout that
you are defining data for in XML Schema Maintenance using Dictionary Maintenance.

For example, in the Contact record, attribute 7 is the contact's address information. When entering a
contact in Eclipse you enter the information in the Addressfield, and the address can be up to two lines
long. In the following example, John Doe's contact information is contained in record number 7772, and
his addressis 123 Anywhere Lane, #12A.
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Contact Maintenance
Fir=t Hame : .ohn Middle -
Last Name : Doe Sal =l
Entity

Address :

: BB301
. Doedoh
Company : John Doe’s Supplwy
[ i £
Classification :
Codes Description
Work |Davtime phone.
Cell |(Alternative davtime phone.

When you save the contact record in above example, the system stores the address information in attribute
7 within the contact record numbered 7772.

LIST.ITEM CONTACT = 7772 03:23:40pm @7 Apr 2004 PAGE

A9 0

i1 30301 .
4 303-555-12347 303-555-4321
y Davtime phone. Hlternative davtime phone.
Hork Cell
13247755413
John Doe's Supply
z )

g

Attribute 7 consists of the following values, separated by a superscript 2:
e AddressLine 1 whichis 123 Anywhere Lane
e AddressLine 2 whichis#12A

The Contact XML database schema contains attribute 7 and indicates that Address Line 1 is part of
attribute 7 in Eclipse, and any information entered there is saved in value 1. Address Line 2 is also part of
attribute 7, that information is saved in value 2 of attribute 7.
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Y Schemna Maintenance
SML Database Schema : COMTACT
Eclipse File———HHL Hame————FHHL Description

CONTARCT ContactID Contact ID

CONTACT Fir=ztName First Mame

CONTACT Hidd]eName Hiddle Hame

CONTRCT LastName Last Mame

CONTRCT Salutation Salutation

CONTACT Sorthy SortBy

CONTACT UsebntityAddress Use Parent Entity Addres

T , Jeldress L1 i

Address Lir

l=a Ly B b

CONTACT

CONTRCT Zip )

CONTACT EmailRddress Email Address
CONTARCT Title Title

CONTACT Wehsite Wehsite

COMTRCT PhoneNunber Phone MNumber
CONTACT PhoneDescription Phone De=scription

CONTACT PhoneCode Phone Code

Properties | Import | Delete I | F12 - Abort
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How XML Database Schemas Form Transactions

A transaction schemais one or more XML database schemas that define an XML transaction type. For
example, Business Connect XML includes the following XML database schemas:

o Order - Includes items such as the bill-to address and the payment terms.
e OrderDetail - Contains the items being ordered, including product ID and total order quantities.

An order in the system includes the information required to ship the order and the information about what
is being purchased or sold. The OrderSubmit transaction schema contains both the Order and OrderDetail
database schemas to create a complete order submit transaction. An XML database schema can be
included in more than one transaction schema. For example, the Order and OrderDetail schemas are aso
used to create an invoice transaction.

Note: Business Connect XML includes a set of predefined XML transaction types such
as order submits and invoices. For acomplete list of the supported customer and
vendor transactions, see Sending and Receiving Customer Transactions Using
XML and Sending and Receiving Vendor Transactions Using XML. Y ou cannot
create your own transaction schemas.

A transaction can be one of the following types:
¢ Inbound inquiry, such as aprice and availability check.

¢ Inbound update, such as an order submit or change order from a customer or an invoice from a
vendor.

¢ Outbound, such as a purchase order you are sending to a vendor.

Transaction Schemas and the XML Mapping Utility

Transaction schemas defined in Eclipse are available for selection as transaction typesin the Business
Connect XML mapping utility. When you create a new transaction map in the mapping utility, select the
transaction type, or schema, in the Transaction Typefieldsfor both the received and sent documents:
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@ New Transaction Map @

Transaction MName | Purchase Order

Trahzaction Source | |

Do

Transaction Type | Order Subrit
Cu

> 7]
I ! | " | Browse

|:| Mo Docurnent Wil Be Received

- | Browse

|:| Mo Document Will Be Received

Tranzaction Type |Order Suh

Cu

[ Ok H Cancel ” Help ]

Business Connect XML

The contents of the transaction schema display as the target or source XML in the mapping utility,
depending on the type of transaction you are creating and whether you are viewing the received or sent to
map. In the following example, the OrderSubmit transaction schema contains the Order and OrderDetail

XML database schemas.
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ma 1 ORDERSUBHLT
IHBOUND UPDATE

The #ML database schemas contained
in the fransaction schema display as the
target or source XML far the transaction.

"t iE¢| 2

HML Transaction Type

ER . .

e The transaction schema displaved reflects
JRDERDETAIL whether the transaction is for a vendor ar

a custamer. In this example, the order

submit requestis fram a customer.

aML Database Schema :

WML Hame—
Product ID

Eclipse File
LEDGER
LEDGER

LEDGER

rrnperliaq Impnrt

The order detail datais stored in the table called Linelteminfo defined for the OrderDetail XML database

Dacument Received Fratm Customer

Reply Docurmert Sent to Custorder || Mapping Selection Criteria

E Source XML
=@ PURCHASEORDER

1

+— @ HEADERBLOCK ]

+— 1@ CUSTOMERIDEHTIFIERS =@ OrderDetsi

+— @) VENDOR =@ Linsteminfa (+)
I  —

+— (D SHIPTOADDRESS @ UPCCode

+1@ CONFIRMTOADDRESS (71
'I"—@ INWOICEADDRESS (7)
13 COMPANYADDRESS (7]

—D ProcuctiD
E:g PONUM Ejj —m temComment
i MOTES (7) —@ Totaloty

+-1B REQUISITION (71
'I"—@ RELEASEMUM (7]
s Ta:nt AU

DR Eque Inae

Itemlamment
TotalQty
plty

InStockShi
Kkl

e L
Cost0fhoods5old

Mapping (B

—iP CatalogMumber
—@ UserDefinedinfo
—i@ Productheywords

—ED InStockShipoty
—i® MonStock Gty
—Ii@ RequiredDste
—D selPrice

—@ FriceCrerride
—D CostOfGoodsSold

Drderedll oM
Customerl ineHumn
“us tomerPH

I Delete

The items contained in

the XML database schemas
are availahle for the transaction
in the XML mapping utility.

schema's properties, and displays nested in the XML mapping utility.
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BML Database Schema :
Eclipse File

LEDGER

Tnlalﬂtﬂ
InStockShiplty
HonSlackly
EBequiredDate
SellPrice
Pricelverride
Cost0fbhoodsSold
[ll'dl.'.l'ﬂl“lDH
CustorerLineHum
fustonerPH

EML Deseription
Internal Product ID
Line Ttem Gomment
Total Quantity Dedered
In 5tock Ship Quantity
fom Stock Quantily
Jroduct Required Date
tell Price
‘rice Override
+05t of Good 5olds COGS
UIH as Ordered
Customer Line Humber
Customer Fart Humber

Bl b Sl S ] Y B ek

Al
o
1]
1}
o
0
o
1]
1}
1}
0
1}
1]

P

=
wn
=

Business Connect XML

chema Properties
Batabase Schema HHD[RU[TﬂIL
Eclipse File LEDGER
&ML Hame : FProdoctlID

Froperties dmport | Dele EML Deseriplion : Internal Producst ID

Eclipse Database Data Type @ Humeric
Domain Object Data Type Intrqer
Fointer to Database

The OrderDetail database
schema infarmation saves
to a table called Linelteminfo.

Hulti
| Document Received From Customer Reply Documert Sert to Customer | Mapping Selection Criteris |
Source KL i
B e 1 eies o (O s The contents of the
=~® PURCHASEORDER — | 8 CustomerOyes bk OrderDetail database
?‘Fﬁ HEADERELOCK £7) +@ Optler schema displays under
#@ CUSTOMERIDENTIFIERS = the table name
1 . .
¢.—@ VEHDOR ! =@ Linetterinfo [+
@ SHIPTOADDRESS 3
; i —I@ Cataloghlumber
i"@ COMFIEMTOADDRESS (7] ® k
1 —_—
# @ MvOICEADDRESS (7) W& UserDefinedinfo
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Creating XML Database Schemas

Use XML Schema Maintenance to define new XML database schemas. One way to create XML database
schemas is to dictionaries directly from Eclipse files. Importing dictionaries saves you timeif asimilar
dictionary is aready defined for the XML database schema you want to create. Y ou can also create XML
database schemas from scratch without importing Eclipse dictionaries.

Note: You can also modify schemas or delete schemas using XML Schema Maintenance.

Use XML Schema Maintenance to complete the following tasks:
o Import Eclipse dictionariesto create an XML database schema.
o Create XML database schemas without importing dictionaries.
¢ Modify and delete XML database schemas.

Importing Eclipse dictionaries to Create an XML Database Schema

Importing existing dictionaries saves you time if asimilar dictionary is already defined for the XML
database schema you want to create.

Toimport Eclipsedictionariesto create an XML database schema:

1. Fromthe System > Custom > Add On Products > Eclipse B2B Products menu, select XML
Schema M aintenance to display the XML Schema Maintenance screen.

Note: If prompted, log on to the charcter-based system.

2. Inthe XML Database Schema field, do one of the following:
¢ Type the new name of the schema that you want to create and select New.

e PressF10 to select an existing XML database schemato which you want to add information
from an Eclipse dictionary.

4. Inthe Eclipse Filefield, enter or select the Eclipse file that contains the data you want to include
in your schema. Y ou can enter standard Eclipse files or user-defined files. Press F10 to select a
valid file.

Press F10 for alist of files with dictionaries defined in your system.
5. Usethelmport hot key to import the dictionary information for the file.

Note: If you are an internal Eclipse user, answer Yes a the Use New dictionaries Only
prompt to import only the dictionaries that meet the new Eclipse dictionary
naming conventions. If you are not an internal Eclipse user, you do not receive
this prompt.
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6. The system displays details for each dictionary defined in the file you imported. Update the
information for each line, as necessary.

7.

Field

Description

XML Name

The system's trandlation of the dictionary name into XML format and
what displays in the Business Connect XML mapping utility when
mapping data to and from Eclipse data. The XML name contains no
spaces, and is formatted with initial caps, for example, Email Address
and PhoneNumber.

XML Description

The description for the dictionary as defined in Dictionary
Maintenance. Update the description for each line item as necessary to
further clarify each piece when mapping XML data.

AM The attribute marker for the data. See Understanding Eclipse Data and
XML Database Schemas for more information about attributes.

VM The value marker for the data within an attribute. See Understanding
Eclipse Data and XML Database Schemas for more information about
values.

SVM The sub-value marker for the data within a value. See Understanding

Eclipse Data and XML Database Schemas for more information about
sub-values.

Do the following to complete the XML database schema:

To...

Do this...

define XML database
schema translation
properties for each line

select the line for which you want to define trandation properties and
use the Properties hot key to display the XML Schema Properties
screen. See Defining XML Database Schema Trandation Properties for
additional information about defining schema properties.

Note: Setting trandation properties for each lineis required before you
can close the XML Schema Maintenance screen and compile the XML
for the schema.

delete the data definitions
that you do not want to map
to using the Business
Connect XML mapping
utility

select the line to delete and press Alt + Delete.

Y ou can only delete lines that you have added. Y ou cannot delete
standard Eclipse files that provide data essential for the supported
transaction sets.

modify the imported
information for a data
definition, such asthe
description listed in the
XML Description field

access the field and type the new information. Any updates that you
make to the XML name and XML description are made only to the
schema and do not apply to the dictionary that you imported.

Note: Although you can change the values for attribute marks, value
marks, and any sub-value marks, we recommend that you do not do so.
Changing these markers affects how datais stored.

8. PressEsc to save the schema and compile the associated XML.

Creating XML Database Schemas without Importing Dictionaries

Y ou can create XML database schemas without importing Eclipse dictionaries, however, importing
dictionaries does save time when creating schemas.
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To create XML database schemas without importing dictionaries:

0.

1

From the System > Custom > Add On Products > Eclipse B2B Products menu, select XML
Schema M aintenance to display the XML Schema Maintenance screen.

Note: If prompted, log on to the charcter-based system.
Inthe XML Database Schema field, type the name of the XML database schema you want to
create and select New.

In the Eclipse File field, enter or select the Eclipse file that contains the data you want to include
in your schema. Y ou can enter standard Eclipse files or user-defined files. Press F10 to select a
valid file.

Inthe XML Namefied, enter the name of the data definition, such as Addressl. The XML
name format cannot contain spaces. Use uppercase | etters to distinguish between words, such as
FirstName in a contact record.

Inthe XML Description field, enter adetailed description of the data. For example, for an XML
name of CreditCard, you might enter Default Credit Card Infointhe XML Description field.

Inthe AM field, enter the attribute mark for the data in the Eclipsefile.
Inthe VM fidld, enter the value mark, if any, for the data within the attribute in the Eclipsefile.

Inthe SVM fidld, enter the sub-value mark, if any, for the data within the attribute in the Eclipse
file.

With the line selected, use the Properties hot key and define the XML database schema

trandation properties.

10.

Press Esc to save the schema and compile the associated XML.

Modifying and Deleting XML Database Schemas

Y ou can add data definitions for your user-defined filesto the default schemas set up with your system or
delete an XML database schema that is no longer valid. Ensure that any schemas you want to delete are
not currently used in an XML transaction map for atrading partner.

Note: You can only delete XML database schemas that you created, not those provided
by Eclipse.

To modify XML database schemas:

48

1

Display the character-based system.

Note: The XML database schedule functionality has not been incorporated into Solar
Eclipse as of thisrelease.

From the System > Custom menu, select XML Schema Maintenance to display the XML

Schema Maintenance screen.

Inthe XML Database Schema field, enter or select the XML database schema you want to
modify and press Enter.
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4. Do any the following to modify the XML database schema:

To... Do this...
update XML database schema select the line for which you want to define trandlation properties
trandation properties and use the Properties hot key to display the XML Schema

Properties screen.

delete data definitions that you select the line you want to delete and press Alt + Delete.

do not want to include in the Y ou can only delete lines that you have added. Y ou cannot delete

schema standard Eclipse files that provide data essential for the supported
transaction sets.

modify the information for a for each line you want to change, access the field and type the new

data definition, such as, the information.

description listed inthe XM L

Description field Note: Although you can change the values for attribute marks,

value marks, and any sub-value marks, we recommend that you do
not do so. Changing these markers affects how data is stored.

4. PressEscto save your changes to the schema and to compile the new XML.

To delete XML database schemas:
1. Display the character-based system.
Note: The XML database schedul e functionality has not been incorporated into Solar
Eclipse as of thisrelease.
2. Fromthe System > Custom menu, select XML Schema Maintenanceto display the XML
Schema Maintenance screen.

3. Inthe XML Database Schemafield, enter or select the XML database schemato delete and
press Enter.

4. Usethe Delete hot key and type Delete at the prompt to confirm the removal of the schema.
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Defining XML Database Schema Translation Properties

Y ou need to define tranglation properties for each attribute in an XML database schema. The trandation
properties indicate to the system how datais converted from XML for storage in Eclipse, and how datais
converted from Eclipse for transmission using XML.

Each data definition in the database schema requires that you define the following:

e Thetype of datathat is stored in Eclipse, such as Text or Numeric.

e Thetype of information that isreceived or sent in XML, such as String or Integer.

Todefine XML schema trandation properties:

1

50

From the System > Custom menu, select XML Schema M aintenance to display the XML
Schema Maintenance screen.

Note: If prompted, log on to the charcter-based system.

Inthe XML Database Schema field, enter or select the XML database schemafor which you
want to define properties.

The Eclipse datafiles and their associated XML information display for each linein the schema.
See Creating XML Database Schemas for additional information.

Select the line for which you want to define properties and use the Properties hot key to display
the XML Schema Properties screen.

In the attribute and sub-value fields, for example AM and SSVM, the system displays the
information as it was defined in the XML Schema Maintenance screen. Update the values as
necessary.

As you define the properties for the attribute, update the attribute mark, value mark, and sub-
value marks as necessary for the data.

Note: Although you can change the values for attribute marks, value marks, and any sub-
value marks, we recommend that you do not do so. These markers change how
datais stored.

For additional information about attributes, values, and sub-values, see Eclipse Dataand XML
Database Schemas.

In the Eclipse Database Data Type field, select one of the following to identify the type of data
stored:

Data Type Description

Text The Eclipse data stored is atext string, such as the name or addressin a
customer or contact record. If you are unsure what type of data you are
defining, use Text as the default setting.

In the Wrap Width field, enter the number of charactersthat display before
wrapping occurs if the data for this field can wrap from one line to the next.
In the Delimiter field, enter the character or marker in the data that indicates
anew item. Typically, the delimiter for text is a value marker.
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Data Type

Description

Date

The Eclipse data stored is a calendar date. The Domain Object Data Type
field defaults to I nteger to reflect that the datafor a date is a number, such as
06/04/2004.

Numeric

The Eclipse data stored is a number, such as the credit limit or past due days
defined for a customer in a customer record, or the unit weight for a product.

If you select Numeric as the data type, indicate the number of places after
the decimal the system allowsin the Decim field. For example, if you are
defining properties for unit weight for a product, you might determine that a
product can be measured to two decimal places, such as 10.25 |bs.

Y/N Only

The Eclipse data stored is yes or no, such as the flag that indicates whether
the entity address should be used for a contact.

* Only

The Eclipse data stored is an asterisk (*), such as, an attribute where more
than one value can be set. For example, lists where you can indicate more
than one option, such asindicating a bill-to/ship-to customer.

Time

The Eclipse datais atime of day, such asanormal delivery time of 8:00 am
for acustomer or the last updated date for a contact.

Order Qty

The Eclipse data stored is a product quantity on an order, such as total
quantity of an item order, or atotal ship quantity.

6. Inthe Domain Object Data Typefield, the system displays the XML data type that is associated
with the domain object datatype you entered in the Eclipse Data Typefield. Y ou can change the

value, if necessary.

Select one of the following data types:

Date type Description

String The dataistext, such as a contact's first name or last name. String is the
default setting for the Text Eclipse data type.

Boolean The dataisayes or no value, such as aflag that indicates whether the entity
address should be used for a contact. Boolean is the default setting for the
Y/N Eclipse data type.

I nteger The datais a number, such as adate or a quantity. Integer is the default
setting for the Date, Numeric, and Time Eclipse data types.

Real The datais a number value that is counted, such as an order quantity or a
dollar amount. Real isthe default setting for the Order Qty Eclipse data
type.

7. Tonest an XML database schema within an element in the Business Connect XML mapping
utility's tree structure, enter the schemain the Pointer to Database Schema field. Use the M ulti
hot key to insert multiple schemas.

For example, if the bill-to address contains all the same information for an entity address, you
might point the Bill To data definition to the Entity schema. When a transaction is defined that
uses the schema in the Business Connect XML mapping utility, the nested element in the Pointer
to Database Schema field displays as a child element.
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8. If the data definition can have multiple values, continue with the procedure below. If it does not
allow multiple values, press Esc to save the property settings and return to the XML Schema
M aintenance screen.

To define multiple value settingsfor an XML schema trandation:
1. Complete the procedure above.
2. Inthe Can thisposition have Multiple Values field, enter Yes.

3. Inthe XML Table Name field, enter the Eclipse database table where they system stores the
XML data.

For example, if you are defining properties for a contact's credit cards, your Contact XML
database schema might contain two pieces of data: Credit Card Types and Credit Card Numbers.
A contact can use more than one credit card to pay for orders, so the attributes contain more than
one credit card type and credit card number. These values can be stored in atable called Credit
Card Information with values and sub-values.

4. IntheWill this Table Always contain a value field, enter Y esto indicate that the XML table
you indicated in the previous field requires avalue. If the table does not always need to contain a
value, enter No.

5. PressEsc to save your changes and return to the XML Schema Maintenance screen.
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Business Connect XML Mapping Utility Overview

Use the Business Connect XML mapping utility to define how the system trand ates data transmitted
using XML from your trading partners format to a format that Eclipse can understand. Also use the
mapping utility to define how the system trandlates data stored in Eclipse to aformat that your trading
partners systems can understand.

For example, you receive orders from atrading partner in XML. Y ou can map datain a customer order
submit request from atrading partner to corresponding data elements in Eclipse that make up an Eclipse
sales order. Thetrading partner sends datain an XML element called

PurchaseOrder/Customer| dentifiers/CustomerNum. To process the information, map that element to the
OrderSubmit/Order/ShipTo data element in Eclipse.

Documert Recerved From Customer | Reply Docurment Sert to Customer || Mapping Selection Criteria
B CSowrceXML | Mappng D) Target XML
=@ PURCHASEORDER ” =D Order ~
# @ HEADERBLOCK (7) —@ CrderiD
=@ CUSTOMERIDENTIFIERS —g BillTo
1
[+} W PayTo
iy \ —@ FriceBranch
T.—m CONTACTMAME (7) . .
50 o NS Ty
#—@ VENDOR
I —
#-@ SHIPTOADDRESS - _g gf:;iﬂa;‘;m
:]+-:—m CONFIRMTOADDRESS (7) \
Tf—m IN‘-,“OICE;E':.DDRESS (7 - SIWFI o
i—@ COMPANY ADDRESS (7) @ Orderstatus
-f-—@ POMNUM (7) @ ShipDate
@ NOTES (7) — @ RequiredDate

To create an order acknowledgement response to the order request, map the Eclipse data you send to an
XML element the trading partner can understand.

See the following topics to add trading partners and transactions:
¢ Adding and Editing XML Trading Partners
XML Transaction Maps Overview

Mapping XML and Eclipse Data Elements

Valid XML Mappings and Precautions

Creating XML Transaction Maps
e Defining XML Mapping Selection Criteria

See the following topics for additional information about the mapping utility:
e Business Connect XML Mapping Utility Main Window Aspects
e Business Connect XML Mapping Utility Symbols
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Accessing the Business Connect XML Mapping Utility

The Business Connect XML mapping utility is a client application that opens outside the Eclipse Eterm
and Solar Eclipse environment.

To access the Business Connect XML mapping utility:
1. Fromthe Windows Start menu, select Programs > Eclipse > Business Connect XML Mapper.
The Eclipse Login dialog box displays.
In the User Name field, enter the user name you use to log in to Eclipse.
In the Password field, enter the password you use to log in to Eclipse.

Click OK to open the Business Connect XML mapping utility.
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Setting Business Connect XML Mapping Utility Preferences

Set the following preferences in the Business Connect XML mapping utility:
¢ Change the application server to which the mapping utility points.
o Change the default HTTP port to display the online Help system.

To changethe application server settings:
1. Accessthe Business Connect XML mapping utility,
2. Fromthe File menu, select Preferencesto display the Preferences dialog box.

3. IntheApplication Server Addressfield, enter the IP address or domain name and the port
number to the application server that is running the Business Connect XML application.

Note: The port number to the application server is 1099.

4. Click OK to save the setting and return to the main window.

Toset theHTTP port for accessto the online Help:
Note: When you install the Business Connect XML mapping utility, it sets a default

HTTP port. Change this value if you are experiencing port conflicts.
Access the Business Connect XML mapping utility.
From the File menu, select Prefer encesto display the Preferences dial og box.
Inthe HTTP Port field, enter the port number to access the online Help.
Click OK to save the setting and return to the main window.

A w NP
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Adding and Editing XML Trading Partners

Before you can create transaction maps, add the XML trading partners with whom you are doing business
to the Trading Partners Tree in the mapping utility. The Trading Partners Tree is away to organize your
trading partners and their associated transaction maps.

The trading partners display in the tree in the order that you add them. The system validates any trading
partners you enter against the entity recordsin Eclipse. Y ou can only enter customers or vendors that have
arecord defined within Eclipse.

To make any changesto an XML trading partner's profile, access the customer or vendor record within
Eclipse. To edit the name of the trading partner in the Trading Partner Tree within the mapping utility, use
the instructions below.

If atrading partner in the tree does not have any transactions defined, the system del etes the trading
partner from the tree when you exit the mapping utility.

Note: Editing atrading partner name is transaction map specific. That is, you can use the
editing function to move a transaction map to a different trading partner in the
tree. For additional information, see the procedure below.

Toadd an XML trading partner in the mapping utility:
1. Accessthe Business Connect XML mapping utility.
2. Fromthe File menu, select New Trading Partner to display the Trading Partner dialog box.

3. Enter the name of the customer or vendor defined in Eclipse that you want to add as an XML
trading partner.

Y ou can also enter the entity ID or thefirst few letters of the name and click the arrow to search
for the customer or vendor.

4. Click OK to add the trading partner to the Trading Partners Tree on the | eft side of the main
window.

The system validates the trading partner you entered against the existing customer and vendor
records. If amatch is not found, No Entity Found displays.

To edit thename of an XML trading partner in the mapping utility:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

From the Edit menu, select Edit Trading Partner to display the Edit Trading Partner dialog box.
Enter a new trading partner name and click OK.

The system renames the trading partner, and places the selected transaction under the new name
in the Trading Partner Tree, and removes it from the original trading partner name.

Note: The system validates the trading partner you entered against the Eclipse customer
and vendor records. If amatch is not found, No Entity Found displays.
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XML Transaction Maps Overview

Before you can begin using Business Connect XML to do business with your trading partners using

XML, you need to determine what XML standard each trading partner is going to use. All XML standards
have associated document type definition (DTD) filesthat explain the data elementsin the XML
documents they send you. DTD files determine what data elements your trading partners can receive from
youl.

What is an XML Transaction?
An XML transaction can consist of the following components:

¢ Aninbound request (received document), such as an order from a customer that contains the
customer datarequired to enter and ship the order plusthe line items for products on the order.

o An outbound request (reply document), such as an order acknowledgement that lets a customer
know that you successfully received their order request.

A transaction can be an inbound-only transaction (such as an invoice you receive from avendor) with no
outbound reply document, or an outbound-only transaction (such as an invoice you send to your
customer) with no inbound received document.

What is a Transaction Map?

A transaction map creates an XQuery, which the system usesto trand ate data from an XML document to
aformat Eclipse can understand, or to trandate Eclipse datato XML. A valid transaction map includes a
received document, sent document, or both, and mapping selection criteria.

The elements defined in the DTD files from your trading partners might contain elements that are not
named the same as Eclipse elements. Therefore, when you receive XML data from atrading partner or
send data from Eclipse to atrading partner the system needs to know which elements to associate with
elementsin Eclipse. A transaction map associates the elements from atrading partner's XML document to
the elementsin Eclipse.

For example, your trading partner sends the purchase order number information in an order request in an
element called PONum. Eclipse stores PO number or order number address information in the
CustomerPONumber element in the database. Therefore, you need to associate the element from the DTD
file to the corresponding element in Eclipse. Using the Business Connect XML mapping utility, you can
make that association by drawing aline between the two elements, as shown in the following illustration:
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Define atransaction map for each transaction type for each trading partner with which you do business
using XML. For instructions to create a compl ete transaction map, see Creating XML Transaction Maps.

What if the Data Sent and Received is in Different Formats?

At times, your trading partners might define datain a different format than how Eclipse can store it. For
example, you have atrading partner that defines dates in the mm/dd/yy format, where Eclipse stores dates
in the mm/dd/yyyy format. Or, you have a trading partner that defines the unit of measure of each as
"each" where Eclipse stores the same unit of measure as "ea."

To process XML transactions successfully, you might need to manipulate incoming or outgoing datato
match the intended format. The system translates the data to the new format before saving it or sending it.
Y ou can modify each element in the Target XML column of atransaction for both the received
document map and the sent document map using operations such as concatenation, adding, subtracting,
and defining table-based conversions. For additional information about how to manipulate the XML data
for trandation, see Modifying Incoming and Outgoing XML Data.

How Does the System Know to Use the Map | Defined?

Y ou might have trading relationships with many customers and vendors, therefore receiving and sending
multiple XML documents to and from different trading partnersin one day. As the system receives and
sends XML transactions, it scansthe XML documents for an element or a value that you define per
transaction for each trading partner. This element or value tells the system which trading partner is
sending or receiving the XML document and which transaction map to use to translate the XML.

For example, trading partner ABC Company sends you order requests with the following data elements
within the XML:

HeaderBlock

From

To
Customerldentifiers

CompanyName
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CustomerNum
Email
ItemList

If ABC Company isthe only trading partner you have that sends you an XML document with the
CustomerNum element, you can tag that ement in the transaction map as the indicator. When the system
receives the XML, it scans the content of the request and knowsiit is from ABC Company when it reaches
the CustomerNum element and aso knows to use the map you have defined for an order request
transaction from ABC Company. However, if ABC Company sends you multiple XML documents that
contain the CustomerNum element, defining the e ement itself does not provide the system enough
information to distinguish the map. In this case, or if you have another trading partner that uses the same
element, define a value sent in the element as the map indicator.

For each transaction map that you create, define an element tag as the indicator or a value as the indicator.
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Mapping XML and Eclipse Data Elements

The Business Connect XML mapping utility provides away to connect source and target elements using
drag and drop functionality. The mapping utility represents each connection using aline that you draw
from the Source XML column to the Target XML column. Each connection is also represented in the
preview pane of the mapping utility main window. For more information about the mapping utility, see
Business Connect XML Mapping Utility Overview. For more information about transaction maps, see
XML Transaction Maps Overview.

Bold elementsin atrading partner's DTD indicate elements that are required for the transaction.
See the following instructions to map elements:
e Map source and target elements (one-to-one, one-to-many, and many-to-one relationships).
o Map repeating groups to non-repeating groups (many-to-one relationships).
¢ Delete element mappings.

To map source and target elements (one-to-one, one-to-many, and many-to-one relationships):
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

Note: Expand the elements as necessary to access nested elements.

In the Source XML column, select the element you want to connect to a target element.

Click and drag the selected source el ement to the element in the Target XML column to which
you want to connect the source element.

The system draws aline from the source element through the M apping column to the target
element and highlights the el ements mapped together.

Note: You can also view the map in column format using the Mapping Preview pane.

To map repeating groups (many-to-one relationships):
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Note: Expand the elements as necessary to access nested elements.

3. Inthe Source XML column, select the repeating element you want to connect to a target el ement.
Note: Repeating groups are identified in aDTD file with aplus (+) after the element.

4. Click and drag the selected source element to the element in the Target XML column to which
you want to connect the source element.

The Repeating Group Selection diaog box displays with the source e ement listed in the Group
Namefield.
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5. Inthe Occurrencefield, indicate the occurrence number that you want to map to the target
element.

For example, atrading partner sends you contact tel ephone numbersin an element called
ContactNumber nested in an element called Contact. The ContactNumber is a repeating group
that can occur one or multiple times:

o Thefirst timeit occurs, the telephone number it contains is the contact's business phone
number.

e The second time it occurs, the telephone number it contains is the contact's mobile phone
number.

e Thethird timeit occurs, the telephone number it contains is the contact's home phone number.

Y ou want to map the contact's business phone number to atarget data element. In this example,
enter 1 in the Occurrence field to indicate that you want to map the first occurrence of the
repeating group to capture the business telephone number.

6. Click OK to save the information and return to the mapping utility main window.

To delete element mappings:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

Note: Expand the elements as necessary to access nested elements.

3. IntheTarget XML column, right-click the e ement whose connection you want to remove and
select Remove M apping.

The system removes the connection between the source element and the target element.
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Valid XML Mappings and Precautions

When creating maps between XML e ements and Eclipse database elements, every line you draw
represents a movement of datafrom an XML document to Eclipse, or from Eclipse to an XML document
being sent to your customers or vendors' systems.

Y ou can create maps from almost any source element to almost any target element. Be sure to make the
connectionsin alogica manner. For example, do not map elements to the Bill To element in Eclipse. Any
data you map to the BillTo element overwrites the Bill To information you have stored in the customer
record for the trading partner. Instead, map a customer number or ID to the ShipTo element. The system
verifiesthat the incoming number or ID isvalid and matches a customer ID or e-commerce ID in the
system and then populates the Bill To information from the customer record.

Note: If an XML element in the document type definition (DTD) file for areceived or
sent document has nested elements, the mapping utility might not allow you to
draw a connection from or to the parent element. Expand the element to map the
nested children, if necessary.

The symbols that display for aDTD filein the mapping utility indicate what types of data can be
transmitted in the corresponding XML document. For example, items on an order request might be
indicated with a plus sign (+) in the mapping utility, indicating that they are arepeating group. The
repeating group symbol means that the element can occur multiple times within the XML document.

Mapping Fields with Modified Data

Asyou create your transaction maps, note that any field that you map and add data modifications to must
be contained in the XML document you send or receive. Thefield in the XML document can be blank;
however, if the tag does not exist in the XML document for a mapped field, the system gives you an error.

Mapping Repeating Groups

In creating your transaction maps, take into consideration how repeating groups are stored in Eclipse. For
example, the data element called Item in a customer's DTD file likely contains additional nested elements
such as ItemNum and Description. Y ou can logically map these e ements to the ProductID and

ProductK eywords database elements in Eclipse, thus, creating alogical map where the system can store
the information from the repeating group.

Y ou can map the following:
¢ A single element from the source to a single e ement in the target (one-to-one mapping).
¢ A single element from the source to multiple el ements in the target (one-to-many mapping).

o Multiple elements from the source to asingle field in the target (many-to-one mapping). The
system concatenates each e ement from the source into the target element.

Note: A valid transaction map includes an inbound request, an outbound request, or both,
and mapping selection criteria. Inbound and outbound documents can be one
directional, that is, inbound only or outbound only.
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Required XML Transaction Data

When creating maps between XML e ements and Eclipse database elements, some transaction types have
data that is required to send the transaction through the system.

¢ Required datafor customer transactions.

¢ Required data for vendor transactions.

Required Data for Customer Transactions

Thefollowing datais required for transactions you send to or receive from your customers:

Transaction Type

Required Data M apped to Eclipse

Order Submit
Request for Quote

e ShipTo - Can be either the Eclipse ID or the customer e-
commerce ID.

¢ Productldentifier - Can be the UPC, product keywords, product
ID, or the customer part number.

e TotalQty - Defaults to one each for each product if you do not
map data to this element, or if this element is mapped but the
XML document contains no data.

Product Inquiry

¢ Productldentifier - Can be the UPC, product keywords, product
ID, or customer part number.

Order Inquiry

e OrderID.

Change Order Request

e ChangeType - Free form text is alowed.
e Order|D or CustomerPONumber.
¢ Any elementsthat identify the changes to the order.
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Required Data for Vendor Transactions
Thefollowing datais required for transactions you send to or receive from your vendors:

Transaction Type Required Data M apped to Eclipse

Order Acknowledgement e OrderID.

Advance Ship Notice e PayTo or ShipFrom.

Invoice e Productldentifier - Can be the UPC code, product 1D, customer

part number, or vendor catalog number.
e TotalQty - Thetotal quantity on the order.

When creating a transaction map for an order acknowledgement
that you receive from your vendor, map the full ordered quantity
from the vendor's DTD to TotalQty in Eclipse. If the full order
quantity is not filled in and not correct, the system cannot match
the acknowledgement to an order in your system.

When creating a transaction map for an invoice that you receive
from your vendor, map the number being shipped from the
vendor's DTD to TotalQty in Eclipse.

Note: TotalQty and InStockShipQty are located under OrderDetail
in the Vendor Order Acknowledgement transaction type.

¢ [nStockShipQty - Quantity available for shipment.

When creating a transaction map for ab order acknowledgements
that you receive from your vendor, map the total number of items
being acknowledged from the vendor's DTD to the
InStockShipQty in Eclipse. If the full order quantity is not filled in
and not correct, the system cannot match the acknowledgement to
an order in your system.

Note: TotalQty and InStockShipQty are located under OrderDetail
in the Vendor Order Acknowledgement transaction type.

Direct Order Submit e ShipTo - Located under the CustomerSalesOrder|D element in a
vendor direct order submit transaction. The
CustomerSalesOrder| D element references the header information
specific to the customer receiving the items on the direct order.

e BillTo- Located under the CustomerSalesOrderID element in a
vendor direct order submit transaction. The
CustomerSalesOrder| D element references the header information
specific to the customer receiving the items on the direct order.
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Creating XML Transaction Maps

Use the Business Connect XML mapping utility to create a relationship between the document type
definition (DTD) files you receive from your trading partners and Eclipse data. Define the relationship by
creating a transaction map.

Creating an XML transaction map requires completing the following tasks:
o Defining transaction types and selecting DTD files
o Mapping the received XML
e Mapping the sent or reply XML
o Defining mapping selection criteria

To better understand the layout of the mapping utility, see Business Connect XML Mapping Utility Main
Window Aspects.

Note: If you need to modify the XML data, modify the mapping characteristics after
creating the XML transaction map.

Defining Transaction Types and Selecting DTD Files

Create transaction maps for each transaction you want to trade with each trading partner. Before you can
create a transaction map, you must work with your trading partner to obtain DTD files and document
specifications. DTD files define the data that is contained within each document you trade using XML.
For more information, see Getting Started with Business Connect XML .

A transaction can be areceived-only transaction with no reply document, or a sent-to only transaction
with no received document.

To definethetransaction type and select the DTD files:

1. Accessthe Business Connect XML mapping utility and select the trading partner for which you
want to define atransaction.

2. Right-click the trading partner and select New Transaction Map to display the New Transaction
Map dialog box.

3. Inthe Transaction Name field, enter the name of the transaction, such as Purchase Order. The
name you enter here displays in the Trading Partners Tree under the trading partner.

4. Inthe Transaction Sourcefield, enter the portal or marketplace the trading partner uses for the
transaction. Entering a transaction source allows you to sort by the source in the remote review
gueues within Eclipse.
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5. Based on the trading partner for which you are creating the transaction map, the New Transaction
Map dialog box displays fields specific to customers or vendors. Enter the transaction type and
DTD information in the fields for a customer or vendor transaction.

Vendor Transaction
Type

Description

Document sent to the
vendor and areply
document received from
the vendor

(outbound with an
inbound response)

1. IntheTransaction Typefield in the Document Sent to Vendor
area of the New Transaction Map dialog box, select the transaction
type of the document you receive from your vendor.

For example, if you are creating a map for a purchase order
transaction, select Order Submit asthe typein the Transaction
Typefield. Your selection populates the Source XML column in the
mapping utility's main window for the sent document map and
determines which elementsin Eclipse are available. For additional
information about how your selections display in the main window,
see Understanding the Business Connect XML Mapping Utility.

The options available in the Transaction Typefield are defined in
XML database schemas.

2. IntheVendor'sDTD field in the Document Sent to Vendor area,
enter the path to the DTD file your trading partner provided you for
this transaction type. The DTD you enter here populates the Tar get
XML column in the mapping utility's main window for the sent
document map. Click Browse to select the field.

3. Inthe Transaction Type field in the Reply Document Received
from Vendor area, select the transaction type of the reply document
your vendor sends to you.

For example, if you are creating a map for a purchase order
transaction, select Order SubmitResponse as the type in the
Transaction Type field. Y our selection populates the Target XM L
column in the mapping utility's main window for the received
document map and determines which elementsin Eclipse are
available. For additional information about how your selections
display in the main window, see Understanding the Business
Connect XML Mapping Utility.

The options availablein the Transaction Typefield are defined in
XML database schemas.

4. IntheVendor'sDTD field in the ReplyDocument Received from
Vendor area, enter the path to the DTD file your trading partner
provided you for this transaction type. The DTD you enter here
populates the Source XML column in the mapping utility's main
window for the received document map. Click Browse to select the
file.
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vendor, but no reply
document received from
the vendor

(outbound only)

Vendor Transaction Description
Type
Document sent to the 5. Inthe Transaction Type field in the Document Sent to Vendor

area of the New Transaction Map dialog box, select the transaction
type of the document you receive from your vendor.

For example, if you are creating a map for a purchase order
transaction, select Order Submit asthe typein the Transaction
Typefield. Your selection populates the Source XML column in the
mapping utility's main window for the sent document map and
determines which elementsin Eclipse are available. For additional
information about how your selections display in the main window,
see Understanding the Business Connect XML Mapping Utility.

The options available in the Transaction Typefield are defined in
XML database schemas.

6. IntheVendor'sDTD field in the Document Sent to Vendor area,
enter the path to the DTD file your trading partner provided you for
this transaction type. The DTD you enter here populates the Tar get
XML column in the mapping utility's main window for the sent
document map. Click Browse to select the file.

7. Inthe Reply Document Received from Vendor area, select the No

Reply Will Be Received check box to indicate that the vendor does
not send areply to your request.

When your vendor's system receives your XML document, it sends
an immediate HTTP Status 200 message back to your system. The
Status 200 message indicates that the system received your request.

The Document Received From Vendor tab is disabled for the
transaction map.
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Vendor Transaction Description
Type
Document received from 8. Inthe Document Sent to Vendor area of the New Transaction Map

the vendor, but no
document sent to the
vendor

(inbound only)

10.

dialog box, select the No Document Will Be Sent check box to
indicate that you are not sending an XML document to your vendor.

The Reply Document Sent To Vendor tab is disabled for the
transaction map.

Inthe Transaction Type field in the Document Received from
Vendor area, select the transaction type of the document your
vendor sendsto you.

For example, if you are creating a map for an invoice transaction,
select Invoice asthe type in the Transaction Typefield. Y our
selection populates the Target XM L column in the mapping utility's
main window for the received document map and determines which
elementsin Eclipse are available. For additional information about
how your selections display in the main window, see Understanding
the Business Connect XML Mapping Utility.

The options available in the Transaction Typefield are defined in
XML database schemas.

Inthe Vendor'sDTD field in the Document Received from
Vendor area, enter the path to the DTD file your trading partner
provided you for this transaction type. The DTD you enter here
populates the Source XML column in the mapping utility's main
window for the received document map. Click Browse to select the
file.
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Customer
Transaction Type

| nstructions

Document received from
the customer and areply
document sent to the
customer

(inbound with an
outbound response)

1. Inthe Transaction Type field in the Document Received from
Customer area of the New Transaction Map dialog box, select the
transaction type of the document you receive from your customer.

For example, if you are creating a map for a purchase order
transaction, select Order Submit as the type in the Transaction
Typefield. Y our selection populates the Target XML column in the
mapping utility's main window for the received document map and
determines which elementsin Eclipse are available. For additional
information about how your selections display in the main window,
see Understanding the Business Connect XML Mapping Utility.

The options available in the Transaction Type field are defined in
XML database schemas.

2. Inthe Customer's DTD field in the Document Received from
Customer area of the New Transaction Map dialog box, enter the
path to the DTD file your trading partner provided you for this
transaction type. The DTD you enter here populates the Sour ce
XML column in the mapping utility's main window for the received
document map. Click Browse to select the file.

3. Inthe Transaction Type field in the Reply Document Sent to
Customer area, select the transaction type of the reply document
you send to your customer.

For example, if you are creating a map for a purchase order
transaction, select Order Submit Response as the typein the
Transaction Type field. Y our selection populates the Sour ce XM L
column in the mapping utility's main window for the sent document
map and determines which elementsin Eclipse are available. For
additional information about how your selections display in the main
window, see Understanding the Business Connect XML Mapping
Utility.

The options available in the Transaction Typefield are defined in
the XML transaction schemas.

4. Inthe ReplyDocument Sent to Customer areaenter the path to the
DTD file your trading partner provided you for this transaction type.
The DTD you enter here populates the Target XML column in the
mapping utility's main window for the sent document map. Click
Browse to select thefile.
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Customer Instructions
Transaction Type
Document received from 5. Inthe Transaction Type field in the Document Received from

the customer, but no
reply document sent to
the customer

(inbound only)

Customer area of the New Transaction Map dialog box, select the
transaction type of the document you receive from your customer.

Y our selection populates the Target XML column in the mapping
utility's main window for the received document map and determines
which elementsin Eclipse are available. For additional information
about how your selections display in the main window, see
Understanding the Business Connect XML Mapping Utility.

The options availablein the Transaction Typefield are defined in
XML database schemas.

In the Customer's DTD field in the Document Received from
Customer area, enter the path to the DTD file your trading partner
provided you for this transaction type. The DTD you enter here
populates the Source XM L column in the mapping utility's main
window for the received document map. Click Browse to select the
file.

In the Reply Document Sent to Customer area, select the No
Reply Will Be Sent check box to indicate the transaction type does
not require a response.

When your system receives the XML document from your customer,
it sends an immediate HT TP Status 200 message back to the system
that sent the document. The Status 200 message indicates that your
system received the request

The Reply Document Sent To Customer tab is disabled for the
transaction map.
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Customer Instructions

Transaction Type

No document received 8. Inthe Document Received from Customer area of the New
from the customer, but a Transaction Map dialog box, select the No Document Will Be
document is sent to the Received check box to indicate the transaction does not have an
customer inbound transaction type, such as sending an invoice to your
(outbound only) customer.

The Document Received From Customer tab is disabled for the
transaction map.

9. Inthe Transaction Type field in the Document Sent to Customer
area, select the transaction type for the document you send to your
customer.

For example, if you are creating a map to send an invoice to your
customer, select Invoice as the typein the Transaction Type field.
Y our selection populates the Source XML column in the mapping
utility's main window for the sent document map and determines
which elementsin Eclipse are available. For additional information
about how your selections display in the main window, see
Understanding the Business Connect XML Mapping Utility.

The options available in the Transaction Typefield are defined in
XML database schemas.

10. Inthe Customer'sDTD field in the Document Sent to Customer
area, enter the path to the DTD file your trading partner provided
you for this transaction type. The DTD you enter here populates the
Target XML column in the mapping utility's main window for the
sent document map. Click Browse to select thefile.

7. Click OK to add the transaction under the trading partner in the Trading Partner Tree.

8. If the transaction has areceived document, continue with Mapping the Received XML. If the
transaction does not have areceived document, continue with Mapping the Reply/Sent XML.

Mapping the Received XML

If the transaction you are mapping contains a received document, map the received DTD elements from
your trading partner to the Eclipse database el ements available for the transaction type. If the transaction
you are mapping does not contain areceived transaction type, the Document Received From
Customer/Vendor tab of the mapping utility is disabled.

Note: The tab name changes based on whether you are creating a customer or vendor
transaction map.

Tomap therequest XML:

1. If thetransaction you want to map is not open, right-click the transaction in the Trading Partners
Tree and select Edit Transaction Map.

2. Select the Document Received From Customer/Vendor tab to display the DTD for the source
XML and the elementsin Eclipse to which you can map the data.
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3. Map elements from the Source XML column to elementsin the Target XML column. For

additional information about how to map and guidelines for creating valid mapping connections,
see Mapping XML and Eclipse Data Elements.

Modify the mapping characteristics, as necessary.

If the transaction has an outgoing transaction type, continue with Mapping the Reply/Sent XML.
If the transaction is a received-only transaction type, continue with Defining XML Mapping
Selection Criteria

Mapping the Reply/Sent XML

If the transaction you are mapping contains a document you are sending to a customer or vendor, map
Eclipse elements available for the transaction type to the elements in the response DTD from your trading
partner. If the transaction you are mapping does not contain areply/sent transaction type, the Document
Sent to Customer/Vendor tab of the mapping utility is disabled.

Note: The tab name changes based on whether you are creating a customer or vendor
transaction map.

Tomap thereply/sent XML:

1

72

If the transaction you want to map is not open, right-click the transaction in the Trading Partners
Tree and select Edit Transaction Map.

Select the Document Sent To Customer/Vendor tab to display the DTD for the reply/sent XML
and the data elements in Eclipse from which you map the outgoing data.

Map Eclipse database elementsin the Source XML column to the data elementsin the response
DTD inthe Target XML column. For additional information about how to map and guidelines
for creating valid mapping connections, see Mapping XML and Eclipse Data Elements.

Modify the mapping characteristics, as necessary.
Define the XML mapping selection criteria

From the File menu, select Save Transaction M ap to save the map.
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Adding and Editing Source Distinctions in XML Transaction
Maps

When you create your transaction maps, you can associate each map to a source, such as a portal or
marketplace, or to a general specification, such as xCBL or cXML. Y ou might have more than one
trading partner that trades through a portal or marketplace or more than one trading partner that uses the
same XML specifications. Assign atransaction source and use that sourceto filter what displaysin
Remote Archive Maintenance. For example, if you have three trading partners that are using a source,
such asiProcure, you can filter the remote archive to display only transactions that are sent through that

source, and the system displays transactions from al three trading partners that were sent through the
same source.

To add a sourcedistinction to an XML transaction map:

1. Accessthe Business Connect XML mapping utility and select the trading partner for which you
want to define atransaction.

Create a new transaction map.

In the Transaction Sour ce field, click the down arrow to select the portal or marketplace used
for the transaction.

The Selection dialog box displays.
4. Do one of the following:

o Select an existing source name — Select aname in the list to add it to the Transaction Source
field in the New Transaction Map dia og box.

e Create a new source name — Click Create New and enter the new source name. Click OK to
add it to the Transaction Sour ce field in the New Transaction Map dialog box. The name is
also added to the sdlection list for future transactions.

5. Continue creating the transaction map.

To edit a transaction sour ce:
1. Accessthe Business Connect XML mapping utility.

2. Right-click the transaction in the Trading Partner Tree that you want to rename and select Edit
Transaction Map to display the transaction map.

From the Edit menu, select Edit Transaction Sour ce to display the Mapping Source dialog box.
Enter or select a new source and click OK.
The system updates the transaction source for the transaction map.
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Defining XML Mapping Selection Criteria

Y ou might have trading relationships with many customers and vendors, therefore receiving and sending
multiple XML documents to and from different trading partnersin one day. As the system receives and
sends XML transaction requests, it scans the XML for an element or a value that you define per
transaction for each trading partner. This element or value tells the system which trading partner is
sending or receiving the XML document and which transaction map to use to trandate the XML.

Note: Y ou must define the mapping selection criteria before you can save a transaction
map.
For each transaction map for each trading partner, define one of the following:
o Element tag as the selection indicator.
e Vaue asthe selection indicator.

Note: For apurchase order that you send to your vendor, use only the PayTo and
ShipFrom elements as selection criteria.

To define an element tag asthe selection indicator:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. Sedlect the Mapping Selection Criteria tab to display the available e ements to define as map
indicators.

If the transaction map is areceived transaction type, the content of the DTD for the received
document displaysin thistab. If the transaction map is a sent-only transaction type, the content of
the DTD for the sent document displays.

4. Right-click the element to use astheindicator and select Set Selection Criteria to display the
Selection Criteria dialog box.

5. Select the This Tag Exists option to indicate that the system should look only for thistag, not a
value associated with this tag.

6. Click OK to save the setting and return to the Mapping Selection Criteriatab.
The option you selected displays with ared highlight.

7. Fromthe File menu, select Save Transaction M ap to save the map settings.
Note: To change the indicator, repeat steps 3 through 6.

To defineavalue asthe selection indicator:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

3. Select the Mapping Selection Criteria tab to display the available e ements to define as map
indicators.
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If the transaction map is areceived transaction type, the content of the DTD for the received
document displaysin thistab. If the transaction map is a sent-only transaction type, the content of
the DTD for the sent document displays.

4. Right-click the element to use asthe indicator and select Set Selection Criteria to display the
Selection Criteriadialog box.

5. Selectthe This Tag Exists With Values option to indicate that the system should look for values
defined within the element.

6. IntheValuefield, enter the value the system uses to identify this trading partner and press Enter
to add the value to the list.

7. Repeat steps 5 and 6 to add additional values, as necessary.
Note: To delete avalue from thelist, select the value and click the X button.

8. Click OK to save the setting and return to the Mapping Selection Criteria tab.
The option you selected displays with ared highlight.

9. From the File menu, select Save Transaction M ap to save the map settings.
Note: To change the indicator, repeat steps 3 through 8.
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Duplicating XML Elements for Repeating Groups

A document type definition (DTD) file indicates that an element repeats by using aplus sign (+) or an
asterisk (*) after the element name. The symbols display in the Business Connect XML mapping utility as
well. Some XML specifications place significance on datain repeating groups, and you need to map each
piece of data sent in the repeating group.

Because arepeating group isindicated in the DTD only once, it can be difficult to map data from each
repetition of the element. Use the mapping utility to duplicate the el ement within a repeating group to
make mapping the repeating information clearer.

For example, your trading partner sends you an XML document that contains a repeating element called
Partner. Your XML specifications indicate that the Partner element occurs three timesin the XML
document they send. Each repetition of the Partner element defines different required data, as shownin
the following example:

<Partner>

<PartnerType> Includes Bill-to data
<Partner|D>

<Partner>
<PartherType> Includes Ship-to data
<Partner|D>

<Partner>
<PartnerType> Includes Buyer data
<Partner|D>

When you create the transaction map for the repeating group, the Partner and its children occur only once
inthe DTD, but you need to map and save all three pieces of data. Duplicate the element in the mapping
utility so you have three instances from which to map.

To pull only one piece of datafrom a repeating group, use alogical expression to modify the XML data.

Toduplicate XML elementsfor repeating groups:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Click the tab to display the map in which you want to duplicate an element.

In the source or target DTD, depending on the map you have displayed, select the element to
duplicate.

5. Right-click the element and select Duplicate this Node.

The system duplicates the entire element. Y ou can aso duplicate children within a node. Each
duplicated element displays with agray highlight.
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6. Map the element as needed.

If your XML specification indicates that each instance of arepeating group is required, map all
instances of the repeating groups.

7. Fromthe File menu, select Save Transaction M ap to save the map.
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Searching for XML Elements in Transaction Maps

Y ou can have lengthy document definition files (DTD) files or the list of elementsin Eclipse can be
lengthy. Y ou can search for text in either the Source XML column or the Target XML columnina
transaction map. Y ou can also search for elementsin the Mapping Selection Criteriatab.

Tosearch for XML elementsin transaction maps.

1
2.

78

Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

From the Options menu, select Find.
Note: If you want to search the contents of M apping Selection Criteria tab, select that
tab and then select Find from the Options menu. Continue with step 5.
Click the button corresponding to the column you want to search, Source or Tar get, to display
the Tree Node Search dialog box.
In the Sear ch Text field, enter the text you want to find.
In the Deepest Tree Level fied, enter the number of levels deep you want to search.

For example, you might have aDTD file from atrading partner that has a data e ement structured
asfollows:

ItemList
Item
ItemNum
Attachments
Attachment
URL

The <URL> dlement is six levels deep. If you enter 3 in the Deepest Tree Level field and search
for URL, the search will not locate the element, because it is six levels deep.

Click Search to find the first occurrence of the text in the column you selected. The system
highlights the first occurrence.

Click Search Next to find the next occurrence.
Click Cancd inthe Tree Node Search dialog box to return to the main window.
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Adding HTTP Headers to XML Transaction Maps

Y our trading partners might require that you add security or other information to an XML document in
the form of an HTTP header. Including an HTTP header section in an XML document allows your trading
partner's system to examine the information in the header prior to opening the XML document. An XML
document can include more than one HT TP header section.

When you preview the XML trandation for the transaction map containing an HTTP header, the HTTP
header displays as part of the XML in the response document. When the XML istransformed and sent to
your trading partner, the system extracts the information and adds it to the HTTP headersin the HTTP
transaction.

Note: You can add HTTP header information only to transaction maps for outgoing
XML documents.

Toadd an HTTP header to an XML transaction map:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. Click the Document Sent to Customer/Vendor tab to display the DTD for the reply/sent XML.

Inthe Target XML column, right-click any element and select Add HTTP Header Infoto
display the Add HTTP Header Info dialog box.

The default element name displays.

Update the element name, as needed. We recommend you use the default el ement name.
Click OK to add the HTTP header element to the Target XML column.

Map the element, as needed.

Modify the mapping characteristics, as needed.

© © N o U

From the File menu, select Save Transaction M ap to save the map.

Todeletean HTTP header from an XML transaction map:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Click the Document Sent to Customer/Vendor tab to display the DTD for the reply/sent XML.

Inthe Target XML column, right-click the HTTP header element you want to delete and select
Remove HTTP Header Info.

5. Fromthe File menu, select Save Transaction M ap to save the map.
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Indicating the Document Type in XML Transaction Maps

Y our trading partners might require that you declare the document type in aDOCTY PE element in XML

documents you send. The DOCTY PE declaration contains a URL to the document type definition (DTD)

or schemathat defines the XML document, and tells your trading partner's system which DTD or schema
to use to validate the XML.

Note: You can add a DOCTY PE declaration only to transaction maps for XML
documents you are sending to atrading partner. XML documents that you receive
from your trading partners do not require a DOCTY PE declaration.

Toindicatethe document typein an XML transaction map:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

Click the Document Sent to Customer/Vendor tab to display the reply/sent transaction map.

Inthe Target XML column, right-click any element and select Add DOCTY PE Referenceto
display the Add DOCTY PE Reference dialog box.

5. Inthe System ID Referencefield, complete the URL to the DTD or schemathe XML document
uses.

e http://ly.com - The URL path to the location that containsthe DTD or schema.
e [*.dtd - The DTD file name or schema name. An XML schema'sfile extension is .xsd.

For example, if the XML document uses the basic commerce XML (cXML) DTD, complete the
URL to read http://xml.cxml.or g/schemas/cXM L /<version>/cXML .dtd, where <version> is
the full cXML versions number, such as 1.2.014.

The declaration must be in the correct upper and lower case for the reference to work.
6. Click OK to add the DOCTY PE reference to the transaction map.

Thefirst element in the Target XML column displays with ayellow icon, indicating that the
XML document now contains the DOCTY PE e ement.

7. Fromthe File menu, select Save Transaction M ap to save the map.

To verify the DOCTY PE in the outgoing XML, preview the XML trandation for transaction
map's response XML document. To test the document post the XML to Eclipse. You must save
the transaction prior to posting.

Toremovethe document type declaration from an XML transaction map:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

Click the Document Sent to Customer/Vendor tab to display the reply/sent transaction map.
In the Target XML column, right-click any element and select Remove DOCTY PE Reference.
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The system removes the DOCTY PE element and the yellow icon no longer displays in the first
element in the Target XML column.

5. Fromthe File menu, select Save Transaction M ap to save the map.

© 2011 Epicor Software Corporation. All rights reserved.

81



Solar Eclipse Business Connect XML Rel. 8.7.2

Previewing XML Transaction Maps

Use the preview paneto preview an XML transaction map in aformat different from the main window
view. The preview pane displays the transaction map in column format, lists the source items mapped to
the target items, and indicates if modifications have been assigned to XML data.

To preview an XML transaction map:

1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display

the transaction map.

Click the tab for the map you want to view.

From the Options menu, select Show Preview Pane to display the Mapping Preview pane.

Note: The Preview Pane displays by default when you open the mapping utility.

The preview displays the following information for mapped elementsin the received document or

sent document map:

Column

Description

Target

The elements that display in the Target XM L column of the tab you are

currently viewing:

o For received document maps, displays elementsin Eclipse for the
transaction type.

o For sent document maps, displays elementsin the DTD file for the
reply/sent document from your trading partner.

Sour ce

The elements that display in the Source XML column of the tab you are

currently viewing:

o For received document maps, displays elementsin the DTD file for the
received document from your trading partner.

o For reply/sent maps, displays elementsin Eclipse for the transaction type.

Note: If a source element has several target elements mapped to it, the listing
in the Sour ce column of the Mapping Preview pane displays with aMultiple
symbol. Double-click the symbol to view the target elements mapped to the
source.

Conversion Data

Indicates if modifications have been specified for the element. For additional
information, see Modifying Incoming and Outgoing XML Data Overview.
Click the symbol in the Conversion Data column to display the XML
Mapping Conversion Editor dialog box.

If there is a single operation applied to the element, the type of operation
displays, for example, ConvertDate. If multiple operations are assigned to the
element, Multiple Operations displays.

Note: Right-click aline item in the Mapping Preview pane and select Remove this
M apping to remove an element mapping from the transaction map. Right-click a
lineitem and select M odify this M apping to modify XML data.
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Renaming XML Transaction Maps

Use the rename transaction map function to rename any transaction map.

Torename XML transaction maps:
1. Accessthe Business Connect XML mapping utility.

2. Right-click the transaction in the Trading Partner Tree that you want to rename and select Edit
Transaction Map to display the transaction map.

From the Edit menu, select Edit Transaction Name.
Inthe Enter New Transaction Name field, enter the new name and click OK.

The system updates the transaction name in the Trading Partner Tree and in the tab above the
map.
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Copying XML Transaction Maps

Use the transaction copy function to copy and reuse maps. For example, you might have multiple
transaction types for atrading partner that can share the same transaction map. Or, you might have
transactions that are similar in nature, and require only small changes to the map. Y ou can a so copy
transactions that exist for one trading partner and paste them to a different trading partner.

To copy XML transaction maps:

1. Accessthe Business Connect XML mapping utility.

2. Right-click the transaction in the Trading Partner Tree that you want to copy and select Copy
Transaction Map.

Click OK inthe dialog box to continue.

In the Trading Partner Tree, right-click the trading partner to which to copy the transaction and
select Paste Transaction Map.

Enter the name for the new transaction.

Click OK to copy the transaction and add it to the transaction list under the trading partner in the
Trading Partner Tree.

If you need to make changes to the copied map, right-click the new transaction and select Edit
Transaction Map.
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Deleting XML Transaction Maps

Y ou might have transaction maps that you no longer use. Delete any unused transaction maps, as
necessary. Deleting the last transaction map from a trading partner also removes the trading partner from
the Trading Partner Tree.

Note: If you delete atransaction map for atrading partner with which you are still doing
business, be sure amap exists for any transactions you still receive or send to that
trading partner using XML.

Todelete an XML transaction map:
1. Accessthe Business Connect XML mapping utility.

2. Right-click the transaction map in the Trading Partner Tree that you want to delete and select
Delete Transaction Map.

3. Click Yesto confirm the deletion.
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Modifying Incoming and Outgoing XML Data Overview

Lines drawn from source to target elements in a transaction map represent a movement of data. At times,
your trading partners might define datain aformat different than how Eclipse can store it or the datain
Eclipse might not bein aformat your trading partner can understand. For example, you might have a
trading partner that defines dates using the mm/dd/yy format, where Eclipse stores dates using the
mm/dd/yyyy format; or you might have atrading partner that defines the unit of measure of each as
"each," but Eclipse stores the same unit of measure as"ea’.

To process XML transactions successfully, modify this type of datato match the required format. The
system trand ates the data to the new format before saving it or sending it. Y ou can manipulate each target
element of atransaction for both the received document map and the sent document map using operations
such as concatenation, adding, subtracting, and table-based conversions.

Y ou can aso add sources, such asliteral statements to help identify data. For example, you might store e-
mail addresses and other information in the Internal Notesfield of an order. To better identify data stored
and displayed in thefield, you can concatenate aliteral statement, such as Email: to the incoming data
address.

Using a combination of sources and operations, you can create a stacked operation to modify any XML
data, even if the element does not have source data mapped to it.

Y ou can add the following sources to an expression:

Source Description

Literal Adds atext string to the XML data. For example, you can store e-mail
addresses and other information in the I nter nal Notes field of an order. To
better identify data stored and printed in the field, add literal statementsto
identify the data.

New Line Inserts aline break in the XML data, for better readability.

Y ou can add the following operations to an expression:

Operation Description

Concatenate Links or joins data together. For example, if you are mapping several
pieces of datato the Internal Notesfield of an order, link the data
together to form avalid expression.

Substring Copies one part of a string, and assignsit to a variable or element. For
example, you can extract the first four digits of a credit card number to
identify the bank. If the string of data contains delimiters, you can also use
the extract field operation.

Extract fields Extracts data from a substring of data separated by delimiters into
numbered field names. For example, if you have a string of three values
separated by a comma (the delimiter), and you need to save the middle
value, use the extract field operation to indicate which field within the
delimited string you want to save.

Table-based conversions Converts data from one format to another. For example, your trading
partner might use the unit of measure of "each." Eclipse stores units of
measure as two characters. Using a table-based conversion, you can tell
the system to change the unit of measure "each" to "ed" for incoming data,
and to change "ea" to "each" for outgoing data.

86 © 2011 Epicor Software Corporation. All rights reserved.



Rel.8.7.2

Business Connect XML

Operation

Description

Decimal conversions

Tells the system how many decimal places to use in numeric values. Use
decimal conversionsif your trading partner sends dollar amounts or other
numbersin aformat that does not contain decimals in the actual data.

Date conversions

Converts dates into different formats. For example, your trading partner
sends date information using the mm/dd/yy format, but Eclipse stores
dates using the mm/dd/yyyy format. Define a date conversion operation to
convert the format of the date element.

Mathematical operations

Adds, subtracts, multiplies, divides, or sums amounts within XML data.

Encode or decode Base64

Encodes or decodes Base64 data. Use this type of encoding to preserve
special characters that you might receive or send using XML.

Note: Base64 encoding does not encrypt data.

Extract current date and
time

Extracts the date and time the transaction was received or sent. Use this
operation to extract all or a portion of a date or time stamp.

Inversion

Divides a number into 1, making areciprocal. For example, if you
received the number 42, assigning this operation changes the number to
1/42.

Uppercasing and
lowercasing letters

Uppercases or lowercases lettersin astring of XML data.

XPath selection

Defines an if-then-else operation for XML datathat identifies the element
to use instead of another el ement if the correct conditions exist.

Repeating group
selection

Defines an if-then-else operation for XML data that identifies one specific
piece of datawithin an XML repeating element.

Logical If-Then-Else

Defines a basic if-then-else operation for XML data. For example, use this
logical expression type to define a condition in which you would need to
change data.
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Building Modification Expressions for XML Data

Use the XML Mapping Conversion Editor dialog box to build expressions that alter XML data that you
receive or send.

The XML Mapping Conversion Editor Dialog Box
The XML Mapping Conversion Editor dialog box, shown in the diagram below, consists of the following

areas:

88

Sour ces and Oper ations - Tags used to build an expression.
Operation Stack - Sources and operations in the order they occur that comprise the expression.

Operation Stack Expression Validation - Illustrates the expression built in the operation stack. If
the expression isinvalid, a message displaysin this area.

Up and Down Arrow buttons - Moves the selected source or operation in the operation stack.
Remove button - Removes the selected source or operation from the operation stack.

Properties button - Displays the properties dialog box for the selected operation in the operation
stack, if properties are associated with the operation type.
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Accessing the XML Mapping Conversion Edit Dialog Box
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

Building Expressions

All the avail able sources and operations to build an expression are listed the Sour ces field and the
Operationsfield.

To add sour ces and oper ations to build expressions:

1. Do one of thefollowing to add a source or operation to the operation stack:
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¢ Inthe Sources or Operationsfield, select the item to add. Click and drag it to the operation
stack. Y ou can drag the selected source or operation to anywhere in the stack.

¢ Inthe Sour ces or Operations field, double-click theitem to add. The system placesit at the
bottom of the operation stack.

If the source or operation you added requires additional properties, the associated properties
dialog box displays when you add the source or operation to the operation stack. Enter those
properties and click OK.

For additional information about entering additional properties, see the instructions for each
source and operation type.

Note: If you need to change the properties of a source or operation, right-click theitemin
the operation stack and select Edit Additional Data.

Do one of the following to move the source or operation in the operation stack:

o Select theitem to move and use the Up and Down Arrow buttons.

o Select theitem to move and drag it to the correct location.

¢ Right-click the item you want to move and select M ove Up or M ove Down to move theitem
one place up or down.

After completing the modification expression, click OK to return to the mapping utility main
window.

From the File menu, select Save Transaction M ap to save the map and your modification
EXPressions.

Removing Sources and Operations from Expressions

If you add a source or operation to an expression in error, you can remove the item from the operation

stack.

Toremove a source or operation from an expression:

1
2.
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In the Operation Stack field, select the source or operation to del ete.
Right-click the item and select Remove.

The system removes the item from the operation stack. View the expression validation message at
the bottom of the dialog box to verify the expressionis still valid.
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Adding Literal Statements to XML Data

Use literal statements to add additional text to XML data. For example, you might use the Internal Notes
field or the Shipping I nstructions field of an order to store and print data about a customer or the order
itself. If you store more than one piece of datain thisfield, the data can become hard to read. Use litera
statements to tag each piece of datafor easier identification later.

Toadd literal statementsto XML data:

1
2.

9.

Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Inthe Target XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify M apping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Sour cesfield, double-click Literal to add it to the Operation Stack field.
The Literal Vaue dialog box displays.
Inthe Literal Valuefigld, type the text to insert asthe literal statement.

Click OK to return to the XML Mapping Conversion Editor dialog box. The literal tag now
displaysin the Operation Stack field.

If necessary, move the tag to the correct place in the operation stack.

If you are adding aliterd string to identify data, place that string before the element name in the
operation stack. The placement in the stack determines how the operation functions.

Operation Stack
@ Literal :"E-mail address:"

- ERAAIL

Using the example above, if you are mapping the Email element to the I nternal Notesfield for
an order, the literal statement "Email address:" displays before the datain the Email element.

When adding literal statementsto data, the system does not consider the operation valid until you
concatenate the data being received or sent. Use the concatenate operation to form avalid
expression.

Operation Stack

@ Litetal :"E-tail address:"

@ EtdalL

The above operation displays the e-mail address as Email: user @addr ess.com.
Add additional sources and other operations, as necessary.

10. Click OK to save the expression and return to the mapping utility main window.

11. Fromthe File menu, select Save Transaction M ap to save the map.
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Inserting Lines into XML Data

Use new linesto insert line breaksinto XML data. Inserting line breaks can aid in the readability of a
block of text in afield. For example, you might save multiple pieces of datato the Internal Notes or
Shipping Notesfields of an order about the customer or the order itself. Use line breaks to separate each
piece of data so it appears on the order on its own line.

Toinsert linesinto XML data;

1
2.
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Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Inthe Target XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify M apping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source e ement displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Sour cesfield, double-click New Lineto add it to the Operation Stack field.
If necessary, move the new line tag to the correct place in the operation stack.

For example, if you are adding multiple pieces of datato afield, you can insert aline break
between the dataso it is easier to read. Y ou can add as many new lines as you need.

Operation Stack

@ Literal :"E-mail addrezs:"

@ EndaL

“'fi Concat

When adding new lines after data, the system does not consider the expression valid until you
concatenate the new line to the data. Use the concatenate operation to form avalid expression.

Operation Stack

@ Literal :"E-mail address:"

@& EnaL

ﬁ,ﬁ Concat

" ey Line

ﬁ,ﬁ Concat

@ Literal :"Terms:"

ﬁ,ﬁ Concat

@ P AN MEMTCODEMUM
ﬁ,ﬁ Concat

The output of the above expression is as follows:
Email address: user @addr ess.com

Terms:. Payment Code

Add additional sources and operations, as necessary.
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8. Click OK to return to the mapping utility main window.

9. Fromthe File menu, select Save Transaction M ap to save the map.
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Concatenating XML Data

Use the concatenate operation to link or join data together. For example, atrading partner might send you
addressinformation in severa different elements. Y ou might decide to map separate elements that contain
the street number, city, state, and zip code information to the ship-to address of any order. Y ou can
concatenate the data so it al lives on oneline. You can also insert new lines so the datais easier to read.

To concatenate XML data:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

3. Inthe Target XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify M apping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click Concat to add it to the Operation Stack field.
If necessary, move the operation to the correct place in the operation stack.

Place the concatenation operation line after the data, operations, or sources to join together.
Operation Stack

@ Literal :"E-tnail address:"

@ EtdalL

ﬁ,ﬁ Concat

e ey Line

“% Concat

@ Literal :"Terms:"

ﬁ,ﬁ Concat

@ PANMEMTCCODERNUM
ﬁ,ﬁ Concat

In the example above, the information joins together as follows:
Email address. user @addr ess.com.

Terms: Payment Code

Add additional operations or sources, as necessary.

Click OK to return to the mapping utility main window.

From the File menu, select Save Transaction M ap to save the map.

94 © 2011 Epicor Software Corporation. All rights reserved.



Rel. 8.7.2 Business Connect XML

Copying Substrings of XML Data

Use the substring operation to copy part of astring from areceived XML document and assign it to a
variable or an element in Eclipse, or to an XML element for a sent document. For example, you can copy
the first four digits of acredit card number to identify the bank associated with the card. Using the
substring operation, you can specify how many characters and the starting character position to copy. For
example, if you know that a string always contains 16 characters, and to extract the fourth, fifth, and sixth
characters, use the substring operation to indicate the fourth character as the starting character and that
you want to copy three characters.

If you receive datain a string that is not always a consistent length, use the extract field operation to
indicate the delimiter and the field within the string to copy.

To copy asubstring of XML data:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack field. If the element is not mapped, the Operation Stack field is blank.

4. From the Operationsfield, double-click Substring to add it to the Operation Stack field.
The Sub-String Parameters dia og box displays.
In the Start I ndex field, enter the first character position of the string you want to copy.
In the Number of Charactersfield, enter the number of charactersto copy.

For example, if you want to copy data from charactersin the fourth, fifth, and sixth positions,
enter 4in the Star Index field and 3 in the Number Of Bytesfield.

Click OK to return to the XML Mapping Conversion Editor dialog box.
8. If necessary, move the operation to the correct location in the operation stack.

The substring operation line falls after the data that contains the substring from which you want to
copy data:

Operation Stack

@ CREDITCARDNUM
E substring(4 5)

9. Add additional sources and operations, as necessary.
10. Click OK to return to the mapping utility main window.

11. Fromthe File menu, select Save Transaction M ap to save the map.
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Extracting Fields from Delimited XML Strings

Use the extract field operation to extract and copy part of adelimited string and assign it to an element in
the database, or to an XML element for a document you are sending. For example, your trading partner
sends you a string of datain an XML element that contains three fields separated by delimiters. The
second field within that string might be a necessary piece of data to complete a transaction, such as a ship-
to ID for an order. Using the extract field operation, you can map the element and tell the system to save
only the second field in that string.

Use the extract field operation to save pieces of datafrom a string that might not always be the same
number of characterslong. Use the substring operation to extract data from a string that is consistently the
same length by indicating which character positions to extract.

To extract fieldsfrom delimited XML strings:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack field. If the element is not mapped, the Operation Stack field is blank.

4. Fromthe Operationsfield, double-click ExtractField to add it to the Operation Stack field.
The Field Extraction diaog box displays.

5. IntheField Delimiter field, enter the character that is the delimiter in the string, for example, a
commaor apipe (, or |).

6. Inthe Occurrencefield, enter the field to extract.

For example, you receive a delimited string that reads 123[4567|89 the string contains three fields,
each separated by the | symbol. To copy the valuesin the second field, enter 2 in the Occurrence
field.

Click OK to return to the XML Mapping Conversion Editor dialog box.
If necessary, move the operation to the correct place in the operation stack.

Typicaly, the extract field operation falls after the data you want to extract:
Operation Stack

@ CUSTOMERMUM
B EstractField(],2)

9. Add additional sources and operations, as necessary.
10. Click OK to return to the mapping utility main window.
11. Fromthe File menu, select Save Transaction M ap to save the map.
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Performing Table-Based Conversions on XML Data

Use the table conversion operation to change the format of XML datainto a format that the receiving
system can understand. Use table-based conversions for data such as the following:

e Shipvias
e Unitsof measure

For example, your trading partner uses the unit of measure "each." Eclipse stores units of measure as two
characters. Using atable-based conversion, you can tell the system to change the unit of measure "each”
to "ed' for incoming data, and to change "ea" to "each" for outgoing data. For a designated element, you
can define multiple unit of measure conversions in the conversion table.

To perform table-based conversion on XML data:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element you want to modify and select M odify M apping to display the XML Mapping
Conversion Editor diaog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

4. From the Operationsfield, double-click TableConversion to add it to the Operation Stack
field.

The Table Conversion dialog box displays.
In the Convert From field, type the source data that you want to convert.
In the Convert To field, type the format to which you want to convert the source.

For example, if you are converting units of measure from your trading partner, enter a unit of
measure in the format they use, such as"each" or "box," in the Convert From field. In the
Convert Tofield, enter the two-character format of the corresponding unit of measure stored in
Eclipse, such as"ea" and "bx."

Note: The information you enter for table-based conversionsis case sensitive. The
system looks for exactly what you type in the Convert From field. For example,
if you enter "EACH" in the Convert From field, and the datain the XML
document is"each” the system does not convert the data.
7. Repeat steps 5 and 6 to enter additional format conversions for the element.

Note: Ensure that there are no blank lines in the table as you are adding conversions.

Click OK to return to the XML Mapping Conversion Editor dialog box.
If necessary, move the operation to the correct place in the operation stack.

Typically, the table conversion operation line falls after the element that contains the data you
want to convert:
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Operation Stack

& uop

“fﬂ TakleCoryerzion

10. Add additional sources or operations, as necessary.
11. Click OK to return to the mapping utility main window.
12. From the File menu, select Save Transaction M ap to save the map.
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Converting Decimal Formats in XML Data

Some document type definition (DTD) files indicate that quantities or other numbers are sent without
decimal places, and that a decimal place indicator is sent in a different element. For example, atrading
partner's XML document contains a Quantity element that contains adollar quantity, such as 50000. A
nested el ement, NumOfDecimals within the Quantity element indicates that there are two decimal places
in any number sent in the Quantity element. Therefore, the quantity 50000 is actually 500.00.

Use the decimal conversion operation to convert the decimal placesin this circumstance.

Note: Map both the value and the decimal indicator to the same target to convert the
decimal places using the decimal conversion operation.

To convert decimal formatsin XML data;
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
dialog box.

If the element you selected has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

4. From the Operationsfield, double-click DecimalConversion to add it to the Operation Stack
field.

5. If necessary, move the operation to the correct place in the operation stack. Decimal conversions
fall after the element that indicates the decimal conversion value.

Add additiona sources and operations, as necessary.
Click OK to return to the, mapping utility main window.

From the File menu, select Save Transaction M ap to save the map.
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Converting Date Formats in XML Data

Use the date conversion operation to convert calendar dates into different formats. For example, your
trading partners might send date information using the mm/dd/yy format, but Eclipse stores dates using
the mm/dd/yyyy format. Define a date conversion operation to convert the format the format of an
element that contains date information.

To convert dateformatsin XML data;

1
2.
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Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Inthe Target XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify M apping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click DateConversion to add it to the Operation Stack field.
The Define Format Conversions dialog box displays.

In the Incoming Date Format field, enter the source date format. For an outgoing transaction,
thisisthe format from Eclipse. For received transaction, thisisthe format from your trading
partner.

Use the following notations when entering date formats:

Date Element Full Form Short Form
Year yyyy yy

Month MMM MM or M
Day of week EEEE EE

Day of month dd d

Hour (1-12) hh h

Hour (0-23) HH H

Hour (0-11) KK K

Hour (1-24) kk k

Minute mm

Second ss

Millisecond SSS

AM/PM a

Time zone 777z 7z

Day of week in month (for F

example, the third Thursday)

Day in year DDD D
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Date Element Full Form Short Form

Week in year wWw
Era (for example, BC or AD) G

Note: Date format notations are case sensitive. For example, to convert an incoming date
from mm/dd/yy to contain afour digit year, enter MM/dd/yyyy for the outgoing
date format.

6. Inthe Outgoing Date Format field, enter the format to which to save the date in all lowercase
letters.

For a sent transaction, thisis the format that your trading partner requires. For areceived
transaction, thisisthe format Eclipse requires.

7. Click OK to return to the XML Mapping Conversion Editor dialog box.

8. If necessary, move the operation to the correct place in the operation stack.
Typicaly, the date conversion operations fall after the data you need to convert:

Operation Stack

@ ORDERDATE
“% DateConversion(mmfddiy -= mmiddhyyey)

9. Add additional sources and operations, as necessary.
10. Click OK to return the mapping utility main window.
11. Fromthe File menu, select Save Transaction M ap to save the map.
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Performing Mathematical Operations on XML Data

Use the mathematical operations—add, subtract, multiply, divide, and sum— to apply common math
functionsto XML data. For example, if anincoming XML document contains an extended price of $42
for 10 of an item, you can use the divide operation to divide the extended price by the order quantity to
determine the unit price.

Use the Summation function to total quantitiesin a repeating group. For example, if you have the
following XML, you can use the Summation function to total the amounts in each repeating Price
element.

<ltem>

<Price>10.55</Price>
<Price>10.49</Price>
<Price>11.50</Price>

</ltem>

To perform mathematical operationson XML data:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element you want to modify and select M odify M apping to display the XML Mapping
Conversion Editor dialog box.

If the element you selected has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

4. Fromthe Operationsfield, double-click Add, Subtract, Multiply, Divide, or Summation to
add it to the Operation Stack field.

If necessary, move the operation to the correct place in the operation stack.
Click OK to return to the mapping utility main window.
From the File menu, select Save Transaction M ap to save the map.
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Encoding and Decoding XML Data to and from Base64

Use the Base64 operation to encode or decode XML data. For example, your trading partner uses Base64
to encode special characters that you need to preserve. To successfully save that information to Eclipse,
use the Base64 decode operation to trandate the data.

Note: Encoding data using Base64 does not encrypt the data. Use secure HTTP (HTTPS)
for transmitting sensitive information.

To encode data to Base64:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
dialog box.

If the element you selected has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click Base64Encode add it to the Operation Stack field.
If necessary, move the operation to the correct place in the operation stack.

Typically, the Base64 encode operation falls after the data you want to encode:
Operation Stack

@ rosTATUS
ﬁ,ﬁ Baseb4Encode

Add additional sources and operations, as necessary.
Click OK to return to the mapping utility main window.

From the File menu, select Save Transaction M ap to save the map.

To decode data from Base 64:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify M apping to display the XML Mapping Conversion Editor
dialog box.

If the element you selected has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click B64Decode to add it to the Operation Stack field.
If necessary, move the operation to the correct place in the operation stack.
Typicaly, the Base64 decode operation falls after the data you want to decode:
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Operation Stack

@ rosTATUS
% BEdDecode

6. Add additional sources and operations, as necessary.
7. Click OK to return to the mapping utility main window.
8. From the File menu, select Save Transaction M ap to save the map.
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Extracting the Current Date and Time from XML Data

Use the extract current date and time operation to extract and copy the date and time an XML document
was sent or received. Use this operation to extract any of the following for an element that contains
information about the date and time an order was sent or received:

Day, month, or year

Whole date

Hour, minute, or second

Time (including hours, minutes, and seconds)
Time zone

Whole date and time

To extract thecurrent date and timefrom XML data;

1
2.

Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

Inthe Target XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
diaog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click ExtractCurrentDateTime to add it to the Operation
Stack field.

The Current Date Time Extraction dialog box displays.

In the Extract Current field, select the portion of the date/time stamp to extract, such as month,
or hour.

Click OK to return to the XML Mapping Conversion Editor dialog box.
If necessary, move the operation to the correct place in the operation stack.
Typicaly, the extract date and time operation falls after the data you want to extract:

Operation Stack
@ ORDERDATE

I’ ExtractCurrentDateTime DWhale Date)

When extracting a date or time, the system does not consider the expression valid until you
concatenate the data. Use the concatenate operation to form avalid expression.

Operation Stack

@ ORDERDATE
ﬁ; ExtractCurrentDateTime (Whole Date)
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9. Add additional sources and operations, as necessary.
10. Click OK to return to the mapping utility main window.

11. Fromthe File menu, select Save Transaction M ap to save the map.
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Inverting Numbers in XML Data

Use the invert operation to create areciprocal of anumber. For example, if you received the number 42 in
an element, assigning this operation changes the number to 1/42.

Toinvert number in XML data;

1
2.

Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

In the Target XML column of either the received map or the reply/sent map, right-click the
element to modify and select M odify Mapping to display the XML Mapping Conversion Editor
dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click I nvert to add it to the Operation Stack field.
If necessary, move the operation to the correct place in the operation stack.
Typicaly, the invert operation falls after the data you want to invert.

Operation Stack

@ WEIGHT
ﬁ,ﬁ Irvert

Add additiona sources and operations, as necessary.

Click OK to return to the mapping utility main window.
From the File menu, select Save Transaction M ap to save the map.
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Uppercasing and Lowercasing Letters in XML Data

Use the uppercase and lowercase operations to change XML datato all uppercase letters or al lowercase

|etters.

To uppercase or lowercase lettersin XML data:

1
2.

108

Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

In the Target XML column of either the received map or the reply/sent map, right-click the
element you want to modify and select M odify M apping to display the XML Mapping
Conversion Editor dialog box.

If the element you select has a source element mapped to it, the source element displaysin the
Operation Stack fidd. If the element is not mapped, the Operation Stack field is blank.

From the Oper ations field, double-click Upper Case or L ower Case to add it to the Operation
Stack field.

If necessary, move the operation to after the element you want to upper case or lower casein the
operation stack.

Operation Stack
@ PORILIM

I’ UpperCase

Add additional sources and operations, as necessary.
Click OK to return to the mapping utility main window.
From the File menu, select Save Transaction M ap to save the map.
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Defining Logical Expressions for XML Data

Use logical expressionsto create if-then-else statements to modify XML data. A logical expressionis
useful if you need to set conditions to determine which mapped element to use, save a portion of datain a
repeating group, or define abasic expression to save data for an element such asaflag.

Use any of the following logical expressionsto modify XML data:
¢ Repeating group sdlection
e XPath selection

¢ Basicif-then-else expression

Selecting an Element From a Repeating Group

Use thislogical expression type to create an if-then-el se statement to identify one specific piece of datain
arepeating group. For example, your trading partner sends you an XML document that contains a
repeating element called Partner. Each repetition of the Partner element defines a different type of data, as
shown in the following example:

<Partner>

<PartnerType> Includes hill-to data.
<Partner|D>

<Partner>
<PartherType> Includes ship-to data.
<Partner|D>

<Partner>
<PartnerType> Includes buyer data.
<Partner|D>

When you create the transaction map for this repeating group, the Partner element and its children occur
only once in the document type definition (DTD) file from your trading partner. If you need only the ship-
to data from the second occurrence of the repeating group, you can use an if-then-else operation to
identify the data you need to map.

To create an if-then-else statement for a repeating group:

1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map, right-click the
element you want to modify and select M odify M apping to display the XML Mapping
Conversion Editor diaog box.

Note: To definealogical expression, the element you select must be arepeating group
and must have a mapping defined.
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4.

8.
9.

From the Oper ations field, double-click RepeatingGroupSelection to add it to the operation
stack.

The Repeating Group Selection dialog box displays.
Define the logical expression by selecting the operator, such as EQUAL, and defining the value.

To create alogica expression for the example above, select Equal asthe operator and enter Ship
Toasthevalue.

Click OK to return to the XML Mapping Conversion Editor dialog box.
If necessary, move the operation to the correct place in the operation stack.

To create avalid logical expression, the logical operation falls below the item you want to modify
in the operation stack.

Add additional sources and operations, as necessary.
Click OK to return to the mapping utility main window.

10. From the File menu, select Save Transaction M ap to save the map.

XPath Selection

Use thislogical expression type to create an if-then-el se statement to use a mapping from another element
if the conditions you state are met.

1
2.

8.
9.

Access the Business Connect XML mapping utility.

Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

Inthe Target XML column of either the received map or the reply/sent map, right-click the
element you want to modify and select M odify M apping to display the XML Mapping
Conversion Editor diaog box.

From the Oper ations field, double-click XPathSelection to add it to the operation stack.

The XPath Selection dialog box displays.

Build the expression by selecting the data element you want to use and the operator and value.
Click OK to return to the XML Mapping Conversion Editor dialog box.

If necessary, move the operation to the correct place in the operation stack.

To create avalid logical expression, the logical operation falls below the item you want to modify
in the operation stack.

Add additiona sources and operations, as necessary.
Click OK to return to the mapping utility main window.

10. From the File menu, select Save Transaction M ap to save the map.

Basic If-Then-Else Operation

Use thislogical expression type to create a basic if-then-el se statement to modify XML data. For
example, your trading partner might send XML datain an element that is used as aflag, such as Success
or Fail. The flags might not correspond exactly to the data format you use in Eclipse to indicate the same
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flag. Y ou might need to store the Success flag asa 1 value in your system. Use abasic logical expression
to tell the system that if it reads Successin the data element, to store a 1 in the mapped Eclipse element.

To create asimpleif-then-else operation:

1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

3. IntheTarget XML column of either the received map or the reply/sent map’, right-click the
element you want to modify and select M odify M apping to display the XML Mapping
Conversion Editor dialog box.

Note: To definealogical expression, the element must have a mapping defined.

4. Fromthe Operationsfield, double-click Logical I1f-Then-Elseto add it to the operation stack.
The If-Then-Else Logical dialog box displays.

5. Build the expression by entering the following information:

Expression Section Description

If operand value Select the operator and the value for the expression.

Then use this value Enter the value to use if the data meets the criteria stated in the If
statement.

Otherwise use this value Enter the value to use if the data does not meet the criteria stated in the
If statement.

To create alogical expression for the example above, select Equal as the operator and enter
Success asthe value. In the Then value, enter 1. Thisisthe value the system stores in the mapped
element if it reads "Success' in the source data e ement. In the Otherwise value, enter 2. Thisis
the value the system storesin the mapped element if it does not read " Success' in the source data
element.

The XQuery Preview areadisplays the expression as it appearsin the XQuery code for the
transaction map.

6. Click OK to return to the XML Mapping Conversion Editor dialog box.
If necessary, move the operation to the correct place in the operation stack.

To create avalid logical expression, the logical operation falls below the item you want to modify
in the operation stack.

8. Add additional sources and operations, as necessary.
9. Click OK to return to the mapping utility main window.
10. From the File menu, select Save Transaction M ap to save the map.
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Previewing the XML Translation for Transaction Maps

As you create your transaction maps, the system creates the X Query code that it usesto trandate XML
data. Y ou can view the translation code using the Show X Query functionality. Viewing the code is useful
for troubleshooting your transaction maps. If necessary, you can copy and paste the compiled code to
send it to Eclipse Technical Support.

To preview the XML tranglation for atransaction map:

1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display

the transaction map.

From the Options menu, select Show XQuery to display the XQuery Viewer dialog box.

Click the tab for the preview information you want to view:

Tab Description

Request XQuery The XQuery code for the received document map.
Response XQuery The XQuery code for the sent document map.
Requested Data Thetrandation XML.

TXXML

Request XML The XML generated for the received document map.
Document

Response XML The XML generated for the sent document map.
Document

If you had data element selected in the transaction, the system tries to find the XQuery line that
corresponds to the selected element. If it finds one, the system highlights the text in the XQuery
trandation. If it does not find a corresponding line, the system displaysthefirst linein the
trandation for the transaction.

Note: The XQuery Viewer dialog box defaults to the XQuery tab related to the tab
selected on the main Business Connect XML window. If the Mapping Selection
Criteriatab is selected on the main window, the Request XQuery tab displaysin
the XQuery Viewer dialog box.

5. Click Closeto return to the main window.

To search the XQuery Code, TXXML trandation, or the XML documents:

1

o~ WD

112

Open the XQuery Viewer dialog box.

Select the tab for the information you want to view.

Click Search and enter the text for which you want to search.

Click OK to search for thefirst occurrence of the text.

Click Search Next to find the next occurrence of the text.
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Running Test Compilations of XML Transaction Maps

As you create your transaction maps, the system creates the X Query code that it usesto trandate XML.
The system needs to compile the code before being able to receive or send XML documents. Y ou can set
the system to compile the code as you map elements, but you can also run atest compilation at any time.

Torun atest complication of an XML transaction map:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

Select the tab to display the side of the transaction for which you want to compile code.
From the Options menu, select Test XQuery Compilation to compile the code.
A message displays indicating whether the code compiled successfully.

5. Click OK to return to the main window.
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Posting Test XML Transactions to Eclipse

Use the XML Poster to post atest XML document to Eclipse, before receiving live transactions from a
customer or avendor. Posting test XML sends a sample XML document to the application server and on
to Eclipse to verify that it processes correctly. Posting test XML documents allows you to verify that the
document flows through the system without encountering any errors, and also alows you to verify that
the information you mapped in the transaction is correctly formatted within fields in Eclipse, such as price
data or dates on an order.

Within the XML Poster, you can search the test request data and replace portions with real data. For
example, your test XML document from atrading partner might contain artificial part numbers that will
not correctly process through the system. Use the Find function to search for that element in the test
XML document within the poster and replace the test data with real part numbers.

To post test XML transactionsto Eclipse:
1. Copy datafrom atest XML document to the Windows clipboard.
2. Accessthe Business Connect XML mapping utility.

3. Right-click atransaction in the Trading Partner Tree and select Edit Transaction M ap to display
the transaction map.

4. From the Options menu, select Post XML to display the XML Poster dialog box.
ThePost To fidd, displays the path to your application server in the following format:
http://<Your Application Server Name>/ecom/EcommerceXML
Inthe XML Request field, paste the contents of the test XML document.

From the File menu, select Post XML to send the XML document through the system.

Theresults of the transaction processing display inthe XML Response field. The results display
a status that indicates the system received the document, if there is no sent document map defined
for the transaction you are testing. If thereis a sent document map defined, the XML Response
field displays the response document it would send based on the map defined.

7. Fromthe File menu, select Close to return to the mapping utility main window.

To search the XML request data:
1. Inthe XML Poster dialog box, select Options > Find to display the Input dialog box.
2. Inthe Search For field, enter the text you want to find.
3. Click OK to start the search.
4

To search for the next occurrence of the text, press F3 or select Find Next from the Options
menul.
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Viewing the Business Connect XML Mapping Utility Change
Log

As you make edits to transaction maps, the system records your actions in the mapping utility's change
log. Use the change log to help troubleshoot problems with transaction maps, or to view the activity for a
given map.
Toview the changelog for transactions:

1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

3. Fromthe File menu, select View Change L og to display the Maintenance Log Viewer dialog box
for the transaction.

The dialog box displays the following information for the transaction that you sel ected:

Field Description

User The user who made the change.

Date The date the transaction was changed.

Time The time the transaction was changed.

Description The details about the action taken on the transaction.

4. Click Closeto return to the mapping utility main window.

Toview the changelog for deleted transactions:
1. Accessthe Business Connect XML mapping utility.

2. Right-click atransaction in the Trading Partner Tree and select Edit Transaction Map to display
the transaction map.

3. Fromthe File menu, select View Change L og to display the Maintenance Log Viewer diaog
box.

4. Click the Show Deleted Transactions M aps Only check box. The system lists all the deleted
transaction maps, including the following information:

Field Description

User The user who deleted the transaction.

Date The date the transaction was del eted.

Time The time the transaction was del eted.

Description The details about the deleted transaction, such as the transaction name and the
trading partner to whom the transaction bel onged.

5. Click Closeto return to the mapping utility main window.
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Viewing the Business Connect XML Mapping Utility Error Log

Asyou create, change, and test transaction maps, the system records any errorsit encounters when
compiling a map and creating the XQuery code. If you encounter problems with a map or the mapping
utility, you can copy the data recorded in the error log and send it to Eclipse to help identify the cause of
the error.

Note: The error log available in the mapping utility contains only errors generated by
activity within the utility itself. Additional logging information is stored on the
application server about server activity and possible server errors.

Toview the XML mapping utility error log:
1. Accessthe Business Connect XML mapping utility.
2. Fromthe File menu, select Show Error Log to display the Error Log diaog box.
Note: If the File menu does not contain the Show Error Log option, contain Eclipse
Technical support.

3. Click Closeto close the error log and return the mapping utility main window.

To clear the XML mapping utility error log window:
1. Accessthe Business Connect XML mapping utility.
2. Fromthe File menu, select Show Error Log to display the Error Log diaog box.
Note: If the File menu does not contain the Show Error Log option, contain Eclipse
Technical support.
3. Click Clear Log to clear al the contents from the log dialog box.

The system clears the contents from the on-screen display; however, the log file remains intact for
later accessif necessary. See the entire log file in the eclipseinc.log file in the Business Connect
XML mapping utility installation directory.
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Business Connect XML Mapping Utility Main Window
Aspects

Asyou select document type definition (DTD) files and identify what transaction types comprise a
trading partner transaction, the system populates the Business Connect XML mapping utility with data
from your selections. This topic illustrates how each field in the New Mapping Transaction dialog box
relates to the data you use to create transaction maps within the mapping utility.

See the following sections for information about what data displaysin each:
Trading Partners Tree

Tabs for Customer Transactions
Tabs for Vendor Transactions

Mapping Selection Criteria Tab for Customer and Vendor Transactions

For information about symbols and useful tips for using the mapping utility most efficiently, see the
following topics:

¢ Viewing and Saving Open XML Transaction Maps
¢ Business Connect XML Mapping Utility Symbols

Trading Partners Tree

When you add a new trading partner, the system adds the trading partner name to the Trading Partners
Tree:

File

ading Partners
( + ,% BEM industries
5 % Eclipse Distribution

As you define transaction maps for each trading partner, the transactions display nested under the partner
to which they belong:
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File Edit Options Help

Trading Parthers

Eclipze Distribwtion
Eﬁ Purchasze Order Submit

ML Mapping Editor

Tabs for Customer Transactions

The Document Received from Customer tab displays the elements in Eclipse for inbound documents
that you receive from your customer. When defining a customer transaction map, the transaction type you
select in the Document Received from Customer area of the New Mapping Transaction dialog box
popul ates the Target XML column in the Document Received from Customer tab. The target XML for
this transaction type contains the data elements in Eclipse that are available for the transaction. The
elements available are defined in XML database schemas.

Note: If the customer transaction does not contain a received document, such asan
invoice, and you select the No Document Will Be Received check box in the
Document Received from Customer area of the New Transaction Map dia og
box, the Document Received From Customer tab is disabled.
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Business Connect XML

% New Transaction Map E]

Tranzaction Mame | Purchase Qrder

Tran=saction Source

-Document Received from Customer

The received from custamer transaction

Ivpe populates the Target XL column in

the Document Received Fram Customer tab.
The Target XML column contains the elements
in Eclipze available far the transaction.

Transaction Type  |Customer Order Submit e
—

oo

|:| Mo Documment Wil Be Received

[ | Browze

Reply Do

Transact

Eﬂcumem Received From CUSTDmE§| Feply Document Sent to Customer | Mappipaebelagtion Criteria
= Durce il tapping = /):"I'ga.rget Wil

=@ PURCHASEORDER
@ HEADERBLOCK (7)
& CUSTOMERIDENTIFIERS

Y

Custome

# CUSTOMERHUM
@ CONTACTMAME (7]
@ EMaIL 7

D VEHDOR

@ SHIPTOADDRESS

@ CONFIRMTOADDRESS (7)
@ NVOICEADDRESS (7)

@ COMPANYADDRESS (7)
@ POMUM ()

@ MOTES (7)

e

=¥ CustomerOrderSubimit
@D order

—@ OrderiD
—@ BilTo

—iD PayTa

—I@ PriceEranch
—@ ShipBranch
—I@ GLBranch
—IE SalesSource
—@ OrderDate

—ig ShigpFrotm
—@ Orderststus

@ ShipDate

The DTD you select in the Document Received from Customer area of the New Transaction Map
dialog box populates the Source XM L column in the Document Received From Customer tab. The
source XML for this transaction type contains the data elements defined in the DTD from your trading
partner. The data elements display in the order they are defined inthe DTD.
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The received from customer

DTD populstes the Source HhL

column in the Documernt Received

From Customer tab. The Source Xkl
column contains the elements in available
faor the transaction from the customer .
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2 New Transaction Map @

Tranzaction Mame | Purchase Order |

Tranzaction Source | |

]

Document Received from Customer

Tranzaction ubitnit

Customer's DTD

Iers st

I{

purchazeorder_red.dtd Browse

[ 1 ER

e T e

Documett Received From Custom

eply Document Sent to Custormer

Mapping Selection Criteria

Mapping = Target XML

# @ HEADERBLOCK (7) \

S CUSTOMERIDEHTIFIERS
@ CUSTOMERHUM
@ CONTACTMAME [7)

B EnaIL (7

@ VEHDOR

@ SHIPTOADDRESS

@ CONFIRMTOADDRESS (7)
@® NVOICEADDRESS (7)
%@ COMPANYADDRESS (7)
B POMUM (7)

=@ CustomerOrderSubmit
=B Order
— @ (e
—i® BilTo
—ip PayTo
—ID PriceBranch
—iP ShipBranch
—I@ GLBranch
—ID SalezSource
—ID OrderDate
—@ ShipTo
— P ShipFrom
—@ OrderStatus
—@ ShipDate

—ip RequiredDate
R hlestenim

W

WZE

The Reply Document Sent to Customer tab displays the data elements in Eclipse for documents you
send to your customer. When defining a transaction map, the transaction type you select in the Reply
Document Sent to Customer area of the New Transaction Map dia og box populates the Source XM L
column in the Reply Document Sent to Customer tab. The source XML for a sent document contains
the data elements in Eclipse available for the transaction. The elements available are defined in XML

database schemas.

Note: If the customer transaction does not contain a sent document and you select the No
Document Will Be Received check box in the Reply Document Sent to
Customer area of the New Transaction Map dia og box, the Reply Document
Sent to Customer tab is disabled.
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Transaction Mame

Transaction Source

The zent to customer transaction
type populates the Source XML
column in the Reply Document Customer's DTD
Zent to Customer tab. The Source
®hL column cortains the elemernts

Business Connect XML

® New Transaction Map @

| Purchase Order

Docurment Received from Customer

Transaction Type |Custu:umer Crder Submit

| purchaseorder _req.ctd

[ ] o Documert Wil Be Received

in Eclipze available for the transaction.
f Reply Document Sent to Customer - o

\n. Tranzaction Type  |Customer Order SubribREsponse
"'Ilq.-__-__ | P

Customer's DD

| purchaseurder_resp.dtdl

Document Reseirtmhegm Customé, Reply Document Sent to Custamer pping Selection Criteriz

Magpping E

Source }(ML\

Target XL

7 CustomerOrder Submit

@ PriceBranch
3] ShipBranch
@ GLBranch

@B salezSource

=@ PURCHASEORDER.
— @ HEADERBLOCK (7)

— @ CUSTOMERIDENTIFIERS
— i@ VEHDOR

— P SHIPTOADDRESS

— @ CONFIRMTOADDRESS ()
— @ INVOICEADDRESS (7

— @ COMPANYADDRESS (7)
— @ PORNUM (7

— @ MOTES (1)

— @ REQUISITION (7)

— @ RELEASENUM (7

— @ PURCHASINGCEMTER (7)
— @ SHIPVIACODE
— T PAYMEHTCANE

The DTD you select in the Reply Document Sent to Customer area of the New Transaction Map dialog
box populatesthe Target XML column in the Reply Document Sent to Customer tab. Thetarget XML
for this transaction type contains the data elements defined in the DTD file from your trading partner. The
data elements display in the order they are defined inthe DTD.
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% New Transaction Map @

Tranzaction Matne | Purchaze Order

Tranzaction Source |

(2]
-

Document Received from Custamer

Transaction Type |Custu:umer Order Submit

v|

Customer'zs DTD | purchazearder_red.dtd

Reply Document Sent to Customer

|:| Mo Documetit Will Be Received

| Browse

The sert to customer transaction
DTD populates the Target AL
column in the Reply Document
Sent to Customer tab, The Target
¥ML column contains the elements

Tranzaction Type |Cus:tl:lmer Order Submit Response o | available for the transaction for
| e the trading partner.
Customer's DTD h d dtd
4 purchazearder_resp :! oY
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Document Received From Customde Reply Document Sert to Customer Eelection Criteria
B Source XML Mapping Target XML
| o @ CustormerOroerSubrit - =i pHRCHASEORDER ”
=@ Order @ HEADERBLOCK (7
g ;’_:I'E’FE”D @ CUSTOMERIDEHTIFIERS
- @ VENDOR
@ PayTo ]
® Frissiranch P SHIPTOADDRESS
L @ Shipgranch D CONFIRMTOADDRESS (7) B
| @ oLEranch ® NVOICEADDRESS (7)
| ® SalesSource ® CcoMPANYADDRESS (7)
—® OrderDate @ PoNUM (7)
@ ShipTo @ MOTES (7)
@ ShipFrom ® REQUISITION (7)
—@ OrderStatus @ RELEASENUM (?)
—@® ShipDate PURCHASINGCENTER 7
IR Remiiredhiste !
4 | > bt

Tabs for Vendor Transactions

The Document Sent to Vendor tab displays the elementsin Eclipse for documents you send to your
vendor. When defining a transaction map, the transaction type you select in the Document Sent to

Vendor areaof the New Transaction Map dialog box populates the Source XML column in the

Document Sent to Vendor tab. The source XML for a sent document contains the elementsin Eclipse
available for the transaction. The elements available are defined in XML database schemas.

Note: If the vendor transaction does not contain a sent document and you select the No

Document Will be Received check box in the Document Sent to Vendor area of
the New Transaction Map dialog box, the Document Sent to Vendor tab is

disabled.

122

© 2011 Epicor Software Corporation. All rights reserved.



Rel.8.7.2

The =zert to wendor transaction type populates
the Source XML calumn in the Document

Sent to Yendar tak. The Source Bkl

column contains the elements available

far the transaction in Eclizpe.

—

Transaction Mame

Transaction Source |

Business Connect XML

2 New Transaction Map E

| Product Inguiry

(2]
-

Document Sent to Wendor \\

Transaction Type Wry

vl

YVendor's DTD

productinguirysent dtd

|:| Mo Docurment Wil Be Received

| Browsze

Product
€3] Gty
@ customerProductiumie
@ ProductiD

@ Description

@ CGLProductType

@D status

@ KEYWORDSTable (+1)
D PricingProductiD

@ Uom_aTyTable (+)

4 | >

ocutnent Sent to Yendor | Béply Document Received from “Yendar || Mapping Selection Criteria
= aurce KMCN hdzpping = Target Xl "
=@ veltdorProductinguiry - =@ Eclipsebtob

IJ:'I—E EclipseProductStockinquiry
— @ CustomerHumber

— @ Password

— @ UPCCode (7)

— @ Keywords (7)

— @ Description (7)

— @ CustomerPartMumber (7
— @ UserDefined (7)

— I Quantity (7)

— i@ LineNumber iEa]

— i@ Additionalinformation ™

The DTD you select in the Document Sent to Vendor area of the New Transaction Map dial og box
populates the Target XML column in the Document Sent to Vendor tab. Thetarget XML for this
transaction type contains the data elements defined in the DTD file from your trading partner. The data
elements display in the order they are defined inthe DTD.
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The Reply Document Received from Vendor tab displays the elements in Eclipse for documents that
you receive from your vendor. When defining a vendor transaction map, the transaction type you select in
the Reply Document Received from Vendor area of the New Transaction Map dialog box populates the
Target XML column in the Reply Document Received from Vendor tab. Thetarget XML for this
transaction type contains the data elements in Eclipse that are available for the transaction. The elements
available are defined in XML database schemas.

Note: If the vendor transaction does not contain areceived document, and you select the
No Document Will Be Received check box in the Reply Document Received
from Vendor area of the New Transaction Map dialog box, the Reply Document
Received From Vendor tab is disabled.
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The DTD you select in the Reply Document Received from Vendor area of the New Transaction Map
dialog box populates the Source XML column in the Reply Document Received from Vendor tab. The
source XML for this transaction type contains the data elements defined in the DTD from your trading
partner. The data elements display in the order they are defined inthe DTD.
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Mapping Selection Criteria Tab

Use the Mapping Select Criteria tab to indicate to the system which map to use when it receives or
sends an XML document. If the transaction map contains an inbound, received transaction type, the DTD
file you select for the received XML document in the New Transaction dialog box populates the
Mapping Selection Criteria tab. If the transaction map does not contain an inbound transaction type and
is outbound-only, the DTD you select for the outgoing, sent to document popul ates the M apping
Selection Criteriatab. For additional information, see Defining Mapping Selection Criteria.
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Viewing and Saving Open XML Transaction Maps

Asyou create and edit transaction maps, the system keeps each map open until you close the transaction
using the File menu. Each open transaction map displays as a tab along the top of the main mapping
utility window. To view amap that is aready open for editing, click the tab for the transaction at the top
of the main window.

EM industries

Tranzaction Mame  lnvoice

happing Source Iprocure

To close transaction maps.
1. Select thetab of the transaction you want to close.
2. Fromthe File menu, select Close Transaction Map.

To save all open transaction maps:
1. FromtheFile menu, select Save All Transaction M aps.

The system saves all changes to al open transaction maps.
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Business Connect XML Mapping Utility Symbols

Y our trading partners document type definition (DTD) files might contain one or more of the following

symbols that indicate the occurrence of each element in the DTD. These symbols display in the Business
Connect XML mapping utility when you expand the source or target XML that represents the DTD from
your trading partner:

Symboal Description
& A one-to-many relationship can be mapped for the element. The element can appear in
the XML document once, more than once, or not at all.
+ A repeating group, that is, the element can occur in the XML document once or more
than once, such as, items on an order.
? An optiona piece of data, such as an extension for a telephone number. The element
might appear in the XML document zero or one time.
Blank The element must appear only once in the XML document.
@ An XML attribute associated with the element.
Bold The element isrequired for the transaction.

The Business Connect XML mapping utility also contains the following symbols:

Symbol Description

e Trading partner in the Trading Partner Tree. Transactions are listed under each trading
partner.

N Transaction in the Trading Partner Tree, or atrading partner that does not have
transactions defined yet.

= The target XML element has operations assigned to modify incoming or outgoing data.

e The target XML element has a source element mapped to it, with no additional data
modifications.
The target XML element has a nested element to which a source element is mapped.
Expand the element to see the nested elements.

=) Multiple target elements are mapped to a source element. This symbol displaysin the
Mapping Preview pane.

The XML document contains a DOCTY PE declaration.

n The element has a single data conversion applied. This symbol displays in the Mapping
Preview pane.

- The element has multiple data conversions applied. This symbol displaysin the
Mapping Preview pane.

@ A source, such asaLiteral, in the Operation Stack field in the XML Mapping
Conversion Editor dialog box.

&

An operation, such as concatenation, in the Operation Stack field in the XML
Mapping Conversion Editor dialog box.
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Sending and Receiving Customer Transactions Using XML

Using the settings you define in Eclipse and the transaction maps you set up for trading partnersin the
mapping utility, the system processes transactions and routes them to review queues where appropriate.

Before sending or receiving XML from customers, ensure you have completed the following setup for the
customer recordsin Eclipse. For additional system setup requirements, see Business Connect XML Setup
Overview.

o Set system notifications for XML customer transactions.

e Set post locations for XML customer transaction documents.
e Set XML activity triggers.

e Define pricing variance for XML customer transactions.

Use Business Connect XML to receive the following transaction types from customers with whom you do
business using XML documents:

e Order submits

Product inquiries

Change order requests

Requests for quotes

Punch-out setup requests
B2B connection test

Use Business Connect XML to send the following transaction types to customers with whom you do
business using XML documents:

¢ Order acknowledgements
o Advance ship notices

e Invoices
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Reviewing XML Orders From Your Customers

Y ou can receive and process orders from your customers using XML. When atrading partner submits an
order to your company using XML, the system does the following:

e Trandatesthe XML document according to the settings in the inbound order submit transaction
map for the trading partner.

e Creates asaesorder with theinitia order status set.

If the order status is mapped and sent in the XML document, the system uses thisvalue. If the
XML document either does not have an order status mapped or the datais not included in the

XML, the system uses the default new order status set in the Customer record. If the customer
record does not have a default new order status set, the system defaults to Bid.

o Placesthe order in the Remote Order Entry Review Queueif the Log Bids For Review field in the
customer record is set to New Order. If theinitial status for inbound orders for the customer is set
to Order, the system places the order in the Remote Order Entry Review Queueif the Log Orders
for Review field in the customer record is set to New Order.

If an item on the order is backordered, the system assigns the BkOr d status to the queue entry.

¢ Sends a message to the user responsible for reviewing the Remote Order Entry Review Queue for
the customer. This person reviews the order, makes any needed edits, and then changes the order
status to an open status.

e Archivestheincoming XML document in Remote Archive Maintenance.

Todisplay the Remote Order Entry Review Queue:
1. Display the character-based system.
Note: The Remote Order Entry Queue has not been incorporated into Solar Eclipse as of
thisrelease.
2. From the System > Custom menu, select Remote Review Queues and select Order Entry
Queueto display the Selection Criteria screen.

3. Inthe Start Datefield and End Date field, enter the first and last dates in the range for which to
display documentsin the queue.

For example, to see dl the ordersthat you received from April 1, 2004 to April 15, 2004, enter
04/01/04 in the Start Date field and 04/15/04 in the End Date field.

Thefields default to the date one week before the current date and to the current date.
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4. Enter additional selection criteriaand press Esc to populate the BCXML Remote Order Entry

Review Queue.

Field

Description

Remote Type

The type of remote transaction you want to view, for example, XML or EDI.

Note: The current release supports only XML order acknowledgmentsin the
Remote P/O Acknowledgment Review Queue.

User ID

The user ID to display only XML order acknowledgments that a user is
assigned to review.

Branch

The branch from which the items ordered will be shipped. To review orders
for all branches, leave this field blank.

Note: Thisfield respects the setting in the Remote Order Review Queue
Branch control maintenance record.

The summary information for each acknowledgement that meets the criteria displays.

Field Description

SO# The sales order number the order references.

Customer The bill-to customer for the order.

Status The current shipment status of the order, such as B for bid or A for ship when

available.

Order Amount

The total dollar amount of the order.

Type The type of transmission, such as XML or EDI.
Note: The current release supports only XML orders in the Remote Order
Entry Review Queue.

Error Identifies any errors that occurred in the transaction.

Note: To refine or change your search, use the Select hot key and enter new search

criteria

Toresearch orderswith errors:;

1. Display the Remote Order Entry Review Queue.

2. Useany of the following hot keys to research orders with errors:

To...

Usethishot key...

view the associated sales order in view-only mode | View
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To...

Usethishot key...

make changes to the associated sales order, such
as overwriting any ***B2B Product Not
Found*** items with the correct product, or
updating the ship viafor an order

Edit

Note: Do not delete a product-not-found item or
add any new items to the original generation order
generation. The information provided in the
purchase order is repeated back in the order
acknowledgement and the invoice documents.
Add any new itemsto new order generations.

view the error message for an order

Errors

display the archived XML document asthe
system received it

Detail

The Remote Archive Detail screen displays. Use
the Edit hot key to edit the contents of the
document and the Requeue hot key to reprocess
the document.

More Options When Reviewing XML Orders From Customers

The following are additional options you can use when reviewing remote ordersin the Remote Order
Entry Review Queue:

To... Usethishot key...
delete an order that no longer requires your Clear

attention

to delete all orders older than a designated date Clear By Date

from the queue

to delete orders that successfully processed with
no errors

Clear OrdersW/O Errs
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Processing XML Product Inquiries

When atrading partner submits a request for prices and product availability to your company using XML,
the system does the following:

o Trandatesthe XML document according to the settings in the inbound price and availability
transaction map for the trading partner.

o Searchesthe price and available inventory information in the system.
¢ Sends aresponse using the product inquiry response transaction map for the trading partner.
o Archivesthe incoming XML document in Remote Archive Maintenance.

The system retrieves the price and available inventory information and generates the response
automatically.
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Reviewing XML Change Order Requests From Your
Customers

Y our customers might send you changes to existing orders using an inbound XML change order request.
When the system receives an XML change order request, it does the following:

o Looks for asales order number that matches one that existsin your system.

o Processes the change order request using the change order transaction map you defined for the
trading partner requesting the change.

¢ Createsareport that contains the requested changes.

e Savesthereport to the Hold file of the user entered in the Default User M essaged With Order
Changesfield in the Remote Order Entry Parameters screen for the customer, and sends a system
notification message to that user.

o Placesthe order in the Remote Order Entry Review Queue if the Log Bids For Review field in the
customer record is set to Changes. If theinitial status for inbound orders for the customer is set to
Order, the system places the order in the Remote Order Entry Review Queue if the Log Orders
for Review field in the customer record is set to Changes.

Note: If adefault user is not defined for change order notifications in the customer
record, the system notifies the user identified for order changes in the Default
Remote Order Entry (ROE) Messaging control maintenance record.

The identified user reviews the requested changes to the order and updates the order in the system
manually. The system does not update existing orders automatically with requested changes because an
order could be picked and on atruck at the time the customer makes the change request.

After making the requested changes, you can send an XML order acknowledgement. The system
transmits the acknowledgment to customers when you set the print status of the order to 2 for B2B.
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Reviewing XML Quote Requests From Your Customers

Y ou can receive quote requests from your customers using XML. When atrading partner submits a quote
request to your company using XML, the system does the following:

o Trandatesthe XML document according to the settings in the inbound quote request transaction

map for the trading partner.

e Creates asaesorder with an order status of Bid.

o Placesthe order in the Remote Order Entry Review Queueif the Log Bids For Review field in the
customer record is set to New Order. If theinitial status for inbound orders for the customer is set
to Order, the system places the order in the Remote Order Entry Review Queue if the Log Orders
for Review field in the customer record is set to New Order.

¢ Sends a message to the user responsible for reviewing the Remote Order Entry Review Queue.
This person reviews the order, makes any needed edits, and then changes the order statusto an

open status.

e Archivestheincoming XML document in Remote Archive Maintenance.

Toreview an XML quoterequest:

1. Display the character-based system.

Note: The Remote Order Entry Queue has not been incorporated into Solar Eclipse as of

thisrelease.

2. Fromthe System > Custom menu, select Remote Review Queues and select Order Entry
Queueto display the Selection Criteria screen.

3. Inthe Start Datefield and End Date field, enter the first and last dates in the range for which to
display documentsin the queue.

For example, to see al the ordersthat you received from April 1, 2004 to April 15, 2004, enter
04/01/04 in the Start Date field and 04/15/04 in the End Date field.

The fields default to the date one week before the current date and to the current date.
4. Enter additional selection criteriaand press Esc to populate the Remote Order Acknowledgement

Review Queue.

Field Description

Remote Type The type of remote transaction you want to view, for example, XML or EDI.
Note: The current release supports only XML order acknowledgmentsin the
Remote P/O Acknowledgment Review Queue.

User ID The user ID to display only XML order acknowledgments that a user is
assigned to review.

Branch The branch from which the items ordered will be shipped. To review orders
for al branches, leave this field blank.
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The summary information for each acknowledgement that meets the criteria displays.

Field Description

SO# The sales order number the order references.

Customer The customer that sent the order.

Status The current shipment status of the order, such as B for bid or A for ship when
available.

Order Amount Thetotal dollar amount of the order.

Type The type of transmission, such as XML or EDI.
Note: The current release supports only XML orders in the Remote Order
Entry Review Queue.

Error Identifies any errors that occurred in the transaction.

Select the bid and use the Edit hot key.
Edit the bid, as necessary.

Display the bid's Status screen.
Changethe Prt statusto 2 for B2B.

Press Esc to exit and send the XML quote regquest response to the customer from which you
received the quote request.

© ® N o o

The system verifiesthat avalid XML transaction map exists for a quote request response for the
trading partner and trand ates the Eclipse data using the settings in the map.
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Processing XML Punch-Out Requests

Use Business Connect XML to process inbound punch-out requests from procurement marketplace
software, such as the Ariba Supplier Network. When a user requests a product on the source's web site,
the site requests to access, or "punch-in," to your web site to view your catalog. Using a punch-out system
allows your buyersto access your most current catalog and pricing information at any time of day.

When the Eclipse system receives a punch-out setup request, it does the following:

e Trandatesthe XML document according to the settings in the websession transaction map for the
trading partner.

¢ Sends aURL and websession login ID using the websession response transaction map for the
trading partner.

e Archivesthe XML document in Remote Archive Maintenance.

As acustomer shops and places orders for items from your catalog, the source site routes XML order
requests through to the Eclipse system for order fulfillment. For information about how to process
inbound order requests, see Reviewing XML Orders From Y our Customers.
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Sending XML Order Acknowledgements to Your Customers

When a customer sends an inbound XML order request, the system does the following to generate the
order and automatically send an order acknowledgement. Y ou can also send an other acknowledgement
manually.

Note: Before the system can send a purchase order acknowledgement to a customer,
create an XML transaction map for an order acknowledgement transaction type,
set activity triggers, and define document post locations for the customer.

Trandates the XML document according to the settings in the inbound order submit transaction
map for the trading partner.

Creates a sales order with theinitial order status set.

If the order status is mapped and sent in the XML document, the system uses thisvalue. If the
incoming XML document either does not have an order status mapped or the datais not included
in the XML, the system uses the default new order status set in the Customer record. If the
customer record does not have a default new order status set, the system defaultsto Bid.

Places the order in the Remote Order Entry Review Queue if the Log Bids For Review field in the
customer record is set to New Order. If theinitia status for inbound orders for the customer is set
to Order, the system places the order in the Remote Order Entry Review Queue if the Log Orders
for Review field in the customer record is set to New Order.

Sends a message to the user responsible for reviewing the Remote Order Entry Review Queue for
the customer. This person reviews the order, makes any needed edits, and then changes the order
status to an open status.

Archives the incoming XML document in Remote Archive Maintenance.

When the order has been processed, the system sends the XML order acknowledgement to the
customer.

Tomanually send an XML purchase order acknowledgement:

1

o~ w DN

From the Order s > Queues menu, select Remote Order Entry Review to display the Remote
Order Review Queue window.

Select the XML bid and double-click it to display the bid in sales order entry.

Edit the order, as necessary.

Display the order's Status tab.

Change the order status to an open status, such as Call When Complete.

Note: The order status cannot be Bid, I nvoiced, or Canceled for the system to send an
order acknowledgement using XML.

In the Print field, change the print statusto 2.

Exit the window and process the order.

If prompted, select the type of acknowledgement to send.

The system verifiesthat avalid XML transaction map is created for an order acknowledgement
for the trading partner and trand ates the Eclipse data using the settings in the map.
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Sending XML Advance Ship Notices to Your Customers

Using XML, you can set the system to create and send an Advance Ship Notice (ASN) to your trading
partner, advising them of inventory you are going to ship in their next order.

Note: Before the system can send an advanced ship notice to a customer, create an XML
transaction map for an advanced ship notice transaction type, set activity triggers,
and define document post locations for the customer.

Y ou can set the system to create and send an ASN from the following locations:

¢ From the Shipping Manifest Queue after the manifest is created and locked. Use the Manifest Lock
activity trigger with the B2B ASNs activity description to set up this process.

e From an order generation when the Prt field on the Status screen is set to 2.

When you send an ASN using XML, the system verifies that the customer has a transaction map defined
for the outbound Advanced Ship Notice transaction type and archives the XML sent in Remote Archive
Maintenance.

Tosend an XML ASN from a shipping manifest:
1. Setthe Manifest Lock activity trigger for the customer to B2B ASNSs.

When an order for the customer is placed on a manifest in the Shipping Manifest Queue and the
manifest is locked, the system generates the ASN and sends it using the transaction map defined
for an outbound ASN transaction for the trading partner.

Tosend an XML ASN from a salesorder:
1. Open the order for which you want to send the advance ship notice document.
Display the order's Status tab and change the order status to I nvoice.
Inthe Print field, enter 2 for B2B.
Exit the window and process the order.
If prompted, select the type of ASN to send.

The system verifiesthat avalid XML transaction map existsfor an ASN for the trading partner
and tranglates the Eclipse data using the settings in the map.

o~ WD
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Sending XML Invoices to Your Customers

The system transmits outbound invoices using XML when the Prt field on the Status screen of an
invoiced order generation is set to 2. Before the system can send an XML invoice to a customer, create an
XML transaction map for an outbound invoice transaction type for the trading partner.

Note: Before the system can send an invoice to a customer, create an XML transaction
map for an invoice transaction type, set activity triggers, and define document post
locations for the customer.

When you send an invoice using XML, the system verifiesthat the customer has a transaction map
defined for the outbound invoice transaction type and archives the XML sent in Remote Archive
Maintenance.

Single Invoice Processing
To send or re-send asingleinvoice using XML, change the print status of the order.

To send an individual XML invoicefrom a salesorder:
1. Display aninvoiced order in Sales Order Entry.
Display the order's Status tab.
In the Printt field of the generation for which you want to send an invoice, select 2 for B2B.

Exit and process the order.

o w N

If prompted, select the type of invoice to send.

The system verifiesthat avalid XML transaction map is created for an invoice for the trading
partner and trand ates the Eclipse data using the settings in the map.

Batch I nvoice Processing

If you flag your trading partner's customer record for XML and set the Batch Invoicein Lieu of Print
activity trigger in the record to B2B Sales Dac, the system sets the print status during batch invoice
processing and then sends the invoice.

Toflag acustomer for XML batch processing:
1. Fromthe Maintenance menu, select Customer to display the Customer Maintenance window.
2. Inthe Customer fidd, enter the customer's name and press Enter to display the record.

3. Fromthe Pricing menu, select Price I nfor mation to display the Customer Pricing Information
window.

4. Inthelnvoice Print Copiesfield, enter the number of invoices you want to print during the batch
processing cycle.

5. Return to the customer record.
6. Save your changes and close the customer record.

When you run the batch printing program, the system checks the setting in the Invoice Print Copiesfidd
and sends the B2B Sales Doc, as specified in the Batch Invoice in Lieu of Print activity trigger. The
system sends the invoice using the outbound invoice transaction map defined for the customer.
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Processing B2B Connection Test Transactions From Your
Customers

If you are using the Eclipse B2B Commerce companion product for electronic trading with customers
who also run Eclipse, your system processes test transactions to verify the communication connection
between your Eclipse system and your customer's Eclipse system. When atrading partner submits a B2B
connection test to your company using XML, your system does the following:

o Trandatesthe XML request according to the settings in the inbound customer B2B connection test
transaction map for the trading partner.

o Verifiesthe basic credential information passed in the transaction.
o Sends a successful HTTP 200 response back to your customer.

o Archivestheincoming XML document in Remote Archive Maintenance.
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Sending and Receiving Vendor Transactions Using XML

Using the settings you define in Eclipse and the transaction maps you set up for trading partnersin the
mapping utility, the system processes transactions and routes them to review queues where appropriate.

Before sending or receiving XML from vendors, ensure you have completed the following setup for
vendor recordsin Eclipse. For additional system setup requirements, see Business Connect XML Setup
Overview.

¢ Set vendor access information for XML documents.
e Set vendor activity triggers for XML documents.
o Set post locations for XML vendor transaction documents.

Use Business Connect XML to receive the following transaction types from vendors with whom you do
business using XML documents:

o Purchase order acknowledgements
o Advance ship notices

e Invoices

e Product inquiries

Use Business Connect XML to send the following transaction to vendors with whom you do business
using XML documents:

e Purchase orders

¢ Change order requests
e Direct orders

e B2B connection tests
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Reviewing XML Order Acknowledgements From Your
Vendors

An XML trading partner might send an XML acknowledgement document after they receive a purchase
order from you.

Note: The current release supports only XML order acknowledgements in the Remote
Order Acknowledgment Review Queue.
When the system receives the order acknowledgement, it does the following:

o Trandatesthe XML document according to the settings in the inbound order acknowledgement
transaction map for the trading partner.

o Adds the order acknowledgement to the Remote Order Acknowledgement Review Queue.

o L ocatesthe order number referenced in the acknowledgement and matches the items to an open
purchase order generation in the system.

o Setsthe match level depending on the matching results:

Match Level Description
N No match was found. Thislevel can occur for any of the following
reasons:

¢ The acknowledgement contains an invalid order number.

o Thereferenced order does not contain an open generation.

o The order has an open generation, but islocked by another user or
process.

o The system cannot match any items on the acknowledgement with
items and quantities on any open generation of an open purchase order.

S Some items and quantities match.

G The items and quantities have an exact match, but the dollar amount is
not within the acceptable over or short range.

P All items and quantities are perfect matches.

o Archivesthe order acknowledgement document in Remote Archive Maintenance.

Review the orders in the queue to verify which acknowledgements matched successfully to existing
purchase order generationsin your system.

To display the Remote Order Acknowledgment Review Queue:
1. Display the character-based system.
Note: The Remote P/O Acknowledgement Queue has not been incorporated into Solar
Eclipse as of thisrelease.
2. Fromthe System > Custom menu, select Remote Review Queues and select P/O
Acknowledgment Queue to display the Selection Criteria screen.

3. Inthe Start Datefield and End Date field, enter the first and last dates in the range for which to
display documentsin the queue.
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For example, to see all the order acknowledgements that you received from April 1, 2004 to April
15, 2004, enter 04/01/04 in the Start Date field and 04/15/04 in the End Date field.

The fields default to the date one week before the current date and to the current date.

4. Enter additional selection criteriaand press Esc to populate the Remote Order Acknowledgement
Review Queue:

Field Description

Remote Type The type of remote transaction you want to view, for example, XML or EDI.

Note: The current release supports only XML order acknowledgmentsin the
Remote P/O Acknowledgment Review Queue.

User ID The user ID to display only XML order acknowledgments that a user is
assigned to review.

Ship Branch The branch to which the items ordered will be shipped. To review
acknowledgments for all branches, leave thisfield blank.

Vendor The vendor to whom you sent the original purchase order. To review
acknowledgments from all vendors, leave this field blank.

PO# The order number to search for a specific order.

The summary information for each acknowledgement that meets the criteria displays:

Field Description

PO# The purchase order number the acknowledgement references.

Vendor The vendor who received your purchase order and sent you the
acknowledgement.

M (Match Level) The system-assigned match level. A dollar sign ($) in thisfield indicates there
is amessage attached. Use the M essage hot key to view the message.

Post Date The date the system received the acknowledgement document.

RcvBr The receiving branch of the purchase order, if noted in the acknowledgment.

Ship Via The carrier handling the shipment, such as UPS, if noted in the

acknowledgement.

Type The transmission type, such as XML or EDI.

Note: The current release supports only XML documents in the Remote P/O
Acknowledgment Review Queue.

Note: To refine or change your search, use the Select hot key and enter new search
criteria.

To resear ch unsuccessful acknowledgment matches:
1. Display the Remote Order Acknowledgement Review Queue.
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2. Useany of the following hot keys to research unsuccessful matches:

it

To... Usethishot key...
display messages attached to the acknowledgement M essage

view the associated order in view-only mode View

display the archived XML document as the system received Detail

The Remote Archive Detail screen
displays. Use the Edit hot key to edit
the contents of the document and the
Requeue hot key to reprocess the
document.

display the detailed order acknowledgement to research
discrepancies, such as price mismatches

Detail then Vendor |tem Detail

The system displays the order
acknowledgement in the Hold Entry
Pre-View screen.

More Options When Reviewing XML Order Acknowledgements From Vendors

The following are additional options you can use when reviewing XML order acknowledgementsin the

Remote Order Acknowledgment Review Queue:

To... Usethishot key...
delete an acknowledgment that no longer requires your attention Clear

delete all acknowledgments older than a designated date from the Clear By Date
queue

edit the associated order within Eclipse Edit

clear order acknowledgements with a perfect match level from the
queue

Clear Matches
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Reviewing XML Advanced Ship Notices From Your Vendors

Business Connect XML

When an XML trading partner ships an order to you, they might send an advance ship notice (ASN) using

XML. This document lists the items from your origina submitted purchase order that the vendor is
shipping to you.

Note: The current release supports only XML advance ship notices in the Remote

Advanced Ship Notice Review Queue.

When the system receives an ASN from a vendor using XML, it does the following:

o Trandatesthe XML document according to the settings in the inbound order submit transaction

map for the trading partner.
o Addsthe ASN to the Remote Advanced Ship Notice Review Queue.

o Locates the purchase order number referenced in the ASN, and matches the items to an open

generation on the purchase order. The system looks at the total number or line items and quantities
to match lineitems.

o Setsthe match level depending on the matching results:

Match L evel

Description

N

No match was found. Thislevel can occur for any of the following reasons:

e The ASN contains an invalid purchase order number.

¢ The referenced purchase order does not have an open generation.

¢ They purchase order has an open generation, but islocked by another user or
process.

¢ The system cannot match any items on the ASN with items and quantities on any
open generation of the referenced purchase order.

Some items and quantities match.

Theitems and quantities have an exact match, but the dollar amount is not within
the acceptable over or short range.

All items and quantities are perfect matches.

¢ If the system finds an exact match, it changes the generation Prt status from Open to Vendor
Shipment Notification.

If there isan entry in the Freight Daysfield on the Miscellaneous Vendor Information screen

for the vendor who sent the ASN, the system adds that number of days to the ship date

indicated on the ASN to determine the expected arrival date of the order.

o If the system does not find an exact match, it transfers the matched items from the open

generation to a new Vendor Shipment Notification generation.

¢ Poststhe "B2B Creating Vendor Ship Notification” message to the purchase order change log for
ASNs that matched all or some items.

Use the ASN listed in the Remote Advanced Ship Notice Review Queue to review theitems on the

shipment before the shipment arrives.
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To display the Remote Advanced Ship Notice Review Queue:
1. Display the character-based system.

Note: The Remote Advanced Ship Notice Review Queue has not been incorporated into
Solar Eclipse as of thisrelease.

1. Fromthe System > Custom menu, select Remote Review Queues and select Advanced Ship
Notice Queue to display the Selection Criteria screen.

2. Inthe Start Datefield and End Date field, enter the first and last dates in the range for which to

display ASNs.

For example, to see al the ASNs that you received from April 1, 2004 to April 15, 2004, enter
04/01/04 in the Start Date field and 04/15/04 in the End Date field.

The fields default to the date one week before the current date and to the current date.
3. Enter additional selection criteriaand press Esc to popul ate the Remote Advanced Ship Notice

Review Queue:

Criteria Description

Remote Type The type of remote transaction you want to view, for example XML or
EDI.

Note: The current release supports only XML ASNsin the Remote
Advanced Ship Notice Review Queue.

s b The user ID to display only ASN documents assigned to the user to
review. To review ASNs assigned to all users, leave thisfield
blank.

Ship Branch The branch to which items on the ASN are being shipped. To review
ASNsfor al branches, leave thisfield blank.

Vendor The vendor who shipped the items. To review ASNs from all your
vendors, leave thisfield blank.

PO # The order number associated with the ASN to search for a specific order.

The summary information for each remote ASN displays:

Field Description
PO# The purchase order number that the ASN references.
Vendor The vendor who sent the ASN.

M (Match Level)

The system-assigned match level. A dollar sign ($) in thisfield indicates
there is a message attached. Use the M essage hot key to view the

message.

Ship Date The date the vendor shipped or plansto ship the items.
RcvBr The branch that is scheduled to receive the shipment.
Ship Via The carrier handling the shipment, if noted in the ASN.
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Field Description

Type The transmission type, such as XML or EDI.

Note: The current release supports only XML ASNs in the Remote P/O
Advanced Ship Notice Review Queue.

Note: To refine or change your search, use the Select hot key and enter new search
criteria
Toresearch unsuccessful XML advance ship notice matches:
1. Display the Remote Advanced Ship Notice Review Queue.
2. Useany of the following hot keys to research unsuccessful matches:

To... Usethishot key...
display messages associated with an ASN M essage
view the associated purchase order View

display the archived ASN document asthe system | Detail

received it The Remote Archive Detail screen displays. Use
the Edit hot key to edit the contents of the
document and the Requeue hot key to reprocess

the document.
display the detailed ASN to research Detail then Vendor Item Detail
discrepancies, such as total number of items The system displays the ASN in the Hold Entry
ordered versus that shipped Pre-View screen.

More Options When Reviewing XML Advanced Ship Notices From Vendors

The following are additional options you might use when reviewing ASNsin the Remote Advanced Ship
Notice Review Queue:

To.. Usethishot key...

delete an ASN that no longer requires your Clear

attention

delete all ASNs older than adesignated date from | Clear By Date

the queue Clearing ASNs removes them from the queue.

Y ou can still view the documents in Remote
Archive Maintenance.

edit the associated order within Eclipse Edit
clear ASNsthat match perfectly from the queue Clear Matches
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Reprocessing XML Invoices From Your Vendors

If the system receives an invoice through XML before you receive the items from the vendor in the
system, the entry in the Remote Invoice Review Queue shows that the system did not find a matching
received purchase order. After you receive the order into the system, you can reprocess the invoice. Y ou
can also reprocess invoi ces after making changes to matching purchase orders.

We recommend that you reprocess invoices in the queue daily. Y ou can also schedule the processto run
automatically.

Note: The system archivesthe XML invoicesit receivesin Remote Document
Maintenance.

Toreprocessan XML invoice:

1. Display XML invoicesin the Remote Invoice Review Queue and select the invoice you would
like to reprocess.

2. Usethe Detail hot key to display the Remote Archive Detail screen, which displaysthe XML
received for the invoice.

3. Usethe Requeue hot key to resubmit the XML document.
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Processing XML Product Inquiries

When atrading partner submits a request for prices and product availability to your company using XML,
the system does the following:

e Trandatesthe XML document according to the settings in the inbound price and availability
transaction map for the trading partner.

o Searchesthe price and available inventory information in the system.
¢ Sends aresponse using the product inquiry response transaction map for the trading partner.
e Archivestheincoming XML document in Remote Archive Maintenance.

The system retrieves the price and available inventory information and generates the response
automatically.
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Sending XML Purchase Orders to Your Vendors

The system transmits purchase orders to vendors using XML when you set the print status on the
purchase order to 2. Y ou can also send a purchase order to your vendor using the Eclipse B2B Commerce
screen in sales order entry if you are procuring items for an order.

Note: Before the system can send a purchase order to a vendor, create an XML
transaction map for a purchase order transaction type, set activity triggers, and
define document post locations for the vendor.

When you send a purchase order using XML, the system verifies that the vendor has a transaction map
defined for an outbound purchase order transaction type and archives the XML sent in Remote Archive
Maintenance.

Tosend an XML purchase order to your vendor:

1. Display an open order in Purchase Order Entry.

2. Display the order's Status tab.

3. InthePrint field, enter 2 for B2B Transmit.
Note: Y ou can also send a purchase order to your vendor using the Eclipse B2B

Commerce screen in sales order entry if you are procuring items for an order.

Exit the window, process the purchase order, and send it to the vendor.
If prompted, select the type of purchase order document to send.

The system verifiesthat avalid XML transaction map exists for a purchase order for the trading
partner and trand ates the Eclipse data using the settings in the map.
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Sending XML Change Order Requests to Your Vendors

The system transmits changes to purchase orders to vendors using XML when you set the print status on
the purchase order to 2.

Note: Before the system can send a change order request to a vendor, create an XML
transaction map for a change order transaction type, set activity triggers, and
define document post locations for the vendor.
Before you can send a change order request to an XML trading partner, compl ete the following tasks:
e Set vendor access information for posting documents to the trading partner's web site.

e Create an XML transaction map for an outbound XML order submit transaction type for the trading
partner.

When you send a change order request using XML, the system verifies that the vendor has a transaction
map defined for an outbound purchase order transaction type and archives the XML sent in Remote
Archive Maintenance.

Tosend an XML change order request to your vendor:
1. Display an open order in Purchase Order Entry.
Make order changes, as necessary.
Display the order's Status tab.
In the Print field, enter 2 for B2B Transmit.
Exit the window, process the purchase order, and send it to the vendor.

o gk~ 0D

If prompted, select the type of purchase order document to send.

The system verifiesthat avalid XML transaction map exists for a purchase order for the trading
partner and trand ates the Eclipse data using the settings in the map.
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Sending XML Direct Orders to Your Vendors

A direct order is similar to a purchase order that you send to your vendor to request items for your
warehouse to fill outstanding orders. However, using a direct order, you instruct the vendor to ship the
ordered items directly to your customer, not to you.

The system transmits direct orders to vendors using XML when you set the print status on a direct sales
order generation to 2 and select the Direct Order Submit transaction document. The direct sales order
generation contains the items that you are acquiring from your vendor to fill the order. Y ou can also send
adirect order to your vendor using the Eclipse B2B Commerce screen in sales order entry if you are
procuring items for an order and want to ship them directly to your customer.

Note: Before the system can send a direct order to a vendor, create an XML transaction
map for adirect order transaction type that contains the ship-to and bill-to
information for the order, set activity triggers, and define document post locations
for the vendor.

When you send a direct order using XML, the system verifies that the vendor has a transaction map
defined for an outbound direct order transaction type and archives the XML sent in Remote Archive
Maintenance.

Tosend an XML direct order to your vendor:
1. Display an open order in Sales Order entry.
2. Display the order's Status tab and select the direct order generation you want to send.
3. InthePrint field for that generation, enter 2 for B2B Transmit.

Note: You can also send adirect order to your vendor using the Eclipse B2B Commerce
screen in sales order entry if you are procuring items for an order and want to ship
them directly to your customer.

Exit the window, process the order, and send it to the vendor.

If prompted, select the Direct Order Submit document.

The system verifiesthat avalid XML transaction map exists for a purchase order for the trading
partner and trand ates the Eclipse data using the settings in the map.
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Testing Vendor B2B Connections with XML

If you are using the Eclipse B2B Commerce companion product for electronic trading with your vendors
who also run Eclipse, test the B2B communication connection between your Eclipse application and your
vendors from the Vendor B2B Setup screen in Eclipse. When you test the vendor B2B communication,
your system and your vendor's system do the following:

o Your system tranglates the XML request according to the settings in the outbound vendor B2B
connection test transaction map.

e Your vendor's system verifies the basic credential information passed in the transaction and sends a
message back to your system. If the connection test was successful, your vendor's system sends
HTTP 200 response back to your system and Eclipse displays the following message in the Vendor
B2B Setup screen: Good Customer Number and Password. Connection was successful.

If the connection test was not successful, Eclipse displays troubleshooting information in the
Vendor B2B Setup scree. For example, the message might indicate that the password you specified
isinvalid, or the web server would not allow a certain method. The message often displays detailed
HTML information that you can use to determine the connection problem.

¢ Your system archives the outgoing XML document in Remote Archive Maintenance.

To send avendor B2B connection test transaction:
1. Display the character-based system.
Note: The B2B connection test functionality has not been incorporated into Solar Eclipse
as of thisrelease.
From the Files menu, select Vendor to display the Vendor Maintenance screen.
Open or create a vendor maintenance record.

Use the WWW hot key to display the Internet Information Maintenance screen.

o~ w DN

Use the B2B Commer ce hot key to open the vendor's Eclipse B2B Commerce Vendor
M aintenance screen.

6. Enter the login information you use to access the vendor’ s web site:

Field Description

Customer ID Y our company-assigned login identification.
Login The login ID for the customer.

Password Y our company-assigned login password.

7. Usethe B2B Post URL hot key and select Connection Test.

The system uses the location in the Default transaction type if all transactions' posts go to the
same location for the vendor. If the vendor requires the connection test posts to go to different
locations, set the URL for the connection test URL. If not, use the default post URL.

8. Inthe B2B Post URL field, enter the post location for XML documents for the customer.
9. PressEsc until you return to the Vendor Maintenance screen.
10. Press Esc to save the vendor record and exit the screen.
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11. Use the Test Connection hot key to test your connection access to the vendor. The system
attempts to connect to the vendor's URL, using your login information.
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Reviewing Remote Transactions with Errors

The Remote Error Review Queue displays inbound and outbound documents for remote transactions,
such as XML and EDI, that contain errors that cause them to not process correctly. From the Remote
Error Review Queue, you can drill down into the details of a document to identify errors, edit the
document, and reprocess it through the system.

Note: The current rel ease supports only XML documents in the Remote Error Review
Queue.
If you receive or send a document with errors, the system does the following:
¢ Creates an entry in the Remote Error Review Queue.
¢ Sends a system message to the user responsible for reviewing the Remote Error Review Queue.
o Archives the document in Remote Archive Maintenance.
Y ou can complete the following tasks in the Remote Error Review Queue:
¢ Review XML remote transactions with errors.
e View or edit aremote document.
o View or edit transaction in Eclipse that are associated with the remote document.

¢ Delete documents from the queue.

Toreview remotetransactionswith errors.
1. Display the character-based system.
The Error Queue functionality has not been incorporated into Solar Eclipse as of this
release.
2. Fromthe System > Custom menu, select Remote Review Queues and select Error Queueto
display the Selection Criteria screen.

3. Inthe Start Datefield and End Date field, enter the first and last dates in the range for which to
display documentsin the queue.

For example, to see all the documents that were received or transmitted with errors from April 1,
2004 to April 15, 2004, enter 04/01/04 in the Start Date field and 04/15/04 in the End Date
field.

The fields default to the date one week before the current date and to the current date.
4. Enter additional selection criteriain the remaining fields to filter the documents displayed in the

queue.
Field Description
Remote Type The type of remote documents you want to view, such as XML or EDI.

Note: The current release supports only XML documents in the Remote
Error Review Queue.
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Field

Description

In/Out

The document type to display. Press F10 and select Inbound to view only
documents you received that contained errors or Outbound to view only
documents you sent that contained errors.

Leave thisfield blank to view both inbound and outbound documents.

Search String

Any word, phrase, or numerical value within a document. For example, if
you want to see only documents that contain a specific product or trading
partner, enter that product or trading partner name here. The system
searches the document transactions for that string.

5. PressEsc to display the Remote Error Review Queue screen with the documentsin error that

match your search criteria.

The screen displays details about each document the system sent or received.

Field

Description

Error

The type of error the system encountered when processing the document.
For example, an error message may indicate that the system could not
find an entity for the transaction or that it could not compile the X Query
code for an XML transaction. Select an error message and use the

M essage hot key to display the entire message.

* (Archive Type)

The document type, inbound or outbound.

I (Inbound) — A document the system received. If the Eclipse system
initiated the transaction, an incoming document is typically a response
from the receiving source.

O(Outbound) — A document the system sent. If your trading partner
initiated the transaction, the outgoing document is typically an Eclipse
system response to the sending source.

Each transmission typically contains both an incoming and an outgoing
document.

Type The remote type, such as XML or EDI.
Note: The current release supports only XML documentsin the Remote
Error Review Queue.

Date The date the document was received or sent.

Time The time the document was received or sent.

Note: To refine or change your search, use the Select hot key and enter new search

criteria

Toview or edit aremote document'stransmission:

1. View documentsin the Remote Error Review Queue.

2. Select the document to view.

3. Usethe Detail hot key to display the Remote Archive Detail screen, which displays the document
asit was received from or sent to the Eclipse system.

Note: Use thisfunction to identify potential problems that are causing a document to not

process correctly.
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4. Usethefollowing hot keys, if necessary:

5.

To... Usethishot key...

edit the contents of the document Edit

The screen changes to an edit mode. Make any changes
necessary to correct the document and press Esc.

reprocess a document Requeue

Requeue the document after you have identified errors and
made any necessary changes.

Press Esc to return to the Remote Archive Maintenance screen.

Toview or edit transactionsin Eclipse that are associated with a remote document:

1
2.
3.

View documentsin the Remote Error Review Queue.
Select the document to view or edit.
Do one of the following:

o Usethe View hot key to open the transaction in view-only mode. For some transactions, such
asadstock inquiry, select the inquiry type, such as Future Ledger, History Ledger, or
Product Maintenance.

o Usethe Edit hot key to open the transaction in edit mode. Select the item to edit from the list.

Note: The View and Edit hot keys look for order numbers, customer numbers, or part
numbers in a document, and provide links to Eclipse data.

To delete documents from the Remote Error Review Queue:

1
2.
3.

View documentsin the Remote Error Review Queue.

Select the document to delete.

Do one of the following:

¢ Usethe Delete hot key to delete the selected document from the queue.

o Usethe Delete By Date hot key to delete all documents from the queue that are older than the
specified date. Enter the date and press Esc.

Note: The system removes the documents from the Remote Error Review Queue.
However, the documents are still available in Remote Archive Maintenance.
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Remote Archive Maintenance Overview

Remote Archive Maintenance is a searchable queue for all inbound and outbound documents associated
with remote transactions, such as XML or EDI.

Note: The current release supports only XML documents in the Remote Archive
Maintenance Queue.

Generally each remote transaction consists of an incoming and outgoing document in the archive.

If your system... Thearchive contains...

initiates the transaction an outgoing document corresponding to the transaction type, such as
a purchase order you send to a vendor. The archive also contains an
incoming response document, such as a purchase order response.

receives the transaction an incoming document corresponding to the transaction type, such as
asales order. The archive also contains an outgoing response
document, such as a sales order response.

160 © 2011 Epicor Software Corporation. All rights reserved.



Rel.8.7.2

Business Connect XML

Viewing Archived Documents for Remote Transactions

As your company receives and sends remote transactions, the system archives each transaction document.
Using Remote Archive Maintenance, you can search and view the documents and drill down to the
Eclipse-related transaction, such as a purchase order.

Use Remote Archive Maintenance to complete the following tasks:

e View archived documents.

e View or edit aremote document's transmission.

¢ View or edit transactions in Eclipse that are associated with the remote document.

To reprocess documents from Remote Archive Maintenance, see Reprocessing Remote Documents. To
remove XML documents from the archive, use the purge routine located on Files> M er ge/Pur ge menu

in Eclipse.

Note: The current release supports only XML documents in Remote Archive

M aintenance.

To view documentsin Remote Archive M aintenance:

1. Display the character-based system.

Note: The Remote Archive Maintenance functionality has not been incorporated in Solar

Eclipse as of thisrelease.

2. Fromthe System > Custom menu, select Remote Archive M aintenance to display the Selection

Criteria screen.

3. Inthe Start Datefield and End Date field, enter the first and last dates in the range for which to
display documentsin the archive.

For example, to see all the documents that were received or transmitted from April 1, 2004 to
April 15, 2004, enter 04/01/04 in the Start Date field and 04/15/04 in the End Date field.

Thefields default to the date one week before the current date and to the current date.
4. Enter any additional, optional selection criteriain the remaining fieldsto filter the documents

displayed in the archive.

Field

Description

Remote Type

The type of remote documents you want to view, such as XML or
EDI.

Note: The current release supports only XML documents in Remote
Archive Maintenance.

In/Out

The document type to display. Press F10 and select Incoming or
Outgoing.

Leave thisfield blank to include both incoming and outgoing
documents.
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Field

Description

Search String

Any word, phrase, or numerical value within a document. For
example, if you want to see only documents that contain a specific
product, enter that product here. The system searches the document
transactions for that string.

Trading Partner

The customer or vendor for which to display documentsin the
archive. For example, if you want to see only documents for Joe's
Electrical Supply, enter the namein thisfield to limit the archive
display to documents sent to or received from Joe's Electrical Supply.

Leave thisfield blank to include documents from all your vendors
and customers.

Source

A portal, marketplace, or specification for which to display
documentsin the archive. For example, if you want to see only
documents from a single source, enter the source name to limit the
archive display to include only those documents.

Leave thisfield blank to include documents from all sources.

Transaction

The transaction type for which to display documentsin the archive.
For example, if you want to see only documents that are purchase
order responses, enter the type to limit the archive display to include
only those documents.

Leave thisfield blank to include all document types.

5. PressEsc to display the Remote Archive Maintenance screen with the documents that match your

search criteria

The screen displays details about each document the system sent or received.

Field

Description

Trading Partner

The customer or vendor to which or from which the document was sent
or received.

Transaction The transaction type, such as a vendor order acknowledgement, vendor
order submit, or customer invoice.
Source The document sender, if the document is not sent to or received from a

customer or vendor. For additional information, see Adding Source
Distinctionsto XML Transaction Maps.

* (Archive Type)

The document type, inbound or outbound:

e | (Inbound) — A document the system received. If the Eclipse system
initiated the transaction, an incoming document is typically aresponse
from the receiving source.

e O(Outbound) — A document the system sent. If your trading partner
initiated the transaction, the outgoing document is typically an Eclipse
system response to the sending source.

Each transmission typically contains both an incoming and an outgoing

document.

Type

The remote type, such as XML or EDI.

Note: The current rel ease supports only XML documentsin Remote
Archive Maintenance.
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Field Description
Date The date the document was received or sent.
Time The time the document was received or sent.

Note: To refine or change your search, use the Select hot key and enter new search
criteria.

Toview or edit aremote document'stransmission:

1
2.
3.

4.

View documents in Remote Archive Maintenance.
Move your cursor to the document you want to view.

Use the Detail hot key to display the Remote Archive Detail screen with the document asit was
received or sent to or from the Eclipse system.

Note: Use thisfunction to identify potential problems that are causing a document to not
process correctly. Reprocess the document, if necessary.

Press Esc to return to the Remote Archive Maintenance screen.

Toview or edit transactionsin Eclipse associated with the remote document:

1
2.
3.

View documents in Remote Archive Maintenance.
Move your cursor to the transaction you want to view or edit.

Do one of the following:

o Usethe View hot key to open the transaction in view-only mode. For some transactions, such

asa stock inquiry, select the inquiry type, such as Future Ledger, History Ledger, or Product
Maintenance.

o Usethe Edit hot key to open the transaction in edit mode. Select the item you want to edit from
thelist.

Note: The View and Edit hot keys look for any order number, customer number, or part
numbersin a document and provide links to the Eclipse data from the remote
archive.
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Reprocessing Remote Archived Documents

Remote transactions are typically two-way transactions. For each received transaction, the system

generates aresponse and sends it back to your trading partner to acknowledge the receipt. Y ou might find
that some documents transmit unsuccessfully, for example, because a password failed. In which case, you
can reprocess the document data asit was originally received after making changesin the Eclipse system.

Note: Y ou can only reprocess documents that you received from a customer or vendor.
Y ou cannot reprocess documents from Remote Archive Maintenance that you sent
to a customer or vendor.

To reprocessremote ar chived documents:
1. View documentsin Remote Archive Maintenance or the Remote Error Review Queue.

Note: Y ou can also reprocess remote documents from the Remote Order
Acknowledgment Review Queue, Remote Advanced Ship Notice Review Queue,
and the Remote Invoice Review Queue.

Select the document to reprocess.

Use the Detail hot key to display the Remote Archive Detail screen.

Use the Requeue hot key to reprocess the document.

See Also:
Remote Archive Maintenance Overview
Viewing Archived Documents for Remote Transactions
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Business Connect XML Application Server Logging and Error
Notification Overview

The application server records al Business Connect XML messages about activity and communications
to alog file called eclipseinc.log located in the $<APPLICATION SERVER HOM E>/server/default/log
directory.

The default configuration of each message in the log provides the following information:

o Date and time the log message was generated, in the following format: YYYY-MM-DD
HH:MM:SSMS.
For example, 2004-04-01 14:03:50,771

e Thelogging level, such as Debug, Info, Warn, Error, or Fatal.

e The name of the Java class that logged the message. For example,
com.eclipseinc.jca.uv.impl.UV ManagedConnectionFactory.UV Connection

e Theactud error message. For example, Binding object
‘com.eclipseinc.jca.uv.impl.UV ConnectionFactorylmpl @8ca8ac' into JNDI at
‘Java:/UV Connection'

A single message in the log looks similar to the following, and can be contained all on oneline:

2004- 04- 01 14:03:50, 771 DEBUG

[com eclipseinc.jca.uv.inpl.U/MnagedConnecti onFact ory. UVConnect i
on] Bindi ng obj ect

'com eclipseinc.jca.uv.inpl.UWConnectionFactoryl npl @ca8ac' into
JNDI at 'java:/WConnection'

Note: Y ou can configure the rolling schedule and the log statement layout to meet your
business needs. See Configuring the Application Server Logging Parameters for
additional information.

When the log file reaches its maximum size limit of 2 MB, the system changes the eclipseinc.log file to
eclipseinc.X.log where X istherollover level. Each time you restart the server, the system starts a new
log file; however, it does not clear or delete any eclipse.X.log files.

Logging Levels

Y ou can set the application server to log only certain types of messages. The following logging levels are
available:

e Debug
e Info
e Warn
e Error
o Fatal

The Debug level logs the most messages, and is the default logging level for Business Connect XML. The
logging hierarchy isinclusive from top to bottom asit is listed above. That is, the Debug level includes
information that would be logged at the Info, Warn, Error, and Fatal levels. If you change the logging
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level to Warn, the system logs the Warn, Error, and Fatal messages, but does not 1og Info and Debug
messages. The following types of messages are logged at each level:

L ogging Description

Level

Debug The Debug level isuseful for programmers and provides detailed information about
system activity.

Info The Info level providesinformation about system activity, such as when the server

starts and ends a transaction.

Warn The Warn level logs messages when the server experiences a questionable program
state that does not stop processing.

Error The Error level logs messages when other systems throw exceptions. The system uses
thislogging level when it encounters errors within the Business Connect XML
application, such as when it receivesinvalid charactersin incoming XML documents
or other encounters other errors that cause a transaction to not complete properly, but
that are not severe enough to stop other transactions from processing.

Fatal The Fatal level logs messages when the server encounters a problem that causes it to
stop processing requests. Thislogging level includes fatal communication errors
between the application server and the Eclipse system and application fatal errors,
such as file permission errors on library or configuration files.
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Configuring the Business Connect XML Application Server
Logging Parameters

The Business Connect XML application uses the log4j logging engine. We recommend that you not make
significant changes to how logging works on your application server. Changing the configuration can
have negative impacts on how the Business Connect XML application's logging operations work.

However, you can change parameters such asroll schedules to meet your business needs and identify e-
mail addresses to which the server sends notifications if the application server encounters an error that
prevents a request from completing (typically data or system failures).

For e-mail notifications, the application server must have visibility to amail server. Eclipse does not set
thise-mail server up for you.

Important: You must be familiar with the log4j engine before changing the logging
configuration. See http://logging.apache.org/l ogdj/docs/manual .htm for
information about the log4j engine or contact Eclipse Technica Support for
assistance.

Configuring Basic Logging Information

Theeclipseinc.log fileis set up to roll when it reaches the maximum size limit of 2 MB. Itisaso set up to
roll each night at midnight, thus starting a fresh log for each business day. If the log reaches 2 MB during
one day, the log rollswhen it reaches 2 MB and at midnight each day. Y ou can change the logging
configuration to not create anew log file for each day. Y ou can also change the configuration so the
server creates anew log file at the top of each hour.

Note: Although you can also change the layout of the actual error message, we
recommend that you use the default error message set up during your
implementation of the Business Connect XML application. Changing the message
layout can cause logging messages to contain no information.

To configurethelog roll schedule:

1. Openthelogdj.xml filein the $<APPLICATION SERVER HOME>/server/default/conf
directory and locate the following part of the XML. The areas of the XML that you will be
changing are highlighted in bold below:

<appender name="APPLICATION"
class="org.jboss.|ogging.appender.DailyRollingFileAppender >

<errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>
<param name="File" value="${ jboss.server.home.dir}/log/eclipseinc.log"/>
<param name="Append" value="false"/>

<!-- Rollover at midnight each day -->
<param name="DatePattern" value=""."yyyy-MM-dd" />|

<layout class="org.apache.log4j.PatternLayout">
<!-- The default pattern: Date Priority [Category] Message\n -->
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<param name="ConversionPattern" value="%d %-5p [%c] Yom%n"/>

<l-- The full pattern: Date MS Priority [Category] (Thread:NDC) Message\n
<param name="ConversionPattern" value="%d %-5r %-5p [%oc] (%ot:%x) Y%om%n"/>

>
</layout>
</appender>
2. Do one of thefollowing to change the log roll schedule:
To... Do This...
create anew log file only delete the line in red above:

when it reaches the maximum | <param name="DatePattern” value="".'yyyy-MM-dd"/>|

sizelimit Add this line back to this location if you want to roll the log at
midnight every night.

to create anew log at the top add the following text under the section that controls the daily
of every hour rollover:
<!-- Rollover at the top of each hour

<param name="DatePattern" value="".'yyyy-MM-dd-HH"/>
-->

3. Saveyour changes and exit thefile.

Configuring E-Mail Notifications

Y ou can change the following e-mail notification parameters to indicate who in your company receives
notifications by e-mail if the application server encounters an error within the Business Connect XML
application or the application server itsdlf.

¢ The e-mail address to which the server sends notifications of messages logged at the Error and
Fatal logging levels, and the sent from e-mail address. Theselogging levelsinclude fatal
communication errors between the application server and the Eclipse system and application fatal
errors, such asfile permission errors on library or configuration files.

e The subject line of the error notification e-mails.
e Thee-mail server through which messages are routed.

To change these settings, open the log4j .xml file in the $<APPLICATION SERVER
HOME>server/default/conf directory, locate the following part of the XML, and follow the instructions
below. The areas of the XML that you will be changing are highlighted in bold below:

<!-- EMail eventsto an administrator -->
<appender name="SMTP" class="org.apache.log4j.net. SMTPA ppender">
<errorHandler class="org.jboss.logging.util.OnlyOnceErrorHandler"/>
<param name="Threshold" value="ERROR"/>
<param nhame="To" value="johndoe@123abc.com" />

<param name="From" value="johndoe@123abc.com" />
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<param name="Subject" value="Eclipse Inc. ECommerce Application Errors"'/>
<param nhame="SMTPHost" value=" SDEXO06.eclipseinc.com" />
<param name="BufferSize" value="10000"/>
<layout class="org.apache.log4j.PatternLayout">
<param name="ConversionPattern" value="[%d{ ABSOLUTE} ,%c{ 1} ] %em%n"/>
</layout>
</appender>

Note: Although you can also change the layout of the actual error message, we
recommend that you use the default error message set up during your
implementation of the Business Connect XML application. Changing the message
layout can cause logging messages to contain no information.

To changethe e-mail addresses:
1. Inthelogdj.xml file detailed above, locate the following lines:
<param name="T0" value="johndoe@123abc.com"/>
<param name="From" value="johndoe@2123abc.com’/>

2. Update the email addressin the To parameter to the address to which you want error
notifications sent.

3. Update the e-mail addressin the From parameter to the address from which you want error
notification sent.

Note: Y ou can enter multiple e-mail addressesin the To and From parameters. Use a
semi-colon (;) to separate the addresses.

4. Saveyour changes and exit thefile.

To changethe e-mail subject line:
1. Inthelog4j.xml file detailed above, locate the following line:
<param name="Subject" value="Eclipse Inc. ECommerce Application Errors'/>

2. Change thetext in quotation marks to the text that you want to display in the subject line of error
notification e-mails.

3. Saveyour changes and exit thefile.
Changing the Logging Level

Y ou can set the application server to log only certain types of messages. For more information about the
available logging levels, see Application Server Logging and Error Notification Overview.
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Y ou can change the logging level if necessary to capture more or less information.

Important! We recommend that only Eclipse personnel change the logging level.

To changethelogging level:

1. Open the logdj.xml filein the $<APPLICATION SERVER HOME>/server/default/conf
directory and locate the following part of the XML. The areas of the XML that you will be
changing are highlighted in bold below:

<category name="com.intuit">
<priority value="WARN"/>
<appender-ref ref="APPLICATION"/>
</category>

2. ChangethePriority Value parameter to a different logging level, as described in Application
Server Logging and Error Notification Overview.

3. Saveyour changes and exit thefile.

170 © 2011 Epicor Software Corporation. All rights reserved.



Rel.8.7.2

Business Connect XML

Troubleshooting XML Transaction Processing

The following troubl eshooting information contains solutions to potential problems you might encounter
when processing XML transactions through your system using Business Connect XML. If the
information you are looking for is not available here, send an e-mail to

Eclipse.documentation@epi cor.com. We will consider your feedback for future releases of the Business
Connect XML documentation.

Contact Eclipse Technical Support if you need additional assistance resolving your problem.

Problem

I ndications

Solutions

System cannot
identify customer
sending XML
documents.

e Errorsin XML Poster.

e "Entity Not Found" error in the
Eclipse message system when
the system receives an XML
document. Eclipse messaging
for the customer must be
defined.

e The system sends the XML
document to the Remote Error
Review Queue.

If the system cannot identify the customer, it
cannot compl ete the transaction. Customers are
identified by Eclipse customer ID and e-
commerce IDsin the ship to or bill to customer
record.

1. Verify that unique customer identifier
information is mapped to the Eclipse
ShipTo or BillTo element within the
transaction map associated with the XML
document. If neither element has data
mapped to it, map the identifying
information, such as a customer number,
and retest the transaction using the XML
Poster.

2. If the ShipTo or BillTo elementsin Eclipse
are mapped and the transaction still does not
process, right-click the mapped element and
select M odify M apping to view the data
modifications assigned to the element.

Verify that the data being sent and any
modifications to the data match either the
customer 1D number in Eclipse or one of the
customer's e-commerce IDs. Typically, an
e-commerce ID is an aphanumeric
combination. If your customer is sending
only a numeric customer 1D, you can use
the concatenate operation to add the alpha
portion of the ID.

Also verify that the mapping selection
criteriais set to identify the customer by the
information in the ShipTo of Billto element.

Make any required changes to the customer
record and the transaction map, save each,
and retest the transaction using the XML
Poster.
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Problem Indications Solutions
System not Remote XML orders contain the The system matches products based on what is
matching wrong products. mapped in the transaction map, and follows the

products correctly
on XML orders.

product matching hierarchy.

1. Check the order change log to verify that
the order was created automatically.

2. View the content of the XML document in
Remote Archive Maintenance to identify the
requested part number. The product part
number is located in the Item Detail section
of the XML document.

3. Open the transaction map and determine if
the item description is mapped to an
element in Eclipse. If it is mapped, then the
system is searching for the product by
description, not by part number.

4. Open the product record in Eclipse and
determine if the description matches the
product description sent in. If so, the system
is correctly matching this product to the
request from your trading partner.

5. Change the transaction map to map the
incoming product description to the
ItemComments element. Now, the system
will not search on the product, but saves the
information.

6. Save the transaction map and retest the
transaction using the XML Poster.

System not
adding products
to XML orders.

Products sent in an XML order
document are not included on the
system-generated order.

If products sent in an XML document are not
included in the system-generated order, the
system cannot find a match in your system for the
requested product.

Ensure that you have a B2B Product Not Found
product defined and that the product isidentified
inthe IDMS-XML Default Part # Used For
Creating A Nonstock Item control maintenance
record. When these two items are set up, retest
the transaction using the XML Poster. Any items
the system cannot match are added to the order
with the product description you define in the
product not found product record.

System reporting
errorsin the
message system
for the remote
order review user

Receive a message similar to the
following in the Eclipse message
system:
08/16/04)04:24pm|BCS|xCustomer
has created order number

If the system successfully creates an order, it
sends a system message to the remote order
review user for the customer. However, the
system can successfully create an order and till
identify errors, such as not finding matching

when the XML S$1111111 through Eclipse products. The system message indicates notifies
contained no Business Connect Suite with 2 the reviewer that the order cannot ship correctly
errors Error(s). and requires review.
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Problem Indications Solutions

XML orders e Pricing information on the order | If the order uses pricing information from

contain the wrong isfrom Eclipse, not from the Eclipse, the customer record's Use Partner
pricing trading partner. Pricing field is set to No, and the system uses the
information. pricing information available in Eclipse. If you

e Pricing information on the order
isfrom the trading partner's
system, not from Eclipse.

want to use the trading partner's pricing
information, set the pricing variance for the
customer.

If the customer record's Use Partner Pricing
field is set to Yes, the system uses the pricing
information within the variance that you define
on system-generated orders. If the pricing
information on the order is from the trading
partner, disable the flag and retest the transaction:
1. Check the order change log to verify that
the order was created automatically.
2. View the content of the XML document in
Remote Archive Maintenance. |dentify the
pricing information sent in the order.

3. Open the customer record and select
Remote Order Entry Parameters from the
Orders menu. From that window, select
WOE Information from the Edit menu to
display the B2B/WOE Remote Order Entry
Parameters window.

4. Select IDMS-XML from the Edit menu to
display the IDMS- XML Parameters
window.

5. Deselect the Use Partner Pricing check
box, and save the customer record.

6. Retest the transaction using the XML
Poster.
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Troubleshooting XML Transaction Map Creation

The following troubl eshooting information contains solutions to potential problems you might encounter

when creating XML transaction maps using the Business Connect XML mapping utility. If the
information you are looking for is not available here, send an email to

Eclipse.documentation@epi cor.com. We will consider your feedback for future releases of the Business

Connect XML documentation.

Contact Eclipse Technical Support if you need additional assistance resolving your problem.

Problem

Indications

Solutions

Cannot add atrading
partner in the mapping
utility.

"No entity found" error
displays.

Thetrading partners that you add to the Trading
Partner Tree must have a customer or vendor record
defined in Eclipse. Type part of the customer or
vendor name and click the Down Arrow to search.

Cannot draw a
connection between
Source XML and
Target XML.

No lineis drawn from the
source €lement to the
target element.

Select the element in the Source XM L column you
want to map. Click the element again and drag the
mouse to the element in the Target XML column.

Cannot drag an
operation to operation
stack.

The operation is not
added to the Operation
Stack field inthe XML
Mapping Conversion
Editor dialog box.

Select the operation you want to add from the
operation list. Click the operation again and drag the
mouse to the operation stack.

Files and fields added
to XML database

The Source XML or the
Target XML that contains

Stop and restart the JBoss server.

schemas are not the data elements for
availablein the Eclipse does not contain
mapping utility. the files and fields added
in XML Schema
Maintenance.
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